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About  this  document  

This document provides information about setting up, installing, configuring, and 

working with the three IBM® System Storage™ DS4000 premium features that assist 

with copy services: FlashCopy®, VolumeCopy, and the Enhanced Remote Mirroring 

Option. These features are used with DS4000 IBM Storage Manager software. Use 

this guide to accomplish the following tasks: 

v   Determine the hardware and software that are required to install the copy 

services features 

v   Install, enable, and activate the IBM DS4000 FlashCopy feature 

v   Install, enable, and activate the IBM DS4000 VolumeCopy feature 

v   Install, enable, and activate the IBM DS4000 Enhanced Remote Mirroring Option 

v   Troubleshoot hardware and software problems

Notes:  

1.   Depending on what version of Storage Manager you are using, the SMclient 

instructions in this document might vary slightly from the actual menu paths in 

the SMclient software GUI. 

2.   The VolumeCopy premium feature is only supported in DS4000 Storage 

Manager version 8.4 or higher, in conjunction with the DS4000 Storage 

Subsystem controller firmware versions 05.40.xx.xx and 06.1x.xx.xx or higher. 

3.   Enhanced Remote Mirroring, Remote Mirror, and Remote Mirroring are used 

interchangeably throughout this document, the online client, and online help 

system to refer to remote mirroring functionality. Although these terms are used 

interchangeably, this usage does not mean that their functionality is identical. 

4.   The Enhanced Remote Mirroring Option premium feature is only supported with 

DS4000 Storage Subsystem controller version 06.1x.xx.xx or higher.

Who should read this document 

This guide is intended for system administrators who are responsible for operating 

and maintaining storage systems, with an emphasis on disaster prevention and 

recovery. 

Important: Before you install premium features, make sure that you have 

purchased the premium feature keys necessary for those features you want to 

install and consult the following documentation: 

DS4000 Storage Manager readme file for your operating system 

Read this text file first. Updated readme files contain important configuration 

information that supersedes the information in this document. To access the 

most recent DS4000 Storage Manager readme file for your operating 

system, complete the following steps. 

1.   Go to the following Web site:

www-1.ibm.com/servers/storage/support/disk/ 

2.   Click the link for your storage subsystem (for example, DS4800). 

3.   When the subsystem support page opens, click the Download tab, and 

then click the Storage Manager, firmware, HBA and tools (including 

readmes) link. 

4.   When the download page opens, click the Storage Mgr tab; a table 

displays. 
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5.   In the table, find the row that contains the listing for your operating 

system, and then click the corresponding v9.1x link in the Current 

Versions and Readmes column.

DS4000 Storage Manager installation and support guides 

The following Storage Manager installation and support guides describe 

how to set up your host operating system for the DS4000 storage 

subsystem, how to install the DS4000 Storage Manager software, and how 

to configure storage: 

v   IBM DS4000 Storage Manager Installation and Support Guide for 

Windows® 2000/Server 2003, NetWare, ESX Server, and Linux® 

v   IBM DS4000 Storage Manager Installation and Support Guide for AIX®, 

HP-UX, Solaris, and Linux on POWER™

You can download these documents from the following Web site: 

www.ibm.com/shop/publications/order/ 

DS4000 Storage Subsystem installation tasks - General overview 

Table 1 provides a sequential list of many installation and configuration tasks that 

are common to most DS4000™ configurations. When you install and configure your 

DS4000 storage subsystem, refer to this table to find the documentation that 

explains how to complete each task.

See also:  The DS4000 Storage Server and Storage Expansion Enclosure Quick 

Start Guide provides an excellent overview of the installation process.

 Table 1. Where to find DS4000 installation and configuration procedures 

Installation task Where to find information or procedures 

1 Plan the installation v   DS4000 Storage Manager Concepts Guide 

v   DS4000 Storage Manager Installation and Support Guide for 

AIX, HP-UX, Solaris and Linux on POWER  

v   DS4000 Storage Manager Installation and Support Guide for 

Windows 2000/Server 2003, NetWare, ESX Server, and 

Linux 

v   DS4100 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4200 Express Storage™ Subsystem Installation, User’s, 

and Maintenance Guide 

v   DS4300 Storage Subsystem Installation, User's, and 

Maintenance Guide 

v   DS4400 Fibre Channel Storage Server Installation and 

Support Guide 

v   DS4500 Storage Subsystem Installation, User's, and 

Maintenance Guide 

v   DS4700 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4800 Storage Subsystem Installation, User’s, and 

Maintenance Guide 
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Table 1. Where to find DS4000 installation and configuration procedures (continued) 

Installation task Where to find information or procedures 

2 Mount the DS4000 

storage subsystem in 

the rack 

v   DS4800 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4700 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4400 and DS4500 Rack Mounting Instructions 

v   DS4300 Rack Mounting Instructions 

v   DS4200 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4100 Storage Subsystem Installation, User’s and 

Maintenance Guide 

3 Mount the DS4000 

EXP storage 

expansion unit in the 

rack 

v   DS4000 EXP100 Storage Expansion Unit Installation, User’s 

and Maintenance Guide 

v   DS4000 EXP420 Storage Expansion Enclosures Installation, 

User’s, and Maintenance Guide 

v   DS4000 EXP700 and EXP710 Storage Expansion Enclosures 

Installation, User’s, and Maintenance Guide 

v   DS4000 EXP810 Storage Expansion Enclosures Installation, 

User’s, and Maintenance Guide 

v   FAStT EXP500 Installation and User’s Guide 

4 Route the storage 

expansion unit Fibre 

Channel cables 

v   DS4100 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4200 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4300 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4400 Fibre Channel Cabling Instructions 

v   DS4500 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4700 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4800 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

5 Route the host 

server Fibre Channel 

cables 

v   DS4100 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4200 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4300 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4400 Fibre Channel Cabling Instructions 

v   DS4500 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4700 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4800 Storage Subsystem Installation, User’s, and 

Maintenance Guide 
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Table 1. Where to find DS4000 installation and configuration procedures (continued) 

Installation task Where to find information or procedures 

6 Power up the 

subsystem 

v   DS4100 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4200 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4300 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4400 Fibre Channel Storage Server Installation and 

Support Guide 

v   DS4500 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4700 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4800 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

7 Configure DS4000 

network settings 

v   DS4100 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4200 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4300 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4400 Fibre Channel Storage Server Installation and 

Support Guide 

v   DS4500 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4700 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4800 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

8 Zone the fabric 

switch 

(SAN-attached only) 

v   DS4000 Storage Manager Installation and Support Guide for 

AIX, HP-UX, Solaris and Linux on POWER  

v   DS4000 Storage Manager Installation and Support Guide for 

Windows 2000/Server 2003, NetWare, ESX Server, and 

Linux 

v   DS4000 Storage Manager Copy Services Guide (describes 

switch zoning for the Remote Mirror Option) 

v   See also the documentation provided by the switch 

manufacturer. 
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Table 1. Where to find DS4000 installation and configuration procedures (continued) 

Installation task Where to find information or procedures 

9 Install DS4000 

Storage Manager 

software on the 

management station 

v   DS4000 Storage Manager Installation and Support Guide for 

AIX, HP-UX, Solaris and Linux on POWER  

v   DS4000 Storage Manager Installation and Support Guide for 

Windows 2000/Server 2003, NetWare, ESX Server, and 

Linux 

v   DS4000 Storage Manager online help (for post-installation 

tasks) 

10 Install host software 

(failover drivers) on 

host server 

11 Start DS4000 

Storage Manager 

12 Set the DS4000 

Storage Manager 

clock 

13 Set the DS4000 

Storage Manager 

host default type 

14 Verify DS4000 

subsystem health 

v   DS4100 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4200 Express Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4300 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4400 Fibre Channel Storage Server Installation and 

Support Guide 

v   DS4500 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4700 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

v   DS4800 Storage Subsystem Installation, User’s, and 

Maintenance Guide 

15 Enable DS4000 

Storage Manager 

premium feature 

keys 

Copy Services premium features 

DS4000 Storage Manager Copy Services Guide 

FC/SATA Intermix premium feature 

DS4000 Fibre Channel and Serial ATA Intermix 

Premium Feature Installation Overview 

Storage Partitioning (and general premium features 

information) 

v   DS4000 Storage Manager Concepts Guide 

v   DS4000 Storage Manager Installation and Support 

Guide for AIX, HP-UX, Solaris and Linux on POWER  

v   DS4000 Storage Manager Installation and Support 

Guide for Windows 2000/Server 2003, NetWare, 

ESX Server, and Linux

16 Configure arrays and 

logical drives 

v   DS4000 Storage Manager Installation and Support Guide for 

AIX, HP-UX, Solaris and Linux on POWER  

v   DS4000 Storage Manager Installation and Support Guide for 

Windows 2000/Server 2003, NetWare, ESX Server, and 

Linux 

v   DS4000 Storage Manager online help 

17 Configure host 

partitions 

18 Verify host access to 

DS4000 storage
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How this document is organized 

Chapter 1, “Introduction,” on page 1 provides information on how to enable, view, 

and disable the premium features. 

Chapter 2, “Overview of FlashCopy,” on page 13 provides information about the 

FlashCopy feature, how to enable the feature, plan, create, and reuse FlashCopy 

logical drives, and how to perform some common FlashCopy tasks. 

Chapter 3, “Overview of VolumeCopy,” on page 57 provides information about the 

VolumeCopy feature, how to use the Create Copy wizard and the Copy Manager to 

copy, backup, and restore data. 

Chapter 4, “Managing VolumeCopy,” on page 73 provides information to help you 

manage your VolumeCopies. It also provides information about how to recopy, stop, 

or remove a VolumeCopy, modify the attributes of a logical drive, view the status of 

a VolumeCopy operation, and determine what logical drives are involved in a 

VolumeCopy operation. 

Chapter 5, “Troubleshooting VolumeCopy,” on page 85 provides information about 

troubleshooting some of the more common problems encountered when you use 

the VolumeCopy feature. 

Chapter 6, “Overview of the Enhanced Remote Mirroring Option,” on page 91 

provides an introduction to the Remote Mirror Option and describes the hardware 

and software requirements for using the Remote Mirror Option. It also provides 

information about configuration types, describes how the Remote Mirror Option 

interfaces with other premium features (such as Storage Partitioning and FlashCopy 

logical drives), and provides a hardware and software checklist to ensure that all 

the requirements are met before you install and configure your systems.

Note:  The terms Enhanced Remote Mirroring, Remote Mirror Option, and Remote 

Mirroring are used interchangeably throughout this document to refer to the 

remote mirroring functionality. Although these terms are used 

interchangeably, this usage does not mean that their functionality is identical. 

Chapter 7, “Installing hardware and software for the Enhanced Remote Mirroring 

Option,” on page 113 provides information about preparing the site and instructions 

for installing key hardware and software components to run the Remote Mirror 

Option. 

Chapter 8, “Using the Enhanced Remote Mirroring Option,” on page 137 provides 

step-by-step instructions for enabling and activating the Remote Mirror Option, 

creating a mirror relationship, and maintaining a mirror relationship. 

Chapter 9, “Disaster recovery,” on page 149 provides a number of scenarios about 

how the Remote Mirror Option can help prevent data loss, and assist with the 

recovery of critical data if a disaster or unrecoverable error occurs. 

Chapter 10, “Troubleshooting the Enhanced Remote Mirroring Option,” on page 157 

provides information for troubleshooting hardware and software components, and 

describes the events that might be logged when using the Remote Mirror Option. 
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Appendix A, “Upgrading controller firmware,” on page 171 describes the procedure 

that you must follow to upgrade controller firmware to ensure that the Remote 

Mirror Option works properly. 

Appendix B, “Additional DS4000 documentation,” on page 173 provides a 

bibliography of additional documentation. 

Appendix C, “Accessibility,” on page 183 provides information about DS4000 

Storage Manager accessibility features such as alternate keyboard navigation and 

how to enable the screen reader software interface. 

“Notices” on page 185 provides product notices and trademark information. 

Notices used in this document 

This document contains the following notices designed to highlight key information: 

v   Notes: These notices provide important tips, guidance, or advice. 

v   Important: These notices provide information that might help you avoid 

inconvenient or problem situations. 

v   Attention: These notices indicate possible damage to programs, devices, or 

data. An attention notice is placed just before the instruction or situation in which 

damage could occur.

Getting information, help, and service 

If you need help, service, or technical assistance or just want more information 

about IBM products, you will find a wide variety of sources available from IBM to 

assist you. This section contains information about where to go for additional 

information about IBM and IBM products, what to do if you experience a problem 

with your system, and whom to call for service, if it is necessary. 

Before you call 

Before you call, take these steps to try to solve the problem yourself: 

v   Check all cables to make sure that they are connected. 

v   Check the power switches to make sure that the system is turned on. 

v   Use the troubleshooting information in your system documentation, and use the 

diagnostic tools that come with your system. 

v   Check for technical information, hints, tips, and new device drivers at the IBM 

support Web site pages that are listed in this section. 

v   Use an IBM discussion forum on the IBM Web site to ask questions.

You can solve many problems without outside assistance by following the 

troubleshooting procedures that IBM provides in the DS4000 Storage Manager 

online help or in the documents that are provided with your system and software. 

The information that comes with your system also describes the diagnostic tests 

that you can perform. Most subsystems, operating systems, and programs come 

with information that contains troubleshooting procedures and explanations of error 

messages and error codes. If you suspect a software problem, see the information 

for the operating system or program. 

Using the documentation 

Information about your IBM system and preinstalled software, if any, is available in 

the documents that come with your system. This includes printed books, online 
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documents, readme files, and help files. See the troubleshooting information in your 

system documentation for instructions for using the diagnostic programs. The 

troubleshooting information or the diagnostic programs might tell you that you need 

additional or updated device drivers or other software. 

Web  sites 

The most up-to-date information about DS4000 storage subsystems and DS4000 

Storage Manager, including documentation and the most recent software, firmware, 

and NVSRAM downloads, can be found at the following Web sites. 

DS4000 Midrange Disk Systems 

Find the latest information about IBM System Storage disk storage systems, 

including all of the DS4000 storage subsystems:

www-1.ibm.com/servers/storage/disk/ds4000/ 

IBM System Storage products 

Find information about all IBM System Storage products:

www.storage.ibm.com/ 

Support for IBM System Storage disk storage systems 

Find links to support pages for all IBM System Storage disk storage 

systems, including DS4000 storage subsystems and expansion units: 

 www-304.ibm.com/jct01004c/systems/support/supportsite.wss/
brandmain?brandind=5345868 

System Storage DS4000 interoperability matrix 

Find the latest information about operating system and HBA support, 

clustering support, storage area network (SAN) fabric support, and DS4000 

Storage Manager feature support: 

www-1.ibm.com/servers/storage/disk/ds4000/interop-matrix.html 

DS4000 Storage Manager readme files 

1.   Go to the following Web site: 

www-304.ibm.com/jct01004c/systems/support/supportsite.wss/
brandmain?brandind=5345868 

2.   In the Product family drop-down menu, select Disk systems, and in the 

Product drop-down menu, select your Storage Subsystem (for example, 

DS4800 Midrange Disk System). Then click Go. 

3.   When the subsystem support page opens, click the Install/use tab, then 

click the DS4000 Storage Manager Pubs and Code link. The 

Downloads page for the subsystem opens. 

4.   When the download page opens, ensure that the Storage Mgr tab is 

selected. A table displays. 

5.   In the table, find the entry that lists the Storage Manager package for 

your operating system, then click on the corresponding v9.xx link in the 

“Current version and readmes” column. The Storage Manager page for 

your operating system opens. 

6.   Click the link for the readme file.

Storage Area Network (SAN) support 

Find information about using SAN switches, including links to user guides 

and other documents:
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www.ibm.com/servers/storage/support/san/index.html 

DS4000 technical support 

Find downloads, hints and tips, documentation, parts information, HBA and 

Fibre Channel support: 

 www-304.ibm.com/jct01004c/systems/support/supportsite.wss/
brandmain?brandind=5345868In the Product family drop-down menu, select 

Disk systems, and in the Product drop-down menu, select your Storage 

Subsystem (for example, DS4800 Midrange Disk System). Then click Go. 

Premium feature activation 

Generate a DS4000 premium feature activation key file by using the online 

tool:

www-912.ibm.com/PremiumFeatures/jsp/keyInput.jsp 

IBM publications center 

Find IBM publications:

www.ibm.com/shop/publications/order/ 

Support for System p™ servers 

Find the latest information supporting System p AIX and Linux servers: 

 www-304.ibm.com/jct01004c/systems/support/supportsite.wss/
brandmain?brandind=5000025 

Support for System x™ servers 

Find the latest information supporting System x Intel®- and AMD-based 

servers: 

 www-304.ibm.com/jct01004c/systems/support/supportsite.wss/
brandmain?brandind=5000008 

Fix delivery center for AIX and Linux on POWER 

Find the latest AIX and Linux on POWER information and downloads:

www-912.ibm.com/eserver/support/fixes/fcgui.jsp 

In the Product family drop-down menu, select UNIX® servers. Then select 

your product and fix type from the subsequent drop-down menus. 

EserverSystem p and AIX information center 

Find everything you need to know about using AIX with System p and 

POWER servers:

publib.boulder.ibm.com/infocenter/pseries/index.jsp? 

Support for Linux on System p 

Find information about using Linux on System p servers:

www.ibm.com/servers/eserver/pseries/linux/ 

Linux on POWER resource center 

Find information about using Linux on POWER servers:

www.ibm.com/servers/enable/linux/power/ 
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Software service and support 

Through IBM Support Line, for a fee you can get telephone assistance with usage, 

configuration, and software problems. For information about which products are 

supported by Support Line in your country or region, go to the following Web site: 

www.ibm.com/services/sl/products/ 

For more information about the IBM Support Line and other IBM services, go to the 

following Web sites: 

v   www.ibm.com/services/ 

v   www.ibm.com/planetwide/

Hardware service and support 

You can receive hardware service through IBM Integrated Technology Services or 

through your IBM reseller, if your reseller is authorized by IBM to provide warranty 

service. Go to the following Web site for support telephone numbers: 

www.ibm.com/planetwide/ 

In the U.S. and Canada, hardware service and support is available 24 hours a day, 

7 days a week. In the U.K., these services are available Monday through Friday, 

from 9 a.m. to 6 p.m. 

Fire suppression systems 

A fire suppression system is the responsibility of the customer. The customer’s own 

insurance underwriter, local fire marshal, or a local building inspector, or both, 

should be consulted in selecting a fire suppression system that provides the correct 

level of coverage and protection. IBM designs and manufactures equipment to 

internal and external standards that require certain environments for reliable 

operation. Because IBM does not test any equipment for compatibility with fire 

suppression systems, IBM does not make compatibility claims of any kind nor does 

IBM provide recommendations on fire suppression systems. 

How to send your comments 

Your feedback is important to help us provide the highest quality information. If you 

have any comments about this document, you can submit them in one of the 

following ways: 

E-mail 

 Submit your comments by e-mail to: 

 starpubs@us.ibm.com 

 Be sure to include the name and order number of the document and, if 

applicable, the specific location of the text that you are commenting on, 

such as a page number or table number. 

Mail 

 Fill out the Readers’ Comments form (RCF) at the back of this document 

and return it by mail or give it to an IBM representative. 

 If the RCF has been removed, send your comments to:

International Business Machines Corporation 

Information Development 

Department GZW
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9000 South Rita Road 

Tucson, Arizona 

USA 

85744-0001

 Be sure to include the name and order number of the document and, if 

applicable, the specific location of the text that you are commenting on, 

such as a page number or table number.
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Chapter  1.  Introduction  

This chapter introduces three Storage Manager premium features that assist with 

copy services: 

FlashCopy 

You use the FlashCopy feature to create and manage FlashCopy logical 

drives. A FlashCopy is the logical equivalent of a complete physical copy, 

but is created more quickly and requires less disk space. It is host 

addressable, so you can perform backups using FlashCopy while the base 

logical drive is online and user-accessible. When the backup completes, 

you can delete the FlashCopy logical drive or save it for reuse. See 

Chapter 2, “Overview of FlashCopy,” on page 13 for more information. 

VolumeCopy  

The VolumeCopy feature is a DS4000 Storage Subsystem controller 

firmware-based mechanism that you use to copy data from one logical drive 

(the source logical drive) to another logical drive (the target logical drive) in 

a single storage subsystem. Once defined, the combination of the source 

and target logical drives in a VolumeCopy relationship is referred to as a 

VolumeCopy logical drive pair. For more information on VolumeCopy 

functionality, see Chapter 3, “Overview of VolumeCopy,” on page 57. 

 The VolumeCopy feature can be used to perform the following tasks: 

v   Copy data from arrays that use smaller capacity drives to arrays that use 

larger capacity drives 

v   Back up data 

v   Restore FlashCopy logical drive data to the base logical drive

The VolumeCopy feature includes a Create Copy wizard that you use to 

create a logical drive copy, and a Copy Manager that you use to monitor 

logical drive pairs after they have been created. 

 Important: During the VolumeCopy data transfer operation, any write 

requests to the source logical drive will be rejected. If the source logical 

drive is used in a production environment, the FlashCopy feature must be 

enabled and the FlashCopy of the logical drive must be specified as the 

VolumeCopy source logical drive instead of using the actual logical drive 

itself. This requirement is to prevent the logical drive from being 

inaccessible to the users. 

Enhanced Remote Mirroring Option 

Enhanced Remote Mirroring provides the ability to create remote logical 

drive mirror pairs with two new features: asynchronous write mode, and the 

write consistency group option. Asynchronous mirroring with the consistency 

group option is referred to as Global Mirroring, and asynchronous mirroring 

without the consistency group option is referred to as Global Copy. Mirroring 

that uses the existing synchronous write mode is now referred to as Metro 

Mirroring. For more information on remote mirroring, see Chapter 6, 

“Overview of the Enhanced Remote Mirroring Option,” on page 91. 

 Note:  Enhanced Remote Mirroring, Remote Mirror, and Remote Mirroring 

are used interchangeably throughout this document, the online client, 

and online help system to refer to remote mirroring functionality. 

Although these terms are used interchangeably, this usage does not 

mean that their functionality is identical.
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Product updates 

 

Important 

In order to keep your system up to date with the latest firmware and other 

product updates, use the information below to register and use the My 

support Web site.

 Download the latest versions of the DS4000 Storage Manager host software, 

DS4000 storage server controller firmware, DS4000 drive expansion enclosure ESM 

firmware, and drive firmware at the time of the initial installation and when product 

updates become available. 

To be notified of important product updates, you must first register at the IBM 

Support and Download Web site: 

www-1.ibm.com/servers/storage/support/disk/index.html 

In the Additional Support section of the Web page, click My support. On the next 

page, if you have not already done so, register to use the site by clicking Register 

now. 

Perform the following steps to receive product updates: 

1.   After you have registered, type your user ID and password to log into the site. 

The My support page opens. 

2.   Click Add products. A pull-down menu displays. 

3.   In the pull-down menu, select Storage. Another pull-down menu displays. 

4.   In the new pull-down menu, and in the subsequent pull-down menus that 

display, select the following topics: 

v   Computer Storage 

v   Disk Storage Systems 

v   TotalStorage® DS4000 Midrange Disk Systems & FAStT Stor Srvrs

Note:  During this process a check list displays. Do not check any of the items 

in the check list until you complete the selections in the pull-down 

menus. 

5.   When you finish selecting the menu topics, place a check in the box for the 

machine type of your DS4000 series product, as well as any other attached 

DS4000 series product(s) for which you would like to receive information, then 

click Add products. The My Support page opens again. 

6.   On the My Support page, click the Edit profile tab, then click Subscribe to 

email. A pull-down menu displays. 

7.   In the pull-down menu, select Storage. A check list displays. 

8.   Place a check in each of the following boxes: 

a.   Please send these documents by weekly email 

b.   Downloads and drivers 

c.   Flashes 

d.   Any other topics that you may be interested in

Then, click Update. 

9.   Click Sign out to log out of My Support.
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FAStT product renaming 

IBM has renamed some FAStT family products. Table 2 identifies each DS4000 

product name with its corresponding previous FAStT product name. Note that this 

change of product name only indicates no change in functionality or warranty. All 

products listed below with new names are functionally equivalent and fully 

interoperable. Each DS4000 product retains full IBM service as outlined in service 

contracts issued for analogous FAStT products. 

 Table 2. Mapping of FAStT names to DS4000 series names 

Previous FAStT Product Name  Current DS4000 Product Name  

IBM TotalStorage FAStT Storage Server IBM TotalStorage DS4000 

FAStT DS4000 

FAStT Family DS4000 Mid-range Disk System 

FAStT Storage Manager vX.Y (for example 

v9.10) 

DS4000 Storage Manager vX.Y (for example 

v9.10) 

FAStT100 DS4100 

FAStT600 DS4300 

FAStT600 with Turbo Feature DS4300 Turbo 

FAStT700 DS4400 

FAStT900 DS4500 

EXP700 DS4000 EXP700 

EXP710 DS4000 EXP710 

EXP100 DS4000 EXP100 

FAStT FlashCopy FlashCopy for DS4000 

FAStT VolumeCopy VolumeCopy for DS4000 

FAStT Remote Mirror (RM) Enhanced Remote Mirroring for DS4000 

FAStT Synchronous Mirroring Metro Mirroring for DS4000 

Global Copy for DS4000
(New Feature = Asynchronous Mirroring 

without Consistency Group) 

Global Mirroring for DS4000
(New Feature = Asynchronous Mirroring with 

Consistency Group) 
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Supported features 

Table 3 indicates the support for FlashCopy, VolumeCopy, and the Enhanced 

Remote Mirror Option on the DS4100, DS4300, DS4300 Turbo, DS4400, DS4500, 

DS4700, and DS4800 Storage Subsystems. This support matrix requires that the 

DS4000 Storage Subsystem controller firmware be at version 06.1x.xx.xx and the 

Storage Manager host software at version 9.16. 

 Table 3. DS4000 Storage Subsystem Copy Services feature support 

Feature DS4100 Base DS4300 

Base 

DS4300 

Turbo 

DS4400 DS4500 DS4700 DS4800 

FlashCopy Supported Supported Supported Supported Supported Supported Supported 

v   Maximum 

number of 

logical drives 

that can be 

defined (See 

note 3) 

1024 1024 1024 2048 2048 1024 2048 

v   Maximum total 

FlashCopy 

logical drives 

(See note 4) 

512 512 512 1024 1024 512 1024 

v   Maximum 

FlashCopy 

logical drives 

per base RAID 

logical drive 

4 4 4 4 4 4 4 

VolumeCopy Supported1 Not 

supported 

Supported Supported Supported Supported Supported 

v   Maximum 

number of 

VolumeCopy 

target logical 

drives for a 

given source 

logical drive 

1023 1023 1023 2047 2047 1023 2047 

v   Maximum copy 

pairs per array 

1023 1023 1023 2047 2047 1023 2047 

v   Maximum 

running copies 

per array (See 

note 5) 

8 8 8 8 8 8 8 

Remote Mirror 

Option 

Supported2 Not 

supported2 

Supported Supported Supported Supported Supported 

v   Total Remote 

Mirror logical 

drives 

32 N/A 32 64 64 32 64

  

In Table 3, a superscript number appearing after an entry (for example: Not 

supported1) indicates the number of a relevant item in the Notes list shown below. 

When a row heading entry references a Notes list item, the entry is followed by a 

text reference (for example: See note 2). 
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Notes:  

1.   VolumeCopy is supported with DS4100 controller firmware version 06.12.1x.xx 

or higher. 

2.   See the IBM DS4000 Storage Manager Installation and User’s Guide for your 

host operating system for more information about Storage Manager controller 

firmware support for the various DS4000 Storage Subsystems. 

3.   Enhanced Remote Mirroring is not available for FAStT200, FAStT500, or 

DS4100 single-controller storage subsystems, or for DS4300 standard (base) 

and single-controller storage subsystems. Please contact IBM representatives or 

resellers for availability of such support in the future. (You can use FAStT500 

Storage Subsystems with the previous synchronous-mode-only Remote 

Mirroring Option.) 

4.   When using firmware version 05.xx.xx.xx or higher, the firmware reserves one 

logical drive for use by the system. For firmware version 05.2x.xx.xx or higher, 

the maximum number of logical drives includes the FlashCopy repository logical 

drives, the VolumeCopy target logical drive and the Remote Mirror logical drives 

in addition to the standard data logical drives. If the Remote Mirror Option is 

enabled, two logical drives are reserved for use by the system. 

5.   The total number of FlashCopy logical drives is limited to one half of the total 

number of logical drives. 

6.   Refers to logical drives in the copy-in-progress state. 

7.   DS4300 and DS4100 Single-Controller (SCU) storage subsystems are not 

supported with Storage Manager controller firmware version 06.1x.xx.xx, or with 

AIX host operating systems.

New features and enhancements 

DS4000 Storage Manager 9.23 supports controller firmware versions 4.01.xx.xx - 

06.23.xx.xx. 

DS4000 Storage Manager 9.23 (with controller firmware 06.23.xx.xx) provides 

support for attachment of DS4000, EXP100, EXP710 and EXP810 Storage 

Expansion Enclosures to DS4800, DS4700, DS4500 and DS4300 Storage 

Subsystems. 

Currently, the only DS4000 storage subsystems that are supported with the 

controller firmware version 6.23.xx.xx are the DS4300, DS4500, DS4700 and 

DS4800. Contact your IBM service representative for other DS4000 storage 

subsystem support in the future. 

Note:  For information about supported host operating systems and operating 

system requirements, see the Storage Manager readme file for your 

operating system. 

FAStT product renaming 

IBM is in the process of renaming some FAStT family products. For a reference 

guide that identifies each new DS4000 product name with its corresponding FAStT 

product name, see “FAStT product renaming” on page 3. 

Storage Manager 9.23 Release 1 (controller firmware 6.23.xx.xx 

and later): New features 

Controller firmware version 6.23.xx.xx (and later) supports: 

v   New 4Gbps 300GB/15Krpm Fiber Channel Disk Drive Module 

v   New 750GB Serial; ATA Disk Drive Module 
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v   DS4700 and EXP810 Fibre Channel and SATA intermix within the same 

enclosure 

v   EXP810, EXP710, and EXP100 attachment to DS4300, DS4500, DS4700, and 

DS4800 

v   Enhanced Disk Drive Predictive Fault Analysis 

v   All of the features listed in “Storage Manager 9.16 Release 2 (controller firmware 

6.16.4x.xx and later): New features”; “Controller firmware 6.14 and 6.15: New 

features” on page 7; “Controller firmware 6.12: New features” on page 7; and 

“Controller firmware 6.10: New features” on page 8.

Storage Manager 9.19 (controller firmware 6.19.xx.xx and later): 

New features 

Controller firmware version 6.19.xx.xx provides support for: 

v   Attaching the DS4000 EXP810 storage expansion enclosure to the DS4300 

Standard-Dual Controller models or Turbo models and the DS4500 

v   Intermixing of DS4000 EXP810 with DS4000 EXP710 and/or EXP100 storage 

expansion enclosures behind the DS4300 Standard-Dual Controller models or 

Turbo models and the DS4500 - All models 

v   Daylight saving time as required by the enactment of the United States’s Energy 

Policy Act or 2005

Storage Manager 9.16 Release 2 (controller firmware 6.16.4x.xx 

and later): New features 

Controller firmware version 6.16.4x.xx (and later) supports: 

v   DS4700 Storage Subsystem models 70A/H and 72A/H, which support the 

attachment of DS4000 EXP710 and EXP810 Storage Expansion Enclosures 

v   New DS4800 Storage Subsystem Model 80A/H, which provides the same 

functionality as the DS4500 Storage Subsystem, with better performance. 

v   New 4 Gb Fibre Channel drives in the DS4000 EXP810 Storage Expansion 

Enclosure 

v   All of the features listed in “Storage Manager 9.16 Release 1 (controller firmware 

6.16.xx.xx - 6.16.3x.xx): New features,” “Controller firmware 6.14 and 6.15: New 

features” on page 7, “Controller firmware 6.12: New features” on page 7, and 

“Controller firmware 6.10: New features” on page 8.

Attention:  Controller firmware 06.16.xx.xx does not support EXP100 storage 

expansion enclosures. Do not download it into DS4000 storage 

subsystems that have EXP100 enclosures attached. After the 

06.16.xx.xx controller firmware is activated, the DS4000 storage 

subsystem will not recognize the drives in EXP100 enclosures, causing 

loss of data availability to the RAID arrays and logical drives that are 

defined in those drives. 

Storage Manager 9.16 Release 1 (controller firmware 6.16.xx.xx - 

6.16.3x.xx): New features 

With this version of controller firmware, 6.16.xx.xx - 6.16.3x.xx, you can connect 

DS4000 EXP810 storage expansion enclosures to DS4800 storage subsystems. 

Controller firmware versions 6.16.xx.xx - 6.16.3x.xx supports: 

v   DS4800 storage subsystem (only) 

v   EXP810 and EXP710 storage expansion enclosures (only) 

v   Automatic ESM firmware synchronization with the new EXP810 storage 

expansion enclosure: When you install a new ESM into an existing EXP810 that 
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is attached to a DS4000 storage subsystem that supports automatic ESM 

firmware synchronization, this feature resolves firmware mismatch conditions by 

automatically synchronizing the firmware in the new ESM with the firmware in the 

existing ESM. 

v   All of the features listed in “Controller firmware 6.14 and 6.15: New features,” 

“Controller firmware 6.12: New features,” and “Controller firmware 6.10: New 

features” on page 8, with the following exception:

Exception:  Controller firmware version 6.16.xx.xx does not support the DS4000 

Fibre Channel/SATA Intermix premium feature.

Attention:  Controller firmware 06.16.xx.xx does not support EXP100 storage 

expansion enclosures. Do not download it into DS4000 storage 

subsystems that have EXP100 enclosures attached. After the 

06.16.xx.xx controller firmware is activated, the DS4000 storage 

subsystem will not recognize the drives in EXP100 enclosures, causing 

loss of data availability to the RAID arrays and logical drives that are 

defined in those drives. 

Controller firmware 6.14 and 6.15: New features 

With controller firmware version 6.15.xx.xx, the DS4800 storage subsystem utilizes 

all of the available data cache memory installed in each controller blade for I/O 

caching. (With controller firmware version 06.14.xx.xx, the DS4800 uses only the 

first 1 GB of the installed data cache memory per controller for I/O caching.) 

Controller firmware versions 6.14.xx.xx and 6.15.xx.xx support: 

v   DS4800storage subsystem (only) 

v   All of the features listed in “Controller firmware 6.10: New features” on page 8 

and “Controller firmware 6.12: New features.”

Controller firmware 6.12: New features 

Controller firmware 6.12.xx.xx and later versions all of the features listed in 

“Controller firmware 6.10: New features” on page 8 in addition to the following new 

features: 

DS4000 FC/SATA Intermix update: Premium Feature Key 

DS4000 Storage Manager 9.1x with controller firmware 06.12.xx.xx (and 

later) supports enabling of the DS4000 FC/SATA Intermix premium feature 

using a Premium Feature Key. 

 For more information about using the Intermix premium feature, including 

configuration and set-up requirements, see the IBM TotalStorage DS4000 

Fibre Channel and Serial ATA Intermix Premium Feature Installation 

Overview. 

New DS4000 Storage Manager installation option 

DS4000 Storage Manager 9.1x with controller firmware 06.12.xx.xx (and 

later) features an installation wizard that enables you to automatically install 

Storage Manager software packages on your host server. 

Note:  Using the DS4000 Storage Manager installation wizard requires a 

system with a graphics card installed. You still have the option of 

installing the stand-alone host software packages manually. The 

packages are included with the installation CD.
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Support for DS4100 standard (base) SATA Storage Subsystems 

Storage Manager 9.1x with controller firmware 06.12.xx.xx (and later) 

supports DS4100 Standard (Base) SATA Storage Subsystems.

Note:  FC/SATA Intermix and Enhanced Remote Mirroring premium features 

are not supported at this time with the DS4100 Standard (Base) 

Storage Subsystem. Also, the DS4100 Standard (Base) Storage 

Subsystem is not supported on AIX host operating systems.

DS4000 Storage Manager usability enhancements 

DS4000 Storage Manager 9.12 and later versions feature the following 

usability enhancements: 

v   Storage Partitioning wizard, which helps you easily create storage 

partitions 

v   Task Assistant, which helps guide you through common enterprise and 

subsystem management tasks 

v   Ability to extract SMART data for SATA drives

Controller firmware 6.10: New features 

Controller firmware 6.10.xx.xx and later versions support the following new 

features: 

Enhanced Remote Mirroring 

In addition to Metro Mirroring, IBM DS4000 Storage Manager version 9.1x 

with controller firmware level 6.10.11.xx (and later) also supports Global 

Copy and Global Mirroring Remote Mirror options. Please see the IBM 

System Storage DS4000 Storage Manager Version 9 Copy Services User’s 

Guide for more information. 

Note:  The terms “Enhanced Remote Mirror Option,” “Metro/Global Remote 

Mirror Option,” “Remote Mirror,” “Remote Mirror Option,” and 

“Remote Mirroring” are used interchangeably throughout this 

document, the SMclient, and the online help system to refer to 

remote mirroring functionality.

Parallel hard drive firmware download 

You can now download drive firmware packages to multiple drives 

simultaneously, which minimizes downtime. In addition, all files that are 

associated with a firmware update are now bundled into a single firmware 

package. See the Subsystem Management window online help for drive 

firmware download procedures. 

Notes:  

1.   Drive firmware download is an offline management event. You must 

schedule downtime for the download because I/O to the storage 

subsystem is not allowed during the drive firmware download process. 

2.   Parallel hard drive firmware download is not the same thing as 

concurrent download.

Staged controller firmware download 

You can now download the DS4000 controller firmware and NVSRAM to 

DS4300 Turbo and DS4500 Storage Subsystem for later activation. 

Depending on your firmware version, DS4000 Storage Subsystem model, 

and host operating system, the following options might be available: 

v   Controller firmware download only with immediate activation 

v   Controller firmware download with the option to activate the firmware at a 

later time
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Note:  Staged controller firmware download is not supported on DS4400 

Storage Subsystems.

Subsystem Management Window menu enhancements 

Troubleshooting, recovery and maintenance tools are now under the 

Advanced heading in the Subsystem Management window. The following 

submenus are available: 

v   Maintenance 

v   Troubleshooting 

v   Recovery

Full command-line interface capability 

All of the options that are available in SMclient are also available using 

either the script editor in the Enterprise Management window, or using your 

preferred command-line interface. For more information about using the 

command-line interface, see the Enterprise Management window online 

help. 

Support for DS4300 standard (base) Fibre Channel Storage Subsystems 

Storage Manager 9.1x with controller firmware 6.10.xx.xx (and later) 

supports DS4300 Standard (Base) Fibre Channel Storage Subsystems.

Note:  The FC/SATA Intermix and Enhanced Remote Mirroring premium 

features are not supported at this time with the DS4300 Standard 

(Base) Storage Subsystem. Also, the DS4300 Standard (Base) 

Storage Subsystem is not supported on AIX host operating systems.

DS4000 FC/SATA Intermix premium feature 

Storage Manager 9.1x with controller firmware 6.10.xx.xx (and later) 

supports the DS4000 FC/SATA Intermix premium feature. This premium 

feature supports the concurrent attachment of Fibre Channel and SATA 

storage expansion enclosures to a single DS4000 controller configuration. 

 With controller firmware 6.10.xx.xx and later versions, the FC/SATA Intermix 

premium feature is enabled using NVSRAM. 

 For more information about using the Intermix premium feature, including 

configuration and set-up requirements, see the IBM TotalStorage DS4000 

Fibre Channel and Serial ATA Intermix Premium Feature Installation 

Overview (GC26-7713). 

Support for DS4000 EXP710 storage expansion enclosures 

Storage Manager 9.1x with controller firmware 6.10.xx.xx (and later) 

supports DS4000 EXP710 storage expansion enclosures. 

Increased support for DS4000 EXP100 SATA storage expansion enclosures 

DS4000 EXP100 SATA storage expansion enclosures are now supported 

on DS4400 Fibre Channel Storage Subsystems. 

 Also, the DS4100 storage subsystem now supports up to seven EXP100 

SATA storage expansion enclosures. 

DS4000 Storage Manager usability enhancements 

DS4000 Storage Manager 9.10 and later versions feature the following 

usability enhancements: 

v   One-click collection of support data, drive diagnostic data, drive channel 

state management, controller ‘service mode,’ and the ability to save host 

topology information 
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v   Improved media error handling for better reporting of unreadable sectors 

in the DS4000 Storage Subsystem event log, and persistent reporting of 

unreadable sectors

Enabling premium features 

You must perform the following tasks to enable a premium feature on your storage 

subsystem: 

v   “Obtaining the feature enable identifier” 

v   “Generating the feature key file” 

v   “Enabling the premium feature” 

v   “Verifying that the premium feature is enabled” on page 11

To obtain the storage subsystem premium feature identifier string, ensure that your 

controller unit and storage expansion enclosures are connected, powered on, and 

managed using the SMclient. Continue with the next section. 

Obtaining the feature enable identifier:   Each storage subsystem has its own 

unique feature enable identifier. This identifier ensures that a particular feature key 

file is applicable only to that storage subsystem. Complete the following steps to 

obtain the feature enable identifier: 

1.   Click Start → Programs → Storage Manager 9 Client. The Enterprise 

Management window opens. 

2.   In the Enterprise Management window, double-click the storage subsystem for 

which you want to enable the premium feature. The Subsystem Management 

window opens for the selected storage subsystem. 

3.   In the Subsystem Management window, click Storage Subsystem → Premium 

Features → List. The List Premium Features window opens and displays the 

feature enable identifier. 

4.   Record the feature enable identifier. 

5.   Close the List Premium Features window. 

6.   Continue to next section, “Generating the feature key file.”

Note:  To check the status of an existing premium feature, select Storage 

Subsystem → Premium Features → List from the pull-down menu.

Generating the feature key file:   You can generate the feature key file by using 

the Premium Feature Activation tool that is located at the following Web site:

www-912.ibm.com/PremiumFeatures/jsp/keyInput.jsp 

1.   Complete the steps in the Web site. Feature key file is e-mailed to you. 

2.   On your hard drive, create a new directory that you can find easily. (For 

example, name the directory FlashCopy feature key.) 

3.   Save the feature key file in the new directory.

Enabling the premium feature:   In the Storage Manager subsystem management 

window: 

1.   In the menu, click Premium Features → Enable. 

2.   Browse to the appropriate key file in the directory you saved it to in the previous 

task, “Generating the feature key file.” 

3.    Click OK. 

4.    Confirm that the premium feature is enabled. See the next section, “Verifying 

that the premium feature is enabled” on page 11.
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Verifying that the premium feature is enabled:   Perform the following steps to see a 

list of those premium features that are enabled on your storage subsystem: 

1.   In the Subsystem Management window, click Storage Subsystem → Premium 

Features → List. 

The List Premium Features window opens (see Figure 1). 

 

 The dialog lists the following items: 

v   The premium features that are enabled on the storage subsystem 

v   The feature enable identifier

2.   Click Close to close the window.

Disabling premium features:   In normal system operations, you do not need to 

disable the premium features. However, if you want to disable a premium feature, 

make sure that you have the key file or the IBM DS4000 premium feature 

entitlement card with the premium feature activation code for generating the key file. 

You need this key file to re-enable the premium feature at a later time. 

Perform the following steps to disable a premium feature on the storage subsystem: 

1.   In the Subsystem Management window, click Storage Subsystem → Premium 

Features → Disable. 

The Disable Premium Feature window opens, listing all the premium features 

that are enabled. 

2.   Select one item in the list, and then click OK. 

A confirmation dialog displays that states that disabling a premium feature is not 

recommended. 

3.   Click Yes. 

d
s
s
0
0
0
0
8

  

Figure 1. Listing premium features
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The Working dialog displays while the feature is being disabled. When the 

feature has been disabled, the Working dialog closes.

Notes:  

1.   If you want to enable the premium feature in the future, you must reapply the 

Feature Key file for that feature. 

2.   You can disable the Remote Mirror Option without deactivating the feature. If the 

feature is disabled but activated, you can perform all mirroring operations on 

existing remote mirrors. However, when the feature is disabled you cannot 

create any new remote mirrors. For more information about activating the 

Remote Mirror Option, see “Enabling and activating the Remote Mirror Option” 

on page 131 or see “Using the Activate Remote Mirroring Wizard” in the 

Storage Manager online help. 

3.   If a premium feature becomes disabled, you can access the Web site and 

repeat this process.

For any additional assistance, contact your local IBM service provider. Make sure 

you have the information listed in “Enabling the premium feature” on page 10 

available. 
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Chapter  2.  Overview  of  FlashCopy  

You use FlashCopy to create and manage FlashCopy logical drives. A FlashCopy 

logical drive is a point-in-time image of a standard logical drive in your storage 

subsystem. The logical drive that is copied is called a base logical drive. 

When you make a FlashCopy, the controller suspends write operations to the base 

logical drive for a few seconds while it creates a FlashCopy repository logical drive. 

This is a physical logical drive where FlashCopy metadata and copy-on-write data 

are stored. 

Note:  To ensure an accurate FlashCopy image of the base logical drive, you must 

follow the procedures that are described in “Preparing the host operating 

system” on page 27. 

You can create up to four FlashCopies of a base logical drive, and then write data 

to the FlashCopy logical drives to perform testing and analysis. For example, before 

upgrading a database management system, you can use FlashCopy logical drives 

to test different configurations. 

You can create FlashCopy logical drives for repeated reuse (frequent or nightly 

backups) or for one-time use (speculative change or upgrade testing). 

This chapter describes the following procedures: 

v   “Enabling FlashCopy” 

v   “Planning a FlashCopy logical drive” on page 14 

v   “Creating a FlashCopy logical drive” on page 27 

v   “Reusing a FlashCopy logical drive” on page 40 

v   “Performing FlashCopy tasks” on page 45

You can perform these procedures using the SMclient GUI interface, or with the 

command-line interface (SMcli) and the script editor. For more information, click the 

Help tab in the Enterprise Management window, and then search for SMcli or script 

editor. 

Notes:  

1.   FlashCopy is not supported on a DS4300 that is running firmware version 

05.33.xx.xx. 

2.   Making a FlashCopy of a ″Dynamic Disk″ type of logical drive is not supported 

on Windows operating systems.

Enabling FlashCopy 

To enable FlashCopy, you must perform the following tasks in the following order: 

1.   Obtain the feature enable identifier. This procedure is described in detail in 

“Obtaining the feature enable identifier” on page 10. 

2.   Generate the feature key file and enable FlashCopy. This procedure is 

described in detail in “Generating the feature key file” on page 10.

Before you begin, gather the following information: 

v   Your Feature Activation Code, which is printed on the IBM FlashCopy Premium 

entitlement card. 
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v   Your controller unit IBM serial number, which is printed on the label on the back 

of your DS4000 controller unit. 

v   A 32 alphanumeric-character IBM DS4000 Storage Subsystem premium feature 

identifier string.

To obtain the storage subsystem premium feature identifier string, ensure that your 

controller unit and storage expansion enclosures are connected, powered on, and 

managed using the SMclient. 

For information on how to view a list of those premium features that are enabled on 

your storage subsystem, see “Verifying that the premium feature is enabled” on 

page 11. 

Planning a FlashCopy logical drive 

Before you create a FlashCopy logical drive, make sure that you are familiar with 

the following concepts, which are described in this section: 

v   “Specifying FlashCopy repository logical drive failure settings” 

v   “Estimating FlashCopy repository logical drive capacity” on page 15 

v   “Estimating FlashCopy repository life” on page 17 

v   “Overview of the FlashCopy Logical Drive wizard” on page 18

Specifying FlashCopy repository logical drive failure settings 

When you create a FlashCopy logical drive, you also create and define the 

parameters of a physical logical drive that is called the FlashCopy repository logical 

drive. The repository logical drive is where FlashCopy data and copy-on-write data 

are stored. 

This section contains information that helps you choose the FlashCopy repository 

logical drive failure settings that you specify in the FlashCopy Logical Drive wizard. 

You should read this section before you create a FlashCopy logical drive, so that 

you have a better understanding of the parameters when you set them initially. 

For information about changing the properties of an existing FlashCopy repository 

logical drive, see “Changing FlashCopy repository logical drive properties” on page 

47. 

Repository capacity threshold warning level 

When you create the FlashCopy repository logical drive, you specify its capacity 

threshold warning level. 

The threshold warning is the only warning that is given before the FlashCopy 

repository logical drive becomes full, so do not ignore it. When you receive the 

Threshold Exceeded warning, you can perform one of the following two actions: 

v   Increase the capacity of the FlashCopy repository logical drive 

v   Increase the FlashCopy repository logical drive threshold capacity warning level

Important: Increasing the threshold capacity warning level reduces the amount of 

time that you have to perform the necessary tasks to prevent the FlashCopy 

repository logical drive from becoming full when you receive a Threshold Exceeded 

warning. 
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See “Specify Logical Drive Parameters panel” on page 20 for information about 

setting the capacity threshold warning level for the FlashCopy repository logical 

drive. 

If you are not sure how high to set the threshold warning level, accept the default 

setting. 

Repository full policy 

When you create the FlashCopy repository logical drive, you can specify the action 

that you want the system to perform when the drive reaches its capacity and 

becomes full. You can choose from the following two options: 

Fail FlashCopy logical drive 

When the FlashCopy repository logical drive becomes full, FlashCopy 

logical drive data is not recoverable and the FlashCopy cannot be 

accessed. In this case, the only possible action is to delete the FlashCopy 

logical drive or re-create the FlashCopy logical drive to create a new 

point-in-time image. 

 This is the default option. 

Fail writes to base logical drive 

When the FlashCopy repository logical drive becomes full, the FlashCopy 

logical drive data is still accessible. However, all write requests to the base 

logical drive are rejected until the FlashCopy repository logical drive 

capacity is increased. This is not a recommended setting. 

 Attention: The "Fail writes to base logical drive" option is not supported on 

AIX. Selecting this option might cause data loss on the base logical drive. If 

you are using AIX, select the "Fail FlashCopy logical drive" option, which is 

the default. Be sure to monitor the capacity of the FlashCopy repository 

logical drive, because you cannot access the FlashCopy if the repository 

logical drive becomes full.

For more information about increasing the storage capacity of an existing 

FlashCopy repository logical drive, see “Resizing a FlashCopy repository logical 

drive” on page 51. 

Estimating FlashCopy repository logical drive capacity 

If numerous I/O requests are written to the base logical drive, the FlashCopy 

repository logical drive can eventually exceed the base logical drive capacity if all 

the original data blocks are changed. 

Note:  Different operating systems might deal with data modifications, such as 

deleting, replacing, adding only, or deleting only, differently. For example, if 

you continuously delete and recreate a 10 MB file, the operating system 

might use only new disk blocks each time the file is created which causes 

the FlashCopy repository logical drive to become full with the original data. 

So, instead of generating the 10 MB worth of data in the FlashCopy 

repository logical drive, it might generate data up to the size of the base 

logical drive in the FlashCopy repository logical drive. 

You can estimate the FlashCopy repository logical drive capacity by calculating the 

amount of expected management overhead and the space required for 

copy-on-write data. 
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Note:  You should reestimate the FlashCopy repository logical drive capacity 

periodically. You can estimate the FlashCopy repository logical drive capacity 

by calculating the following figures: 

v   The amount of expected management overhead 

v   The space required for copy-on-write data 

v   The rate that the FlashCopy repository logical drive is filled up with the 

copy-on-write data

Considerations 

The following information can help you to determine the appropriate capacity of the 

FlashCopy repository logical drive: 

v   The minimum capacity of a FlashCopy repository logical drive is 8 MB. 

v   The amount of write activity to the base logical drive that takes place after the 

FlashCopy logical drive has been created determines the size of a FlashCopy 

repository logical drive. As the amount of write activity to the base logical drive 

increases, the number of original data blocks that need to be copied from the 

base logical drive to the FlashCopy repository logical drive also increases. 

v   The longer a FlashCopy logical drive remains enabled, the higher the risk of the 

FlashCopy repository logical drive reaching its maximum capacity. For more 

information, see “Estimating FlashCopy repository life” on page 17. 

v   There is not necessarily a one-to-one correlation between the number of data 

blocks that change on the base logical drive and the amount of copy-on-write 

data that is stored on the FlashCopy repository logical drive. The controller might 

copy over a full set of 32 blocks for performance reasons, even if only one set of 

blocks has changed. Keep this in mind when determining the percentage of the 

capacity of the base logical drive that can be copied to the FlashCopy repository 

logical drive.

Calculating estimated repository capacity 

The following formula should be used merely as a guide. When you estimate the 

FlashCopy repository logical drive capacity, keep in mind the information listed in 

“Considerations.”

Note:  When performing this calculation, you must convert the bytes to kilobytes, 

the kilobytes to megabytes, and the megabytes to gigabytes. 

Use the following formula to calculate the amount of expected management 

overhead: 

192 KB + (X / 2000) 

where X is the capacity of the base logical drive in bytes. 

Then, add this amount to the amount of space that is required for copy-on-write 

data. The result is the estimated FlashCopy repository logical drive capacity. 

Sample calculation:   On a base logical drive of 5 GB, 30% of the data blocks on 

the base logical drive are expected to change. 

1.   Calculate the amount of management overhead that is required. 

a.   Convert the capacity of the base logical drive to bytes. 

5 GB = 5 368 709 120 bytes 

b.   Divide the capacity of the base logical drive (in bytes) by 2000. 

5 368 709 120 / 2000 = 2 684 354.56 bytes 
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c.   Convert the result from step 1b on page 16 (in bytes) to kilobytes (KB). 

2 684 354.56 bytes = 2621.44 KB 

d.   Add 192 KB to the results from step 1c. 

192 KB + 2621.44 KB = 2813.44 KB 

e.   Convert the result from step 1d to megabytes (MB), then to gigabytes (GB). 

2813.44 KB = 2.75 MB = 0.002686 GB 

Result: The amount of required management overhead is 0.002686 GB. 

2.   Determine the amount of space (in gigabytes) that is required for copy-on-write 

data, using the percentage of the base logical drive that is expected to change 

(30%). 

30% of 5 GB = 1.5 GB 

Result: The amount of space that is required for copy-on-write data is 1.5 GB. 

3.   Add the result from step 2 to the result from step 1e. 

1.5 GB + 0.002686 GB = 1.502686 GB

Result: The estimated FlashCopy repository logical drive capacity is 1.502686 GB. 

For more information on estimating the FlashCopy repository logical drive capacity, 

see ″Learn About Estimating FlashCopy Repository Logical Drive Capacity″ in the 

FlashCopy online help. 

Estimating FlashCopy repository life 

When you initially define the properties of the FlashCopy repository logical drive, 

keep in mind the kind of usage that is planned for the FlashCopy logical drive. 

Understanding how the FlashCopy logical drive will be used can help you to 

estimate the life expectancy of the FlashCopy repository logical drive. 

After you have created the FlashCopy repository logical drive and some usage data 

is available, you can estimate its life expectancy using the following procedure as a 

guide. You can then change the properties of the FlashCopy repository logical drive, 

if necessary. 

Note:  The life expectancy of a FlashCopy repository logical drive should be 

re-estimated periodically. 

1.   Select the FlashCopy repository logical drive in the Logical/Physical view. Click 

Logical Drive → Properties and click the Capacity tab. 

2.   Record the creation timestamp day and time. 

3.   Record the capacity used (GB) and the available capacity (GB). 

4.   Determine the elapsed time (t) by subtracting the creation time from the current 

time, expressing the elapsed time in either minutes, hours, or days. 

5.   The total time (Tr) that the repository is available for copy-on-write data can now 

be estimated, based on the current usage. Multiply the elapsed time (t) by the 

available capacity (Ct), and then divide the resultant number by the capacity 

used (Cu). 

Use the following formula: 

Tr =(t *Ct)/Cu 

Where: 

Tr Total time available 

t Elapsed time 
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Ct Available capacity 

Cu Capacity used

Note:  The total time available (Tr) indicates the total usage time for the FlashCopy 

repository logical drive. 

Using the result of these calculations, you can decide whether to increase the 

capacity of the FlashCopy repository logical drive. If the repository capacity 

becomes 100% full during the expected lifetime of the FlashCopy, then you should 

increase the capacity of the FlashCopy repository logical drive. 

For more information, see “Resizing a FlashCopy repository logical drive” on page 

51. 

Overview of the FlashCopy Logical Drive wizard 

This section contains descriptions of the parameters that you specify on the 

following FlashCopy Logical Drive wizard panels: 

v   Introduction 

v   Allocate Capacity 

v   Specify Logical Drive Parameters 

v   Specify Array Parameters 

v   Specify Names 

v   Specify FlashCopy Repository Logical Drive Capacity 

v   Preview

Note:  See the FlashCopy Logical Drive wizard online help for additional 

information. 

Introduction panel 

The Introduction panel, shown in Figure 2 on page 19, provides a definition of a 

FlashCopy logical drive and describes its physical components. 
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On this panel you can select one of the following options: 

Simple 

You can use this option if there is free capacity in the array in which the 

base logical drive is allocated and the free capacity is at least 8 MB plus 

one percent (1%) of the base logical drive capacity. Select this option to 

specify basic FlashCopy parameters with default settings for FlashCopy 

logical drive mappings. 

Advanced 

You can use this option if you want to specify the following factors: 

v   Where the FlashCopy repository logical drive will be created 

v   All of the customizable FlashCopy settings

Allocate Capacity panel 

On the Allocate Capacity panel, shown in Figure 3 on page 20, you can specify 

where to allocate the repository storage capacity. 
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Figure 2. FlashCopy Logical Drive Wizard Introduction panel
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Free Capacity You can choose Free Capacity on same array as base or Free 

capacity on different array. These paths take you to the Specify 

Logical Drive Parameters panel, where you can define the mapping 

and repository logical drive parameters. 

Unconfigured Capacity 

This path takes you to the Specify Array Parameters panel, where 

you can specify a new array on which the repository resides and 

choose the RAID level of the array.

Specify Logical Drive Parameters panel 

Use the Specify Logical Drive Parameters panel, shown in Figure 4 on page 21, to 

specify the action that you want the system to perform when a FlashCopy 

repository logical drive reaches its capacity and becomes full. 
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Figure 3. Allocate Capacity panel
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FlashCopy logical drive parameters 

In this section of the panel you can specify one of the following options for 

logical drive-to-LUN mapping: 

Automatic 

If you choose this option, the system maps the FlashCopy logical 

drive automatically. 

Map later with Storage Partitioning 

If you choose this option, follow the procedure described in 

“Mapping the FlashCopy logical drive to the host” on page 30 after 

you have finished using the wizard.

Repository logical drive parameters 

In this section of the panel you can specify the threshold warning level and 

repository fail policy. 

Percent (%) full 

 This field specifies the threshold warning level for the FlashCopy 

repository logical drive. Storage Manager provides a warning 

message when the FlashCopy repository logical drive exceeds the 

threshold level that you specify. 
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Figure 4. Specify Logical Drive Parameters panel
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Important: This warning is the only notification that you receive 

before the repository becomes full. 

 The threshold warning level for the FlashCopy repository logical 

drive is initially set to 50%. If you are not sure how high to set the 

threshold warning level, accept this default setting.

You can specify one of the following actions that you want Storage Manager 

to perform when the repository becomes full: 

Fail FlashCopy logical drive 

If you specify this option, the FlashCopy logical drive data is not 

recoverable when the FlashCopy repository logical drive becomes 

full, and the FlashCopy cannot be accessed. In this case, the only 

possible action is to delete the FlashCopy logical drive or re-create 

the FlashCopy logical drive to create a new point-in-time image. 

 This is the default option. 

Fail writes to base logical drive 

If you specify this option, the FlashCopy logical drive data is 

accessible when the FlashCopy repository logical drive becomes 

full. However, the FlashCopy repository logical drive capacity must 

be increased so that writes to the base logical drive are not 

rejected. This is not a recommended setting. 

 Attention: AIX does not support the "Fail writes to base logical 

drive" option. Selecting this option might cause data loss on the 

base logical drive. If you are using AIX, select the "Fail FlashCopy 

logical drive" option, which is the default. Be sure to monitor the 

capacity of the FlashCopy repository logical drive, because you 

cannot access the FlashCopy if the repository logical drive 

becomes full.

 See “Specifying FlashCopy repository logical drive failure settings” on page 14 for 

more information about repository capacity and failure settings. 

When you click Next, the Preview panel opens and displays the parameters that 

you specified. Click Back to return to the previous panels to edit the repository 

parameters or click Finish to proceed to the Specify Names panel. 

Specify Array Parameters panel 

If you specified the Unconfigured Capacity option on the Allocate Capacity panel, 

the Specify Array Parameters panel shown in Figure 5 on page 23, displays. On this 

panel you can specify a new array on which to place the repository logical drive. 

You can also specify the RAID level of the array that meets the FlashCopy 

repository logical drive data storage and protection requirements. 
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Click Next to go to the Specify Names panel. 

Specify Names panel 

On the Specify Names panel, shown in Figure 6 on page 24, you can define the 

FlashCopy logical drive name and the name of its associated FlashCopy repository 

logical drive.
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Figure 5. Specify Array Parameters panel
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The default naming convention for the first FlashCopy uses the base volume name 

and adds a suffix of ″-1″ for the FlashCopy logical drive and ″-R1″ for the 

FlashCopy logical repository drive. The second FlashCopy increments this number 

to 2, and so on, up to the four volumes. 

For example, if you are creating the first FlashCopy logical drive for a base logical 

drive called DataVol, then the default FlashCopy logical drive name is DataVol-1. 

The associated FlashCopy repository logical drive default name is DataVol-R1. The 

default name of the next FlashCopy logical drive that you create based on DataVol 

is DataVol-2, and the corresponding FlashCopy repository logical drive name is 

DataVol-R2. 

Change the default names if required. 

The following are tips when changing names: 

v   You must choose a unique name for the FlashCopy and FlashCopy repository 

logical drives. Otherwise, the system displays an error message. 

v   Regardless of whether you use the software-supplied sequence number that (by 

default) populates the FlashCopy logical drive name or FlashCopy repository 

logical drive name field, the next default name for a FlashCopy or FlashCopy 

d
s
s
0
0
0
0
5

  

Figure 6. Specify Names  panel
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repository logical drive still receives a sequence number determined by the 

software. For example, you might name the first FlashCopy of base logical drive 

DataVol DataVolMay28, without using the software-supplied sequence number of 

-1. Regardless, the software assigns a default name for the next FlashCopy as 

DataVol-2. 

v   The next available sequence number is based on the number of existing 

FlashCopies of a base logical drive. If you delete a FlashCopy logical drive, the 

assigned sequence number becomes available again. 

v   Names have a 30-character limit, including spaces. When you reach this limit in 

either the FlashCopy logical drive name or FlashCopy repository logical drive 

name field, no more input is accepted. If the base logical drive name contains 30 

characters, the default names for the FlashCopy and its associated FlashCopy 

repository logical drive use the base logical drive name truncated just enough to 

add the sequence string. For example, for “Host Software Engineering Group 

GR-1”, the default FlashCopy name would be “Host Software Engineering GR-1”. 

The default repository name would be “Host Software Engineering G-R1.”

Click Next to go to the Specify FlashCopy Repository Logical Drive Capacity panel. 

Specify FlashCopy Repository Logical Drive Capacity panel 

On the Specify FlashCopy Repository Logical Drive Capacity panel, shown in 

Figure 7 on page 26, you can set the repository drive capacity as a percentage of 

the capacity of the base logical drive. 
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percent (%) of base logical drive 

This field sets the FlashCopy repository logical drive capacity as a 

percentage of the base logical drive. The default is 20%. 

 If you calculate a different capacity using the procedure described in 

“Estimating FlashCopy repository logical drive capacity” on page 15, you 

can increase or decrease the percentage in this field until the FlashCopy 

Repository Logical Drive Capacity value matches the estimated capacity 

that you calculated. You might need to round up the number.

Preview panel 

The Preview panel, shown in Figure 8 on page 27, displays the parameters that you 

have specified for the FlashCopy logical drive and the FlashCopy repository logical 

drive. If you click Finish on this panel, the FlashCopy logical drive create process 

initiates. 
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Figure 7. Specify Repository Logical Drive Capacity panel
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Creating a FlashCopy logical drive 

You can create a FlashCopy logical drive using the Create FlashCopy Logical Drive 

wizard. This section describes how to create a FlashCopy logical drive by 

performing the following procedures, in the order that they are listed: 

1.   “Preparing the host operating system” 

2.   “Creating a FlashCopy logical drive using the FlashCopy Logical Drive wizard” 

on page 29 

3.   “Mapping the FlashCopy logical drive to the host” on page 30 

4.   “Configuring the host for the FlashCopy logical drive” on page 33

Attention: Failure to complete the procedures that are required for your host 

operating system can result in an inaccurate point-in-time image of the base logical 

drive. 

Preparing the host operating system 

Before you create the FlashCopy, you must prepare the host operating system. 

Read the following information, then complete the “Steps for preparing the host 

operating system” on page 28. 
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Figure 8. Preview panel
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Flushing the operating system cached I/Os to disk 

 The FlashCopy function provides fast replication of data from the base 

logical drive to the target logical drive, and copies all data that has been 

successfully written to the DS4000 by the host. In some environments, data 

is stored in server memory cache and written to disk at some later time. 

Two examples of these types of environments are: 

v   Buffers for a database management subsystem (DBMS) 

v   Metadata for a journaled file system (JFS)

If buffers from the DBMS or metadata from the journaled file system are not 

flushed before a FlashCopy operation copies a base to a target, you might 

have to recreate the FlashCopy. In addition, you might also need to back 

out of current transactions (for DBMS), or run the fsck utility (for JFS). 

 To avoid these types of restart actions, ensure that all of the data that is 

related to the FlashCopy source volume has been written to disk before you 

perform the FlashCopy operation. For a DBMS, you can accomplish this by 

quiescing the subsystem or by using a DBMS command such as DB2®'s 

LOG SUSPEND. For a journaled file system, you can accomplish this by 

unmounting the FlashCopy base logical drive. 

Stopping I/O to the base logical drive 

 In the following procedure, “Steps for preparing the host operating system,” 

you will need to stop I/O by either stopping the host application that is 

accessing the base logical drive, or by placing the application in backup 

mode. 

 If you choose to place the application in backup mode, you must ensure 

that the application recovery files, such as rollback and redo logs, reside in 

different physical disk storage or on different logical drives from the 

FlashCopy base logical drive. Then, back up the application recovery files.

Note:  If the recovery files are on the base logical drive, placing the 

application in backup mode will not stop I/O to the base logical drive.

Steps for preparing the host operating system 

Complete the following steps to prepare the host operating system immediately 

before you create a FlashCopy logical drive. If you plan to use the FlashCopy 

logical drive at a later date, wait to complete these steps until immediately prior to 

creating the FlashCopy. 

1.   Stop the host application that is accessing the base logical drive, or place the 

application in backup mode.

Note:  Placing the application in backup mode requires some additional 

preparation. See the preceding section, ″Stopping I/O to the base logical 

drive.″ 

2.   Synchronize the file system and flush the operating system cached I/Os to disks 

by unmounting the base logical drive. See the preceding section, ″Flushing the 

operating system cached I/Os to disk,″ for more information.

Note:  In Microsoft® Windows environments, you can use the SMrepassist utility 

to flush the operating system cache I/Os, instead of unmounting the base 

logical drive. For more information on the SMrepassist utility, see the 

″SMrepassist″ topic in the Storage Manager online help.
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Additional information for Microsoft Windows Server 2003 interfaces: 

Windows Server 2003 provides a means for applications to issue calls to flush I/Os 

and to make flashcopy without having to shut down the applications. The Microsoft 

Virtual Disk Service (VDS) and Microsoft Volume Shadow-copy Service (VSS) are 

storage management interfaces for Microsoft Windows Server 2003. VDS and VSS 

enable your storage array to easily interact with third-party applications that use the 

VDS or VSS Application Programming Interface (API). Microsoft VDS/VSS is 

included in the Windows 2003 installation. The SANtricity VDS hardware provider is 

a Windows Dynamic Linked Library (DLL). It is loaded by VDS and used as a 

communication channel to your storage array. With the SANtricity VDS hardware 

provider installed, third-party applications can send management commands to your 

storage array. Creating volumes, deleting volumes and unmasking volumes are 

some the commands supported. It is also possible for third-party applications to 

obtain status and configuration information on the storage array. The SANtricity VSS 

hardware provider is a Windows service (.exe). VSS attaches to the service and 

uses it to coordinate the creation of snapshot volumes on the storage array. 

VSS-initiated flashcopy volumes can be triggered through third-party backup tools. 

For information on installing and using SANtricity VDS/VSS, see the README file. 

Additional information for hosts that use ADT/AVT: Ensure that the base logical 

drive and its associated FlashCopy logical drives are both on the same controller 

ownership/preferred path in host operating system environments that use the 

DS4000 automatic logical drive transfer (ADT) feature to failover and failback logical 

drives. Otherwise, the base logical drive and its associated FlashCopy logical drives 

can move back and forth between controllers, causing logical unit number (LUN) 

access problems.

Note:  ADT is sometimes also referred to as automatic volume transfer (AVT). 

The preferred path can be either Controller A or Controller B, if you ensure that the 

base logical drive, FlashCopy logical drive, and FlashCopy repository logical drive 

are owned by the same controller, and that the controller owner is configured as the 

preferred path from the hosts.

Note:  If a path failure causes one of the logical drives to fail over to the other 

controller, so that the base and FlashCopy logical drives are no longer on 

the same controller, perform one of the following steps: 

v   Manually move either the base or the FlashCopy logical drive so that both 

are on the same controller again. 

v   Correct the failing path immediately.

After you have prepared the host operating system, you can create a FlashCopy 

logical drive using the wizard, as described in the next section. 

Creating a FlashCopy logical drive using the FlashCopy Logical Drive 

wizard 

After you prepare the host operating system, create a FlashCopy logical drive using 

the FlashCopy Logical Drive wizard, which you access through SMclient. 

Before you begin, refer to “Overview of the FlashCopy Logical Drive wizard” on 

page 18 to view screen captures of the FlashCopy Logical Drive wizard panels and 

read descriptions of the parameters. 

To create a FlashCopy logical drive, perform the following steps : 

 

Chapter 2. Overview of FlashCopy 29



1.   Select a base logical drive from the Logical/Physical view of the Storage 

Manager Subsystem Management window. 

2.   Click Logical Drive → FlashCopy → Create. 

Note:  If the FlashCopy logical drive is to be based on the root disk of the host 

operating system, the final point-in-time image might not be completely 

consistent with the base logical drive. 

3.   Review the information in the initial panel. Click OK to proceed to the wizard 

introduction panel. 

4.   Follow the instructions on each wizard panel, and click Next when you are 

ready to continue to the next panel.

Note:  Each wizard panel has context-sensitive help. Click Help on a particular 

panel to receive help for that panel. 

5.   On the final Preview panel, which displays the associated logical drives and the 

components that make up the FlashCopy relationship, click Finish to continue. 

6.   The FlashCopy drives are now displayed in the Logical/Physical view of the 

Subsystem Management window. 

7.   Restart the host application. After you create one or more FlashCopy logical 

drives, mount the base logical drive and restart the host application using that 

base logical drive.

If you did not choose automatic mapping when using the wizard, go to “Mapping the 

FlashCopy logical drive to the host.” If you chose automatic mapping, go to 

“Configuring the host for the FlashCopy logical drive” on page 33.

Note:  You are not done creating the FlashCopy logical drive until you have 

completed the procedure described for your host operating system in 

“Configuring the host for the FlashCopy logical drive” on page 33. 

Mapping the FlashCopy logical drive to the host 

Use the Mappings view in the SMclient to assign logical drive-to-LUN mappings 

between the FlashCopy logical drive and the host that will access the FlashCopy 

logical drive. 

Note:  Because the FlashCopy logical drive is an exact copy of the original base 

logical drive, if you map both a base logical drive and its associated 

FlashCopy logical drives to the same host, it can result in conflicts if the host 

operating systems or the logical volume manager software depend on the 

data in the logical drive to identify it. For more information on how to properly 

configure your host operating system, see “Configuring the host for the 

FlashCopy logical drive” on page 33. 

Perform the following steps to map the FlashCopy logical drive to a host: 

1.   In the SMclient, open the Mappings view of the Subsystem Management 

window, as shown in Figure 9 on page 31. The newly created FlashCopy logical 

drive displays in the undefined mapping section.
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2.   Right-click the host or host group to which you want to map the drive, and click 

Define Additional Mapping, as shown in Figure 10.
 

3.   In the Define Additional Mapping window, specify the following options, as 

shown in Figure 11 on page 32. 

v   Select the host or host group. 

v   Set the LUN number. 

v   Select the FlashCopy logical drive. 
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Figure 9. Undefined FlashCopy disk
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Figure 10. Define Additional Mapping
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v   Click Add.
 

When you are finished, the FlashCopy logical drive is available to the host or 

host group, as shown in Figure 12 on page 33.
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Figure 11. The Define Additional Mapping window
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In the mapping example shown in Figure 11 on page 32 and Figure 12, the 

FlashCopy logical drive named DataVol-1 is made available to the backup 

server host group. This enables the backup server to access and mount the 

drive as part of its own file system. It also allows a local backup to be 

performed by the backup application software. 

It is possible to map the FlashCopy logical drive to the same server that owns 

the base logical drive. However, immediately after you create the FlashCopy, 

the two logical drives are exactly the same (a block-by-block copy). Many 

operating systems do not tolerate seeing an exact duplicate logical drive. You 

might need to complete other steps, such as restarting your computer or 

running the Hot_Add utility, before you can access the FlashCopy logical drive. 

For more information, see the IBM System Storage DS4000 Storage Manager 

Version 9 Installation and Support Guide for your operating system.

Note:  If you use this FlashCopy on a regular basis (for example, for backup 

purposes), use the Disable FlashCopy and Re-create FlashCopy options 

to reuse the FlashCopy. Using these options preserves the existing 

mappings to the FlashCopy logical drive. For more information, see 

“Disabling a FlashCopy logical drive” on page 48 and “Re-creating a 

FlashCopy logical drive” on page 50.

After you have mapped the FlashCopy logical drive, configure the host, as 

described in “Configuring the host for the FlashCopy logical drive.” 

Configuring the host for the FlashCopy logical drive 

After you use the Create FlashCopy Logical Drive wizard to create the FlashCopy 

logical drive and map the FlashCopy logical drive to the host, you must complete 

some additional steps to configure the host operating system. 

Complete the procedure that is applicable for your host operating system: 

v   “Instructions for AIX” on page 34 
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Figure 12. Mapped FlashCopy logical disk
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v   “Instructions for HP-UX” on page 36 

v   “Instructions for Solaris” on page 38 

v   “Instructions for Windows 2000 and Windows Server 2003” on page 39 

v   “Instructions for Windows NT” on page 39 

v   “Instructions for Novell NetWare” on page 40

Attention: You must complete the procedure described for your host operating 

system in this section. Failure to do so can result in an inaccurate point-in-time 

image of the base logical drive. 

Using the script editor and the command-line interface 

If you are using an AIX, HP-UX, Linux or Solaris host, you must use the script 

editor or command line interface (SMcli) to configure your host for the new 

FlashCopy logical drive. 

You can use the script editor to create or edit a script file, save a script file to the 

local disk of the Storage Management station, or load a script file from disk. You 

can also use SMcli to issue individual commands to the scripting engine from the 

host operating system command shell or to call complete pre-written scripts. 

For more information about how to use SMcli and the script editor, click the Help 

tab on the Enterprise Management window. 

Instructions for AIX 

Use the following procedures on a host that is running AIX using Logical Volume 

Manager (LVM). 

Restrictions: 

v   FlashCopy logical drives can be created only for AIX arrays. If a filesystem 

contains more than one logical drive you must create a FlashCopy logical drive 

for each logical drive in the filesystem. 

v   AIX does not support the "Fail writes to base logical drive" option of the 

repository full policy. Selecting this option might cause data loss on the base 

logical drive. You must ensure that the repository full policy is set to the default 

option, "Fail FlashCopy logical drive." 

For information about how to set the repository full policy, see “Changing 

FlashCopy repository logical drive properties” on page 47.

Before you begin, perform the following: 

v   Read the information in “Planning a FlashCopy logical drive” on page 14 and 

“Using the script editor and the command-line interface.” 

v   Perform the procedures that are described in the previous sections: 

1.   “Preparing the host operating system” on page 27 

2.   “Creating a FlashCopy logical drive using the FlashCopy Logical Drive 

wizard” on page 29 

3.   “Mapping the FlashCopy logical drive to the host” on page 30

To configure the AIX host for the new FlashCopy logical drives, perform the 

following steps: 

 1.   Log in to the host as root. 

 2.   Ensure that the host operating system recognizes the FlashCopy logical drives. 

At the host prompt, type the following command, and then press Enter. 
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cfgmgr
  

Several minutes might pass while the operating system accesses the drives. 

When the operation completes, the host prompt displays again. The new 

logical drives are now available from the operating system. 

 3.   At the host prompt, type the following command, and then press Enter. 

 lspv
  

A list of the physical drives that are recognized by the operating system 

displays. 

 4.   Look for the operating system device name of your FlashCopy logical drive in 

the list. The list shows a physical logical drive ID (PVID) for the FlashCopy 

logical drive. This is the same as the PVID for the associated base logical 

drive, because the FlashCopy logical drive contains the same array data 

structures as the base logical drive. 

 5.   Clear the PVID for the FlashCopy logical drives. At the host prompt, type the 

following command, and then press Enter. 

 chdev -l os_device_name -a pv=clear
  

where os_device_name is the operating system device name of the FlashCopy 

logical drive. 

Repeat this step for each FlashCopy logical drive in the AIX array. 

 6.   Re-create a new array using the recreatevg command. This command reads 

the array data structure inside a logical drive and reconstructs it. It also 

allocates new physical logical drive identifiers (PIDs) to the FlashCopy logical 

drives and enables access to the FlashCopy logical drive for the selected host. 

At the host prompt, type the following command, and then press Enter: 

 recreatevg -y logical drivegroupname -L /directoryname os_device_name
  

where: 

v   logical drivegroupname is the name that you want to assign to the 

FlashCopy array. 

v   directoryname is the name of the directory where you want to mount the 

FlashCopy logical drive. 

v   os_device_name is the operating system device name of the FlashCopy 

logical drive. If your AIX array contains more than one FlashCopy logical 

drive, add an os_device_name for each logical drive.

The array is re-created, and contains the FlashCopy logical drive or drives. 

 7.   Mount the FlashCopy logical drive to its intended host. At the host prompt, type 

the following command, and then press Enter. 

 mount mount-point
  

where mount-point is the name of the file system that is being mounted. 

Include the directoryname that was used in step 6. 

 8.   Ensure that the logical drives are back online. At the host prompt, type the 

following command, and then press Enter. 

 df -k
  

A list of the mounted disks displays. 
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9.   Use the FlashCopy logical drive with your backup application or with another 

application. 

10.   When the FlashCopy logical drive is no longer required, unmount the file 

system. At the host prompt, type the following command, and then press Enter. 

 umount mount-point
  

11.   Disable or delete the FlashCopy logical drive after it is no longer needed. 

If you disable the FlashCopy logical drive instead of deleting it, you can retain 

the FlashCopy logical drive and its associated FlashCopy repository logical 

drive. Then, when you need to create a different FlashCopy of the same base 

logical drive, you can re-create the disabled FlashCopy logical drive. This takes 

less time than creating a new FlashCopy logical drive and avoids any reduction 

in performance that might occur if the FlashCopy logical drive remains 

available. 

To disable or delete a FlashCopy logical drive, in the Subsystem Management 

window, right-click the FlashCopy logical drive icon and select either Disable 

or Delete. 

12.   Delete the array that you created in step 6 on page 35, that contains the 

FlashCopy logical drives. At the host prompt, type the following commands, 

and then press Enter. 

 varyoffvg logical drivegroupname exportvg logical drivegroupname 

  

where logical drivegroupname is the name of the FlashCopy array.

Instructions for HP-UX 

Use the following procedures on a host that is running HP-UX 11.0 (or higher) and 

uses LVM (or higher). Failure to complete the steps listed can result in an 

inaccurate point-in-time image of the base logical drive. 

Before you begin, perform the following: 

v   Read the information in “Planning a FlashCopy logical drive” on page 14 and 

“Using the script editor and the command-line interface” on page 34. 

v   Perform the procedures that are described in the previous sections: 

1.   “Preparing the host operating system” on page 27 

2.   “Creating a FlashCopy logical drive using the FlashCopy Logical Drive 

wizard” on page 29 

3.   “Mapping the FlashCopy logical drive to the host” on page 30

To configure the HP-UX host for the new FlashCopy logical drives, perform the 

following steps: 

1.   At the host prompt, type the following command, and then press Enter. 

 ioscan -fn
  

A list of the mapped devices that are recognized by the host displays.

Note:  If the required device names are not displayed by using this command, 

type the following command at the host prompt, and then press Enter. 

 insf
  

2.   Remount the base logical drive to its original host.
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Note:  If I/O activity to the base logical drive was stopped or data transfer was 

suspended, resume I/O activity to the base logical drive or re-enable data 

transfer at this time. 

3.   Perform the following steps to import the FlashCopy logical drives into the LVM: 

a.   Create a new directory for the new array, as shown in the following 

example. 

 mkdir /dev/vg02
  

b.   Create a group node for the new array, as shown in the following example. 

 mknod /dev/vg02/group c 64 -0x020000 

  

c.   Import the FlashCopy logical drive LUNs. At the host prompt, type the 

following command, and then press Enter. 

 vgimport /dev/vg02 FlashCopy-block-node-1 FlashCopy-block-node-2
  

The following example addresses how to handle redundancy with multiple 

paths. The two paths or nodes represent the primary and alternate paths of 

the FlashCopy volume. 

 vgimport /dev/vg02 /dev/dsk/c66t0d1 /dev/dsk/c69t0d1
  

Note:  You must verify that the /dev/dsk device files exist on the FlashCopy 

logical drive. Use the SMdevices utility or the HP-UX ioscan utility to 

perform the verification. 

The system displays a warning indicating that a backup of the array that is 

being imported might not exist on the host. This message is only a warning 

and requires no response. The import operation continues and completes 

successfully. 

The backup for this array is created later, when it is exported. 

d.   Activate the new array, as shown in the following example: 

 vgchange -a y /dev/vg02
  

4.   If a file system existed on the base logical drive, then it also exists on the 

FlashCopy logical drive. Before you mount the FlashCopy logical drive, 

however, perform a file system check to ensure that the file system is 

consistent, for example: 

 fsck /dev/vg02/lvol01 

  

5.   Mount the FlashCopy logical drive to its intended host. 

6.   Use the FlashCopy logical drive with your backup application or with another 

application. 

7.   Unmount the FlashCopy logical drive. 

8.   Disable or delete the FlashCopy logical drive after it is no longer needed. 

If you disable the FlashCopy logical drive instead of deleting it, you can retain 

the FlashCopy logical drive and its associated FlashCopy repository logical 

drive. Then, when you need to create a different FlashCopy of the same base 

logical drive, you can re-create the disabled FlashCopy logical drive. This takes 

less time than creating a new FlashCopy logical drive and avoids any reduction 

in performance that might occur if the FlashCopy logical drive remains available. 
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To disable or delete a FlashCopy logical drive, in the Subsystem Management 

window, right-click the FlashCopy logical drive icon and select either Disable or 

Delete.

Instructions for Solaris 

Use the following procedure on a host that is running Solaris 7 and 8. Failure to 

complete the steps listed can result in an inaccurate point-in-time image of the base 

logical drive. 

Before you begin, perform the following: 

v   Read the information in “Planning a FlashCopy logical drive” on page 14 and 

“Using the script editor and the command-line interface” on page 34. 

v   Perform the procedures that are described in the previous sections: 

1.   “Preparing the host operating system” on page 27 

2.   “Creating a FlashCopy logical drive using the FlashCopy Logical Drive 

wizard” on page 29 

3.   “Mapping the FlashCopy logical drive to the host” on page 30

To configure your operating system, perform the following steps: 

1.   At the host prompt: 

v   for an MPP/RDAC-based installation, type the following command, and then 

press Enter. 

 /etc/raid/bin/hot_add
  

v   for an MPXIO-based installation, type the following command, and then press 

Enter. 

 /etc/raid/bin/devfsadm -C
  

v   for a DMP-based installation, type the following command, and then press 

Enter. 

 /etc/raid/bin/vxdctl enable
  

This step ensures that the operating system is aware of the newly-created 

logical drives, without having to restart the host. 

2.   Run the SMdevices utility to associate the LUN with a host operating system 

device and to ensure that the FlashCopy logical drive is recognized by the host. 

This step ensures that the logical drive name and the operating system device 

name (assigned by the operating system) correlate. 

3.   If you plan to use the FlashCopy logical drive immediately, go to step 4. If you 

plan to use the FlashCopy logical drive at a later date, disable the FlashCopy 

logical drive now. Click Logical Drive → FlashCopy → Disable in the Subsystem 

Management window.

Note:  If I/O activity to the base logical drive was stopped or data transfer was 

suspended, resume I/O activity to the base logical drive or re-enable data 

transfer at this time. 

4.   Mount the FlashCopy logical drive to its intended host. 

5.   Use the FlashCopy logical drive with your backup application, for speculative 

testing, or with another application. 

6.   Unmount the FlashCopy logical drive. 
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7.   Disable or delete the FlashCopy logical drive after it is no longer needed. 

If you disable the FlashCopy logical drive instead of deleting it, you can retain 

the FlashCopy logical drive and its associated FlashCopy repository logical 

drive. Then, when you need to create a different FlashCopy of the same base 

logical drive, you can re-create the disabled FlashCopy logical drive. This takes 

less time than creating a new FlashCopy logical drive and avoids any reduction 

in performance that might occur if the FlashCopy logical drive remains available. 

To disable or delete a FlashCopy logical drive, in the Subsystem Management 

window, right-click the FlashCopy logical drive icon and select either Disable or 

Delete.

Instructions for Windows 2000 and Windows Server 2003 

You cannot add the FlashCopy logical drive to the same Windows 2000 or Windows 

Server 2003 server that the FlashCopy base logical drive is mapped to. You must 

add the FlashCopy logical drive to another Windows 2000 or Windows Server 2003 

server, or unmap the base logical drive from the server that it is mapped to. 

Note:  Making a FlashCopy of a Dynamic Disk type of logical drive is not supported 

on Windows operating systems. 

Complete the following steps to configure your host for the new FlashCopy logical 

drives: 

1.   Run the hot_add utility to let the system recognize the newly-added FlashCopy 

logical drive.

Note:  If the system does not recognize the FlashCopy logical drive after you 

run the hot_add utility, restart the server. 

2.   In the System Management window, open the Disk Management directory and 

assign a drive letter or mount point to the new FlashCopy logical drive. 

3.   When you no longer need the FlashCopy logical drive, remove the drive letter or 

mount point from the Disk Management directory before you delete the 

FlashCopy logical drive.

Instructions for Windows NT 

Complete the following steps to configure your host for the new FlashCopy logical 

drive: 

1.   Run the hot_add utility to let the system recognize the newly-added FlashCopy 

logical drive.

Note:  If the system does not recognize the FlashCopy logical drive after you 

run the hot_add utility, restart the server. 

2.   Resolve duplicate logical drive signatures by navigating to the following 

directory: C:\Program Files\IBM_DS4000\util and typing the following command 

in the Windows command line window: 

 SMrepassist -r
  

3.   In the NT4 Disk Administrator window, assign a drive letter to the new 

FlashCopy logical drive. 

4.   When you no longer need the FlashCopy logical drive, open the NT4 Disk 

Management window and remove the drive letter before you delete the 

FlashCopy logical drive.
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Instructions for Novell NetWare 

You cannot add the FlashCopy logical drive to the same NetWare server where the 

FlashCopy base logical drive is located. You must add the FlashCopy logical drive 

to another NetWare server, or unmap the base logical drive from the server that it is 

mapped to. 

Complete the following steps to configure your host for the new FlashCopy logical 

drive: 

1.   Run the hot_add utility to let the system recognize the newly-added FlashCopy 

logical drive.

Note:  If the system does not recognize the FlashCopy logical drive after you 

run the hot_add utility, restart the server. 

2.   Type the logical drive in the command window, or use the Disk Management 

menu in the ConsoleOne window to verify that the drive is added.

Reusing a FlashCopy logical drive 

Typically, after a FlashCopy logical drive is created, it is disabled until a new 

point-in-time image of the same base logical drive is needed. 

To create a new point-in-time image of the same base logical drive, complete the 

procedure that is applicable for your host operating system: 

v   “Instructions for AIX” 

v   “Instructions for HP-UX” on page 42 

v   “Instructions for Solaris” on page 43 

v   “Instructions for Windows” on page 44 

v   “Instructions for Novell NetWare” on page 44

Instructions for AIX 

Before you begin, stop all I/O activity to the base logical drive, or suspend data 

transfer. This ensures that you capture an accurate point-in-time image of the base 

logical drive. For more information, see “Preparing the host operating system” on 

page 27. 

To create a new point-in-time image of the same base logical drive, perform the 

following steps: 

1.   Unmount the file systems in the array on which the FlashCopy logical drive is to 

be based. At the host prompt, type the following command, and then press 

Enter. 

 umount mount-point
  

where mount-point is the name of the file system that is being unmounted. 

2.   In the Storage Manager Subsystem Management window, re-create the 

FlashCopy logical drive. Click Logical Drive → FlashCopy → Re-create in the 

Subsystem Management window. 

3.   Ensure that the host operating system recognizes the FlashCopy logical drive. 

At the host prompt, type the following command, and then press Enter. 

 cfgmgr
  

Several minutes might pass while the operating system accesses the drives. 
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When the operation completes, the host prompt displays again.The new logical 

drives are now available from the operating system. 

4.   Clear the PVID for the FlashCopy logical drives. At the host prompt, type the 

following command, and then press Enter. 

 chdev -l os_device_name -a pv=clear
  

where os_device_name is the operating system device name of the FlashCopy 

logical drive. 

Repeat this step for each FlashCopy logical drive in the AIX array.

 Attention:  Before specifying clear with the chdev command, verify that you 

are specifying the correct device name. If you specify a different device name, 

all of the data on that device becomes inaccessible. To verify the correct device 

name, use the fget config command. 

5.   Re-create a new array. At the host prompt, type the following command, and 

then press Enter: 

 

 recreatevg -y logical drivegroupname -L /directoryname os_device_name
  

where: 

v   logical drivegroupname is the name that you want to assign to the FlashCopy 

array. 

v   directoryname is the name of the directory where you want to mount the 

FlashCopy logical drive. 

v   os_device_name is the operating system device name of the FlashCopy 

logical drive. If your AIX array contains more than one FlashCopy logical 

drive, add an os_device_name for each logical drive.

The array is re-created and contains the FlashCopy logical drive or drives. 

6.   Mount the file system to its intended host. At the host prompt, type the following 

command, and then press Enter: 

 

 mount mount-point 

  

where mount-point is the name of the file system that is being mounted. Include 

the directoryname that was used in step 5. 

7.   Ensure that the logical drives are back online. At the host prompt, type the 

following command, and then press Enter: 

 df -k 

  

A list of the mounted disks displays. 

8.   Use the FlashCopy logical drive with your backup application or other 

application. 

9.   Disable the FlashCopy logical drive after it is no longer needed. 

If you disable the FlashCopy logical drive instead of deleting it, you can retain 

the FlashCopy logical drive and its associated FlashCopy repository logical 

drive. Then when you need to create a different FlashCopy of the same base 

logical drive, you can re-create the disabled FlashCopy logical drive. This takes 

less time than creating a new FlashCopy logical drive and stops any 

performance reduction that might occur if the FlashCopy logical drive remains 

available.
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Instructions for HP-UX 

Before you begin, stop all I/O activity to the base logical drive, or suspend data 

transfer. This ensures that you capture an accurate point-in-time image of the base 

logical drive. 

To create a new point-in-time image of the same base logical drive, perform the 

following steps: 

 1.   Start the storage management software. The Enterprise Management window 

opens. 

 2.   Launch a Subsystem Management window using one of the following methods: 

v   Select the storage subsystem in either the Device Tree view or from the 

Device Table. Then, click Manage Device on the toolbar or click Tools→ 

Manage Device. 

v   Right-click the storage subsystem in the Device Tree view or from the 

Device Table, and click Manage Device. 

v   Double-click a storage subsystem node in the Device Table. 

v   Select the storage subsystem in the Device Tree view or from the Device 

Table, and then press Enter.

The Subsystem Management window opens in a separate window. 

 3.   Unmount the base logical drive. 

 4.   In the storage management software, re-create the FlashCopy logical drive. 

Click Logical Drive → FlashCopy → Re-create in the Subsystem Management 

window. 

 5.   Remount the base logical drive to its original host.

Note:  If you stopped I/O activity to the base logical drive or suspended a data 

transfer, resume I/O activity to the base logical drive or re-enable data 

transfer at this time. 

 6.   Perform the following steps to import the FlashCopy logical drives into the 

Logical Volume Manager: 

a.   Create a new directory for the new array, as shown in the following 

example. 

 mkdir /dev/vg02 

  

b.   Create a group node for the new array, as shown in the following example. 

 mknod /dev/vg02/group c 64 -0x020000
  

c.   Import the FlashCopy logical drive LUNs. At the host prompt, type the 

following command, and then press Enter. 

 vgimport /dev/vg02 FlashCopy-block-node-1 FlashCopy-block-node-2 ...
  

An alternate command can be used, as shown in the following example. 

 vgimport /dev/vg02 /dev/dsk/c66t0d1 /dev/dsk/c69t0d1
  

Note:  You must verify that the /dev/dsk device files exist on the FlashCopy 

logical drive. Use the SMdevices utility or the HP-UX ioscan utility to 

perform this verification.
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A warning displays indicating that a backup of the array that is being 

imported might not exist on the host. This message is only a warning and 

can be ignored. The import operation continues and completes 

successfully. 

The backup for this array is created when it is exported later. 

d.   Activate the new array, as shown in the following example. 

 vgchange -a y /dev/vg02
  

 7.   If a file system existed on the base logical drive, then it also exists on the 

FlashCopy logical drive. However, before you mount the FlashCopy logical 

drive, perform a file system check to ensure that the file system is consistent. 

For example: 

 

 fsck /dev/vg02/lvol01
  

 8.   Mount the FlashCopy logical drive to its intended host. 

 9.   Use the FlashCopy logical drive with your backup application or other 

application. 

10.   Unmount the FlashCopy logical drive. 

11.   Disable the FlashCopy logical drive after it is no longer needed. 

If you disable the FlashCopy logical drive instead of deleting it, you can retain 

the FlashCopy logical drive and its associated FlashCopy repository logical 

drive. Then when you need to create a different FlashCopy of the same base 

logical drive, you can re-create the disabled FlashCopy logical drive. This takes 

less time than creating a new FlashCopy logical drive and stops any 

performance reduction that might occur if the FlashCopy logical drive remains 

available.

Instructions for Solaris 

To create a new point-in-time image of the same base logical drive, perform the 

following steps: 

1.   Unmount the base logical drive. 

2.   In the storage management software, re-create the FlashCopy logical drive. 

Click Logical Drive → FlashCopy → Re-create in the Subsystem Management 

window. 

3.   Remount the base logical drive to its original host. 

4.   Mount the FlashCopy logical drive to its intended host.

Note:  If you stopped I/O activity to the base logical drive or suspended data 

transfer, resume I/O activity to the base logical drive or re-enable data 

transfer at this time. 

5.   Use the FlashCopy logical drive with your backup application or with another 

application. 

6.   Unmount the FlashCopy logical drive. 

7.   After the FlashCopy logical drive is no longer needed, disable the FlashCopy 

logical drive. 

If you disable the FlashCopy logical drive instead of deleting it, you can retain 

the FlashCopy logical drive and its associated FlashCopy repository logical 

drive. Then when you need to create a different FlashCopy of the same base 

logical drive, you can re-create the disabled FlashCopy logical drive. This takes 
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less time than creating a new FlashCopy logical drive and stops any 

performance reduction that might occur if the FlashCopy logical drive remains 

available.

Instructions for Windows 

To create a new point-in-time image of the same base logical drive, perform the 

following steps: 

1.   Stop the host application or suspend data transfer. 

2.   Run SMrepassist -f on the host where the FlashCopy logical drive resides. 

3.   Disable the FlashCopy logical drive. 

If you disable the FlashCopy logical drive instead of deleting it, you can retain 

the FlashCopy logical drive and its associated FlashCopy repository logical 

drive. Then, when you need to create a different FlashCopy of the same base 

logical drive, you can re-create the disabled FlashCopy logical drive. This takes 

less time than creating a new FlashCopy logical drive and avoids any reduction 

in performance that might occur if the FlashCopy logical drive remains available. 

To disable or delete a FlashCopy logical drive, right-click the icon for that 

FlashCopy logical drive in the Subsystem Management window, and select 

either Disable or Delete. 

4.   Run SMrepassist -f on the host where the base logical drive resides. 

5.   Re-create the FlashCopy logical drive. For instructions about how to re-create a 

FlashCopy logical drive, see “Re-creating a FlashCopy logical drive” on page 

50. 

6.   Restart the host application or re-enable data transfer. The FlashCopy logical 

drive is ready to use. 

7.   Disable the FlashCopy logical drive until it is required again.

Instructions for Novell NetWare 

Perform the following steps to create a new point-in-time image of the same base 

logical drive: 

1.   Stop the host application or suspend data transfer. 

2.   Unmount the base logical drive. 

3.   Re-create the FlashCopy logical drive. For instructions about how to re-create a 

FlashCopy logical drive, see “Re-creating a FlashCopy logical drive” on page 

50. 

4.   Remount the base logical drive. 

5.   Restart the host application. 

6.   Remount the FlashCopy logical drive. The FlashCopy logical drive is ready to 

use (for backup, speculative test, or upgrades). 

7.   Unmount the FlashCopy logical drive. 

8.   Disable the FlashCopy logical drive until it is required again. 

If you disable the FlashCopy logical drive instead of deleting it, you can retain 

the FlashCopy logical drive and its associated FlashCopy repository logical 

drive. Then, when you need to create a different FlashCopy of the same base 

logical drive, you can re-create the disabled FlashCopy logical drive. This takes 

less time than creating a new FlashCopy logical drive and avoids any reduction 

in performance that might occur if the FlashCopy logical drive remains available. 

To disable or delete a FlashCopy logical drive, in the Subsystem Management 

window, right-click the FlashCopy logical drive icon and select either Disable or 

Delete.
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Performing FlashCopy tasks 

This section describes the following FlashCopy tasks: 

v   Viewing the FlashCopy logical drive status 

v   Disabling a FlashCopy logical drive 

v   Re-creating a FlashCopy logical drive 

v   Resizing a FlashCopy repository logical drive 

v   Deleting a FlashCopy logical drive 

v   Viewing and recovering missing logical drives

Viewing  the FlashCopy logical drive status 

You can determine the status of the FlashCopy logical drive by viewing the icons. 

The icons change depending of the state of the drive. The logical drive component 

property display is also useful in determining the state of the logical drives. 

Use the FlashCopy Repository Logical Drive - Properties window to view the 

FlashCopy repository logical drive base and capacity properties. You can also use 

this window to specify the capacity percentage full and the action to be taken if the 

FlashCopy repository logical drive becomes full. 

The progress of the modification operations displays at the bottom of the window. 

FlashCopy icon states 

To view the FlashCopy icon, open the Storage Management Device Manager GUI 

Physical/Logical view. The icon states are shown in Figure 13.
   

What to do if the FlashCopy repository logical drive becomes full 

If the FlashCopy repository logical drive becomes full, you should first, view the 

current FlashCopy logical drive properties, then you can change the failure settings. 

SJ000847
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Figure 13. FlashCopy icon states
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Viewing the current FlashCopy logical drive properties:   Complete the following 

steps to view the current FlashCopy logical drive properties. 

1.   Select a FlashCopy repository logical drive in the Logical view of the Subsystem 

Management window. 

2.   Click Logical Drive → Properties. The FlashCopy Repository Logical Drive - 

Properties window opens. See Figure 14.
 

3.   Click the Capacity tab to view the currently defined settings, as shown in 

Figure 15 on page 47.
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Figure 14. FlashCopy repository logical drive properties
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Changing FlashCopy repository logical drive properties:   If the repository full 

policy is set to Fail FlashCopy logical drive (default setting), the data is not 

recoverable when the drive becomes full and FlashCopy cannot be accessed. If this 

situation occurs, you can perform one of the following actions: 

v   Delete the FlashCopy logical drive 

v   Re-create the FlashCopy logical drive to create a new point-in-time image

If the repository full policy is set to "Fail writes to base logical drive," the data is 

accessible. However, all write requests to the base logical drive are rejected until 

the FlashCopy repository logical drive capacity is increased. This is not a 

recommended setting. 

Attention: AIX does not support the "Fail writes to base logical drive" option of the 

repository full policy. Selecting this option might cause data loss on the base logical 

drive. If you are using AIX ensure that the default option, "Fail FlashCopy logical 

drive," is selected. Be sure to monitor the capacity of the FlashCopy repository 

logical drive, because the you cannot access the FlashCopy if the repository logical 

drive becomes full. 
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Figure 15. Repository capacity settings
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For information about increasing the capacity of a FlashCopy repository logical 

drive, see “Resizing a FlashCopy repository logical drive” on page 51. 

Notes:  

1.   Deleting a FlashCopy logical drive automatically deletes the associated 

FlashCopy repository logical drive. 

2.   Deleting a FlashCopy repository logical drive automatically deletes the 

associated FlashCopy logical drive. 

3.   Deleting a FlashCopy logical drive, and then creating it again, forces you to stop 

the host application and unmount the base logical drive while the FlashCopy is 

being created again. 

4.   If you re-create a FlashCopy logical drive, you do not need to create a 

FlashCopy repository logical drive, or remap the assigned logical drive-to-LUN 

mappings between the FlashCopy logical drive and the host. 

5.   After you re-create the FlashCopy logical drive, you can change parameters on 

the FlashCopy repository logical drive through the appropriate menu options. 

6.   To avoid another FlashCopy repository logical drive full failure, increase the 

capacity of the FlashCopy repository logical drive. For more information, see 

“Resizing a FlashCopy repository logical drive” on page 51.

Viewing the progress of a modification operation 

The progress bar at the bottom of the FlashCopy Repository Logical Drive 

Properties window displays the progress of an operation. You can view the progress 

of the following operations: 

v   Copyback 

v   Reconstruction 

v   Initialization 

v   RAID level change 

v   Dynamic logical drive expansion 

v   Capacity increase 

v   Defragmentation 

v   Segment size change

Note:  The storage management software cannot obtain progress information 

from the storage subsystem controllers if the network management 

connection to the controllers is down or if the storage subsystem is 

partially managed. For more information about a partially managed 

storage subsystem or an unresponsive controller or storage subsystem 

condition, see the Enterprise Management window online help.

Disabling a FlashCopy logical drive 

If you no longer need a FlashCopy logical drive, you might want to disable it. As 

long as a FlashCopy logical drive is enabled, your storage subsystem performance 

can be impacted by copy-on-write activity that is directed to the associated 

FlashCopy repository logical drive. The copy-on-write activity ends when you 

disable a FlashCopy logical drive. 

If you disable a FlashCopy logical drive instead of deleting it, you can retain it and 

its associated repository for future use. When you need to create a different 

FlashCopy of the same base logical drive, you can use the Re-create option to 

re-enable the previously disabled FlashCopy. This takes less time than creating a 

new FlashCopy. 
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When you disable a FlashCopy logical drive, note the following points: 

v   You cannot use that FlashCopy logical drive again until you use the Re-create 

option on that logical drive. 

v   Only that FlashCopy logical drive is disabled. All other FlashCopy logical drives 

remain functional.

If you do not intend to re-create a FlashCopy, you can delete that FlashCopy logical 

drive instead of disabling it. 

Perform the following steps to disable a FlashCopy logical drive: 

1.   Select the FlashCopy logical drive. Right-click and select Disable, as shown in 

Figure 16.
 

2.   The Disable FlashCopy Logical Drive confirmation window opens, as shown in 

Figure 17 on page 50. In this window, type Yes and click OK to begin the 

disable operation. 
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Figure 16. Choosing to disable the FlashCopy drive
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The FlashCopy icon in the Physical/Logical view now displays as disabled.

Re-creating a FlashCopy logical drive 

Re-creating a FlashCopy logical drive takes less time than creating a new one. If 

you have a FlashCopy logical drive that you no longer need, instead of deleting it, 

you can reuse it (and its associated FlashCopy repository logical drive) to create a 

different FlashCopy logical drive of the same base logical drive. 

When you re-create a FlashCopy logical drive, note the following points: 

v   The FlashCopy logical drive must be in either an optimal or a disabled state. 

If the FlashCopy logical drive is in an optimal state, the process first disables, 

and then re-creates the FlashCopy logical drive. This process invalidates the 

current FlashCopy. 

v   All copy-on-write data on the FlashCopy repository logical drive is deleted. 

v   When you use the Re-create option, the previously configured FlashCopy name, 

parameters, and FlashCopy repository logical drive are used. 

FlashCopy and FlashCopy repository logical drive parameters remain the same 

as the previously disabled FlashCopy logical drive and its associated FlashCopy 

repository logical drive. After you re-create a FlashCopy logical drive, you can 

change parameters on its associated FlashCopy repository logical drive through 

the appropriate menu options. 

v   The system retains the original names for the FlashCopy and FlashCopy 

repository logical drives. You can change these names, however, after the 

Re-create option completes.

Before you re-create a FlashCopy logical drive, go to “Preparing the host operating 

system” on page 27 and perform the procedure to prepare your host operating 

system. Then, perform the following steps to re-create a FlashCopy drive: 

1.   Select the FlashCopy logical drive. Right-click and select Re-Create, as shown 

in Figure 18 on page 51.
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Figure 17. Disable FlashCopy confirmation window
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2.   The Re-create FlashCopy Logical Drive window opens. Type Yes and click OK.

This disables and re-creates the FlashCopy logical drive (if it had not been 

previously disabled) and displays it in the Logical view in an Optimal state. The 

creation timestamp shown on the FlashCopy Logical Drive Properties window is 

updated to reflect the new point-in-time image. Copy-on-write activity resumes to 

the associated FlashCopy repository logical drive. 

Resizing a FlashCopy repository logical drive 

Use this option to increase the storage capacity of an existing FlashCopy repository 

logical drive. Typically, this option is used when you receive a warning that the 

FlashCopy repository logical drive is in danger of becoming full. 

You can achieve an increase in storage capacity by using one of the following 

methods: 

v   Use the free capacity that is available on the array of the FlashCopy repository 

logical drive. 
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Figure 18. Recreating a FlashCopy logical drive
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v   Add unconfigured capacity (in the form of unused drives) to the array of the 

FlashCopy repository logical drive. Use this method when no free capacity exists 

on the array. 

Note:  A maximum of two drives can be added at one time to increase 

FlashCopy repository logical drive capacity.

The storage capacity of a FlashCopy repository logical drive cannot be increased if 

any of the following conditions exists: 

v   One or more hot spare drives are in use in the logical drive. 

v   The logical drive has a non-optimal status. 

v   Any logical drive in the array is in any state of modification. 

v   The controller that owns this logical drive is in the process of adding capacity to 

another logical drive. Each controller can add capacity to only one logical drive at 

a time. 

v   No free capacity exists in the array. 

v   No unconfigured capacity (in the form of drives) is available to add to the array.

Perform the following steps to resize a FlashCopy repository drive: 

1.   Select a FlashCopy repository logical drive in the Logical view of the Subsystem 

Management window. 

2.   Click Logical Drive → Increase Capacity. 

Note:  If no free capacity or unconfigured capacity is available, the Increase 

Capacity option is not available. 

An Additional Instructions window opens. Read the information, and click OK if 

you still want to increase capacity. The Increase Repository Capacity window 

opens. 

You can see the FlashCopy repository logical drive name, the associated 

FlashCopy logical drive name, the associated base logical drive name, the 

current capacity, and the amount of free capacity that is available for the 

selected repository. 

If free capacity is available, the maximum free space is shown in the Increase 

Capacity by field. If there is no free capacity on the array, the value that is 

shown in the Increase Capacity by field is 0. Add drives to create free capacity 

on the array of the standard logical drive. 

3.    Use one of the following two methods to increase capacity: 

v   Using the free capacity on the array of the FlashCopy repository logical drive: 

a.   Accept the final capacity increase or use the Increase Capacity by field 

to adjust the capacity. Click OK. 

b.   A confirmation window displays. Type Yes and click OK to continue. 

The Logical view is updated. The FlashCopy repository logical drive with 

its capacity increased shows a status of Operation in Progress, together 

with its original capacity and the total capacity being added. 

c.   The Free Capacity node involved shows a reduction in capacity. If all of 

the free capacity is used to increase the logical drive size, then the Free 

Capacity node involved is removed from the Logical view.

v    Adding unconfigured capacity (drives) to the array of the FlashCopy 

repository logical drive: 

a.   If there are no unassigned drives available and empty slots in the storage 

expansion enclosures are available, insert new drives. 
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If there are no unassigned drives available, and there are no empty slots 

available in the storage expansion enclosures, install another storage 

expansion enclosure and additional drives. 

b.   Click Add Drives. 

The Increase Repository Capacity - Add Free Capacity window opens. 

Details about enclosure, slot, and usable capacity for the available free 

drives are displayed. 

Note:  The drives that are displayed have a capacity that is either 

equivalent to or larger than those that are already employed by the 

array. 

c.   Select a single drive, or two drives, to be added: 

–   Press Ctrl+Enter to select the nonadjacent drives. 

–   Press Shift+Enter to select the adjacent drives.

d.   Click Add. 

The Add Free Capacity window closes. Check the Drives to add 

[enclosure, slot] field to ensure that the correct drives are added. 

e.   Accept the final capacity or use the Increase Capacity by field to adjust 

the capacity. 

f.   Click OK. 

g.   A confirmation window opens. Type Yes to confirm the operation, and click 

OK to continue. 

The Logical view is updated. The FlashCopy repository logical drive that is 

having its capacity increased shows a status of Operation in Progress. It 

also shows its original capacity and the total capacity that is being added. 

The Free Capacity node involved in the increase shows a reduction in 

capacity. 

If all of the free capacity is used to increase the size of the logical drives, 

then the Free Capacity node that is involved is removed from the Logical 

view. 

If a Free Capacity node did not exist before you added capacity and not all of 

the capacity that is added will be used to increase the capacity of the 

FlashCopy repository logical drive, a new Free Capacity node is created and 

displayed in the Logical view. 

Unassigned drives (unconfigured capacity) that are added to increase the 

FlashCopy repository logical drives capacity change in the Physical view to 

assigned drives. They become associated to the array of the FlashCopy 

repository logical drive.

4.   View the progress of the capacity increase process. Select the FlashCopy 

repository logical drive. Click Logical Drive → Properties. 

The FlashCopy Repository Logical Drive - Properties window opens. A progress 

bar at the bottom of the window indicates the status of the capacity increase.

Deleting a FlashCopy drive 

Use this option to delete a FlashCopy logical drive that is no longer needed for 

backup or application testing purposes. This option results in an increase of free 

capacity in the array or additional unconfigured capacity. 

Notes:  

1.   When you delete a logical drive, all data on the logical drive is lost. Back up the 

data and stop all I/O before you perform this operation, if necessary. 
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2.   If a file system is mounted on the logical drive, unmount it before you perform 

this operation. 

3.   When you delete a base logical drive, the associated FlashCopy logical drive 

and FlashCopy repository logical drive are automatically deleted.

Perform the following steps to delete a FlashCopy drive: 

1.   Select the FlashCopy logical drive in the Logical view. 

2.   Click Logical Drive → Delete, as shown in Figure 19. 

 

3.   The Delete FlashCopy Logical Drive window opens, as shown in Figure 20 on 

page 55. Type Yes and click OK.
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Figure 19. Deleting the FlashCopy logical drive
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The FlashCopy logical drive and the FlashCopy repository logical drive are 

deleted, destroying any data that they contained.
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Figure 20. Delete FlashCopy Logical Drive window

 

Chapter 2. Overview of FlashCopy 55



56 IBM System Storage DS4000 Storage Manager Copy Services User’s Guide



Chapter  3.  Overview  of  VolumeCopy  

VolumeCopy is a premium feature that comes with the DS4000 Storage Manager 

software and is enabled by purchasing a premium feature key. VolumeCopy is used 

in conjunction with FlashCopy and, therefore, it can be purchased together with 

FlashCopy as a single copy service option, or at a later time as an enhancement to 

FlashCopy. 

The VolumeCopy feature is a firmware-based mechanism that you use to copy data 

from one logical drive (the source logical drive) to another logical drive (the target 

logical drive) in a single storage subsystem. The source logical drive and the target 

logical drive in a VolumeCopy operation that are located on the same storage 

subsystem can also be referred to as a VolumeCopy pair. 

Important: If the logical drive that you want to copy is used in a production 

environment, the FlashCopy feature must be enabled. A FlashCopy of the logical 

drive must be created, and then specified as the VolumeCopy source logical drive, 

instead of using the actual logical drive itself. This requirement allows the original 

logical drive to continue to be accessible during the VolumeCopy operation. 

With VolumeCopy, you can also copy data from arrays that use smaller capacity 

drives to arrays that use larger capacity drives, back up data, or restore FlashCopy 

logical drive data to the base logical drive. The VolumeCopy feature includes a 

Create Copy wizard that you use to create a VolumeCopy operation, and a Copy 

Manager that you use to monitor logical drive copies after they have been created. 

The VolumeCopy feature is useful for the following tasks: 

Copying data for greater access 

As your storage requirements for a logical drive change, you can use 

VolumeCopy to copy data to a logical drive in an array that uses larger 

capacity disk drives within the same storage subsystem. You can move 

data to larger drives (for example, 73 GB to 146 GB), change to drives with 

a higher data transfer rate (for example, 1 Gbps to 2 Gbps), or change to 

drives that use new technologies for higher performance. 

Backing up data 

With VolumeCopy you can create a backup of a logical drive by copying 

data from one logical drive to another logical drive in the same storage 

subsystem. You can use the target logical drive as a backup for the source 

logical drive, for system testing, or to back up to another device, such as a 

tape drive. 

Restoring FlashCopy logical drive data to the FlashCopy base logical drive 

If you need to restore data to the FlashCopy base logical drive from its 

associated FlashCopy logical drive, you can use the VolumeCopy feature to 

copy the data from the FlashCopy logical drive to another logical drive (the 

VolumeCopy target logical drive) first. Then, copy the data on the 

VolumeCopy target logical drive back to the FlashCopy base logical drive. 

 For more information about FlashCopy, see Chapter 2, “Overview of 

FlashCopy,” on page 13.

Using VolumeCopy  with FlashCopy 

VolumeCopy is used with FlashCopy. It can be purchased together with FlashCopy 

as a single copy service option, or at a later time as an enhancement to FlashCopy. 
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Before you create a VolumeCopy, you first create a FlashCopy of the logical drive 

that you want to copy. During the VolumeCopy operation, use the FlashCopy as the 

source logical drive of the VolumeCopy pair. 

Note:  A VolumeCopy operation will fail all FlashCopy logical drives that are 

associated with the target logical drive, if any exist. You must disable all 

FlashCopy logical drives that are associated with the base logical drive 

before you can select the base logical drive as a target logical drive. 

Otherwise, you cannot use the base logical drive as a target logical drive. 

Enabling the VolumeCopy  feature 

To enable VolumeCopy, you must perform the following two procedures in the 

following order: 

1.   Obtain the feature enable identifier. This procedure is described in detail in 

“Obtaining the feature enable identifier” on page 10. 

2.   Generate the feature key file and enabling VolumeCopy. This procedure is 

described in detail in “Generating the feature key file” on page 10.

Before you begin, gather the following information: 

v   Your Feature Activation Code, which is printed on the IBM FlashCopy Premium 

entitlement card 

v   Your controller unit IBM serial number, which is printed on the label on the back 

of your DS4000 controller unit 

v   A 32 alphanumeric IBM DS4000 Storage Subsystem premium feature identifier 

string

To obtain the storage subsystem premium feature identifier string, ensure that your 

controller unit and storage expansion enclosures are connected, powered on, and 

managed using the SMclient. 

For more details about how to enable the VolumeCopy feature, see “Enabling the 

premium feature” on page 10. For information about how to view a list of those 

premium features that are enabled on your storage subsystem, see “Verifying that 

the premium feature is enabled” on page 11. 

If the VolumeCopy feature is disabled, but VolumeCopy pairs exist, all of the options 

in the Copy Manager (stop copy, remove copy pairs, start copy, enable and disable 

read-only) will still be available. However, you will not be permitted to create any 

new VolumeCopies. 

Create Copy wizard 

The Create Copy wizard guides you through the VolumeCopy process. The Create 

Copy wizard helps you to select a source logical drive from a list of available logical 

drives, select a target logical drive from a list of available logical drives, and set the 

copy priority for the VolumeCopy operation. When you have completed the wizard 

panels, the VolumeCopy operation starts and data is read from the source logical 

drive and written to the target logical drive. 

Creating a VolumeCopy  

The process of creating a VolumeCopy (copying data from the source volume to the 

target volume) is managed by the controllers and is transparent to host machines 
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and applications. This section describes how you use the storage management 

software to copy data with VolumeCopy, and the actions taken by the controllers 

during the creation of a VolumeCopy. 

The Create Copy wizard guides you through the steps to create a new 

VolumeCopy. 

Before you begin, create a FlashCopy of the logical drive that you want to copy. 

During the VolumeCopy operation, use the FlashCopy logical drive as the source 

logical drive of the VolumeCopy pair. 

See “Creating a FlashCopy logical drive” on page 27 for information about how to 

create a FlashCopy.

Note:  Before you use the Create FlashCopy Logical Drive wizard to create a 

FlashCopy logical drive, you must read the information in “Preparing the host 

operating system” on page 27. 

To create a VolumeCopy using the Create Copy wizard, perform the following steps: 

1.   Stop all I/O activity to the target logical drive. 

For more information about what types of logical drives are acceptable for 

source and target logical drives, see “Selecting the source logical drive” on page 

60 and “Selecting the target logical drive” on page 61. 

2.   Unmount any file systems on the target logical drive. 

3.   Select the source logical drive (the FlashCopy that you just created) in the 

Logical view of the Subsystem Management window. 

4.   Click Logical Drive → VolumeCopy → Create. 

The Create Copy Wizard - Introduction panel displays. Select the source logical 

drive from the list of valid source logical drives on the storage subsystem. 

Note:  If the FlashCopy logical drive that you selected to start the wizard is a 

valid source logical drive, it is highlighted in the table.
Click Next. The Select Target Volume and Copy Priority panel opens. 

5.   Select the target logical drive for the VolumeCopy operation and set the copy 

priority. 

The copy priority determines how much of the resources of the controller are 

used to complete the VolumeCopy operation versus to fulfill I/O activity. For 

more information about selecting a target logical drive, see “Selecting the target 

logical drive” on page 61. For more information about the copy priority, see 

“Setting the copy priority” on page 64. 

Click Next. The Preview panel opens. 

6.   Review the source logical drive, the target logical drive and copy priority that 

you specified in the previous steps. If all the information is correct, type yes and 

click Finish to start the VolumeCopy operation. 

Note:  For more information about the Preview panel, see “The Preview panel 

of the Create Copy wizard” on page 65.

When you have completed the wizard tasks, the VolumeCopy operation starts and 

the preferred controller of the source logical drive reads data from the source logical 

drive and writes it to the target logical drive. Operation in Progress icons display 

on the source logical drive and target logical drive while the VolumeCopy operation 

completes. 
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While a VolumeCopy operation has a status of In Progress, Pending, or Failed: 

v   The source logical drive is available for read I/O activity only. 

v   The target logical drive is not available for read or write I/O activity.

After the VolumeCopy operation completes: 

v   The source logical drive is available for both read and write I/O activity. 

v   The target logical drive is available for read I/O activity, unless the Read-Only 

attribute has been disabled. For more information about setting the Read-Only 

attribute on the target logical drive, see “Setting the target logical drive read-only 

attribute option” on page 77.

Important: A maximum of eight VolumeCopy copies can be In Progress at one 

time. If you create more than eight VolumeCopy copies, they will have a status of 

Pending until one of the VolumeCopies with a status of In Progress completes. 

While a VolumeCopy operation is In Progress, the same controller must own both 

the source logical drive and target logical drive. If the same controller does not own 

both the source logical drive and target logical drive before you begin the 

VolumeCopy operation, ownership of the target logical drive is automatically 

transferred to the controller owner of the source logical drive. 

When the VolumeCopy operation completes or is stopped, ownership of the target 

logical drive is restored to its preferred controller. If ownership of the source logical 

drive changes during the VolumeCopy operation, ownership of the target logical 

drive also changes. 

Selecting the source logical drive 

The first panel of the Create Copy wizard is the Introduction panel. The Introduction 

panel defines what a VolumeCopy is and allows you to select a source logical drive. 

The table that displays on the Introduction panel contains all the valid source logical 

drives on the storage subsystem, including the logical drive that you selected to 

start the wizard. 

Note:  Before you start the VolumeCopy operation, use the FlashCopy feature to 

create a FlashCopy of the logical drive that you want to copy, and use it as 

the source logical drive of the VolumeCopy pair. 

The source logical drive is a FlashCopy logical drive that accepts host I/O requests 

and stores application data. When the VolumeCopy operation is started, all data 

from the source logical drive is copied to the target logical drive. 

The source logical drive is available for read I/O activity only while a VolumeCopy 

operation has a status of In Progress, Pending, or Failed. Write requests are 

allowed after the VolumeCopy operation is completed. 

All valid source logical drives on the storage subsystem are displayed in the list in 

the Introduction panel. The logical drive that you selected to start the wizard is 

highlighted. 

Note:  In addition to the FlashCopy logical drives that are listed in the Introduction 

panel, standard logical drives and Remote Mirror primary logical drives are 

also displayed. However, do not use standard or Remote Mirror primary 

logical drives as source logical drives for a VolumeCopy.
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The following logical drives are not valid source logical drives and do not display on 

the list: 

v   A Remote Mirror secondary logical drive 

v   A Remote Mirror repository logical drive 

v   A FlashCopy repository logical drive 

v   A failed logical drive 

v   A missing logical drive 

v   A logical drive that is currently in a modification operation 

v   A logical drive that is holding a legacy or persistent reservation 

v   A logical drive that is a source logical drive or target logical drive in another 

VolumeCopy operation with a status of In Progress, Failed, or Pending

From the Introduction panel, you can open the View Drives window to view drive, 

slot, and capacity of the selected source logical drive. You can use this information 

to copy high-access logical drives to different arrays for increased accessibility, or to 

copy logical drives to an array that uses larger capacity drives. 

Note:  After the VolumeCopy operation completes for a VolumeCopy pair, you do 

not need to perform any additional processing or synchronization between 

the source and the target logical drives. If you recopy, it causes the 

VolumeCopy to start copying from the beginning of the source logical drive. 

Therefore, a source logical drive can be in as many VolumeCopy pairs as 

there are eligible target logical drives in the storage subsystem. 

Selecting the target logical drive 

In the Create Copy Wizard: Select Target Logical Drive and Copy Priority panel, you 

can select the target logical drive for the VolumeCopy and set the copy priority as 

shown in Figure 21 on page 62. For more information about setting the copy 

priority, see “Setting the copy priority” on page 64. 
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A target logical drive is a standard logical drive in a VolumeCopy logical drive pair 

that contains a copy of the data from the source logical drive. Read and write 

requests to the target logical drive will not take place while the VolumeCopy 

operation has a status of In Progress, Pending, or Failed. 

Note:  The target logical drive capacity must be equal to or greater than the usable 

capacity of the original source logical drive (not the FlashCopy of the original 

logical drive). 

Important: A VolumeCopy overwrites data on the target logical drive and 

automatically makes the target logical drive read-only to hosts. 

When a VolumeCopy operation is started, the data from the source logical drive is 

written to the target logical drive. However, if the VolumeCopy operation is stopped, 

and then restarted using the Re-Copy option, the data on the source logical drive 

might not be the same as the data on the target logical drive. If hosts have been 

mapped to the source logical drive before the VolumeCopy operation was restarted, 

the data that will be copied to the target logical drive when you recopy might have 

changed since the previous VolumeCopy was created. So the VolumeCopy 

operation always copies the image of the source logical drive at the time the copy 

operation starts, not a second earlier or a second later. 
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Figure 21. Select Target Logical Drive and Copy Priority panel of the Create Copy wizard

 

62 IBM System Storage DS4000 Storage Manager Copy Services User’s Guide



Important: A VolumeCopy operation will overwrite data on the target logical drive 

and automatically make the target logical drive read-only to hosts. After the 

VolumeCopy operation completes, use the Copy Manager to disable the read-only 

attribute for the target logical drive. If you have used the target logical drive in a 

VolumeCopy operation before, make sure that you no longer need that data or have 

backed it up. For more information about the read-only attribute, see “Setting the 

target logical drive read-only attribute option” on page 77. 

All valid target logical drives on the storage subsystem are displayed in the list in 

the Select Target Logical Drive window. 

The following drives can be used as a target logical drive: 

v   A standard logical drive 

v   A Remote Mirror primary logical drive 

v   A base logical drive of a disabled or failed FlashCopy logical drive

Note:   You must disable all FlashCopy logical drives that are associated with the 

base logical drive before you can select it as a target logical drive. 

Otherwise, the base logical drive cannot be used as a target logical drive.

The following logical drives are not valid target logical drives and do not display on 

the list: 

v   A Remote Mirror secondary logical drive 

v   A Remote Mirror repository logical drive 

v   A FlashCopy logical drive 

v   A FlashCopy repository logical drive 

v   A base logical drive of an optimal FlashCopy logical drive 

v   A failed logical drive 

v   A missing logical drive 

v   A logical drive with a status of Degraded 

v   A logical drive that is currently in a modification operation 

v   A logical drive that is holding a legacy or persistent reservation 

v   A logical drive that is a source logical drive or target logical drive in another 

VolumeCopy operation that has a status of In Progress, Failed, or Pending 

v   A logical drive that has already been defined as a target logical drive for another 

VolumeCopy pair

You can also create a target logical drive specifically for the VolumeCopy operation. 

For more information, see “Creating a Storage Subsystem Logical Drive” in the 

Subsystem Management online help. 

Note:  After you have selected or created a target logical drive, give it a unique 

name so that it is easily recognizable in the Logical view. For example, if the 

source logical drive name is Accounting, name the target logical drive 

Accounting-Copy. That way you can quickly identify the source logical drives 

and target logical drives that are available on the storage subsystem. 

From the Select Target Logical Drive and Copy Priority panel, you can open the 

View Drives window to view drive, slot, and capacity of the target logical drive. You 

can use this information to copy high-access logical drives to different arrays for 

increased accessibility, or to copy logical drives to an array that uses larger capacity 

drives. 
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For more information about source logical drives and target logical drives, see 

“Restrictions” on page 73. 

Setting the copy priority 

In the Select Target Logical Drive and Copy Priority panel you can set the copy 

priority for the VolumeCopy operation as shown in Figure 21 on page 62. 

Several factors contribute to system performance including the following factors: 

v   I/O activity 

VolumeCopy diverts controller processing resources from I/O activity. The copy 

priority defines how much of the system resources are used to complete a 

VolumeCopy operation versus fulfill I/O requests. 

v   The logical drive RAID level 

v   The logical drive configuration 

The number of drives in the array or cache parameters 

v   The logical drive type 

FlashCopy logical drives may take more time to copy than standard logical 

drives. 

v   The source logical drive capacity 

All the data in the source logical drive copies to the target logical drive. 

v   The number of other VolumeCopy operations being performed at the same time 

v   The hard drive family type 

v   The number of hard drives that make up the logical drive

You can set the priority of each active VolumeCopy operation in the Create Copy 

wizard with respect to other tasks in the DS4000 Storage Subsystem. You can use 

the Copy Manager to change the copy priority after it is set and you can change the 

priority of the VolumeCopy operation while it is actively copying. 

The following copy priority rates are available: 

v   Lowest 

v   Low 

v   Medium 

v   High 

v   Highest

The Highest priority rate supports the VolumeCopy operation, but I/O activity might 

be affected. The Lowest priority rate supports I/O activity, but the VolumeCopy 

operation will take longer. 

For more information, see “Changing Copy Priority” on the How To tab in the 

Subsystem Management window online help. 
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The Preview panel of the Create Copy wizard 

The Preview panel provides an overview of the selected source logical drive, target 

logical drive, and copy priority for the VolumeCopy operation as shown in Figure 22. 

 

 You can also return to previous panels to edit the parameters you have chosen. 

When you type Yes in the text box and click Finish, the Copy Started window 

opens to verify that the VolumeCopy operation has begun. 

Note:  You can also click Back to change your choices. 

You can create a new VolumeCopy operation or exit the wizard. To close the Copy 

Started window, you must select one of the following options: 

v   Yes - Create a new VolumeCopy 

v   No - Exit the wizard

Icons that show the progress of the operation display on the source logical drive 

and target logical drive while the VolumeCopy operation has a status of In 

Progress or Pending. For more information about copy status, see “Copy status” on 

page 74. 

The progress of the VolumeCopy operation displays in the status bar at the 

bottom-right of the Copy Manager. The status bar shows the estimated time 

remaining for the VolumeCopy operation to complete. You can view the progress of 

a VolumeCopy operation in the Copy Manager only when a VolumeCopy operation 

has a status of In Progress. For more information about the Copy Manager and 

how to access it, see Chapter 4, “Managing VolumeCopy,” on page 73. 
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Figure 22. The Preview panel of the Create Copy wizard
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Viewing  drives 

The View Drives panel displays the drive tray, slot, and capacity information for the 

selected source logical drive or target logical drive. The View Drives panel is 

available in the Create Copy Wizard - Introduction and Create Copy Wizard - Select 

Target Logical Drive panels. 

Content for this panel will automatically update dynamically if you select a different 

source logical drive or target logical drive in the Copy Wizard panel while the View 

Drives panel is open. 

The information presented in the View Drives panel can be used to copy 

high-access logical drives to different logical drive groups for increased accessibility, 

or to copy logical drives to a logical drive group that uses drives with a greater 

capacity. 

Accessing the VolumeCopy  target logical drive on the host 

To access the target logical drive after you have created the VolumeCopy, you must 

complete some steps on the host, as described in the following sections: 

v   “Accessing the VolumeCopy target logical drive on an AIX host” 

v   “Accessing the VolumeCopy target logical drive on an HP-UX or Solaris host” on 

page 68 

v   “Accessing the VolumeCopy target logical drive on a Windows NT host” on page 

68 

v   “Accessing the VolumeCopy target logical drive on a Novell NetWare host” on 

page 69

Accessing the VolumeCopy  target logical drive on an AIX host 

To access the target logical drive after you have created the VolumeCopy, you must 

first change the target permissions, then mount the target logical drive to a 

directory. 

Complete the following steps to change the target permissions to Disable Read 

Only: 

1.   In the Logical view of the SMclient Subsystem Management window, right-click 

the icon for target logical drive and click Copy Manager. The Copy Manager 

Window opens. 

2.   From the top menu, select Change → Target Volume Permissions → Disable 

Read Only.

Complete the following steps to configure the AIX host for the new VolumeCopy 

logical drive: 

1.   Log in to the host as root. 

2.   Ensure that the host operating system recognizes the VolumeCopy logical drive. 

At the host prompt, type the following command, and then press Enter. 

 cfgmgr
  

Several minutes might pass while the operating system accesses the drive. 

When the operation completes, the host prompt displays again.The new logical 

drive is now available from the operating system. 
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3.   At the host prompt, type the following command, and then press Enter. 

 lspv
  

A list of the physical drives that are recognized by the operating system 

displays. 

4.   Look for the operating system device name of your VolumeCopy logical drive in 

the list. The list shows a physical logical drive ID (PVID) for the VolumeCopy 

logical drive. This is the same as the PVID for the associated base logical drive, 

because the VolumeCopy logical drive contains the same array data structures 

as the base logical drive. 

5.   Clear the PVID for the VolumeCopy logical drives. At the host prompt, type the 

following command, and then press Enter. 

 chdev -l os_device_name -a pv=clear
  

where os_device_name is the operating system device name of the 

VolumeCopy logical drive. 

Repeat this step for each VolumeCopy logical drive in the AIX array.

 Attention:  Before specifying clear with the chdev command, verify that you 

are specifying the correct device name. If you specify a different device name, 

all of the data on that device becomes inaccessible. To verify the correct device 

name, use the fget config command. 

6.   Re-create a new array using the recreatevg command. This command reads 

the array data structure inside a logical drive and reconstructs it. It also 

allocates new physical logical drive identifiers (PIDs) to the VolumeCopy logical 

drive and enables access to the VolumeCopy logical drive for the selected host. 

At the host prompt, type the following command, and then press Enter: 

 recreatevg -y logical drivegroupname -L /directoryname os_device_name
  

where: 

v   logical drivegroupname is the name that you want to assign to the 

VolumeCopy array. 

v   directoryname is the name of the directory where you want to mount the 

VolumeCopy logical drive. 

v   os_device_name is the operating system device name of the VolumeCopy 

logical drive. If your AIX array contains more than one VolumeCopy logical 

drive, add an os_device_name for each logical drive.

The array is re-created, and contains the VolumeCopy logical drive or drives. 

7.   Mount the VolumeCopy logical drive to its intended host. At the host prompt, 

type the following command, and then press Enter. 

 mount mount-point
  

where mount-point is the name of the file system that is being mounted. Include 

the directoryname that was used in step 6. 

8.   Ensure that the logical drives are back online. At the host prompt, type the 

following command, and then press Enter. 

 df -k
  

A list of the mounted disks displays.
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Accessing the VolumeCopy  target logical drive on an HP-UX or Solaris 

host 

To access the target logical drive after you have created the VolumeCopy, you must 

first change the target permissions, then mount the target logical drive to a 

directory. 

Complete the following steps to change the target permissions to Disable Read 

Only: 

1.   In the Logical view of the SMclient Subsystem Management window, right-click 

the icon for target logical drive and click Copy Manager. The Copy Manager 

Window opens. 

2.   From the top menu, select Change → Target Volume Permissions →Disable 

Read Only.

Next, complete the following steps on your HP-UX or Solaris host to access the 

VolumeCopy target logical drive: 

1.   Create a directory for the mount point (the target logical drive) in the root 

directory. At the command prompt, type the following command: 

 #mkdir /target_directory 

  

where target_directory is the name of the directory that you want to create. 

Mount the target logical drive to the new directory, using the following 

command: 

 #mount /target_logical_drive/target_directory /target_directory 

  

where target_logical_drive is the target logical drive for the VolumeCopy, and 

target_directory is the name of the directory that you created in step 1.

Accessing the VolumeCopy  target logical drive on a Windows NT host 

To access the target logical drive after you have created the VolumeCopy, you must 

first change the target permissions, and then mount the target logical drive to a 

drive letter or mount point. 

Complete the following steps to change the target permissions to Disable Read 

Only: 

1.   In the Logical view of the SMclient Subsystem Management window, right-click 

the icon for target logical drive and click Copy Manager. The Copy Manager 

Window opens. 

2.   From the top menu, select Change → Target Volume Permissions → Disable 

Read Only.

Complete the following steps to configure your host for the new VolumeCopy target 

logical drive: 

1.   Run the hot_add utility to let the system recognize the newly added 

VolumeCopy target logical drive.

Note:  If the system does not recognize the VolumeCopy target logical drive 

after you run the hot_add utility, restart the server. 

2.   Resolve duplicate logical drive signatures by navigating to the following 

directory: C:\Program Files\IBM_DS4000\util and typing the following command 

in the Windows command line window: 

 

68 IBM System Storage DS4000 Storage Manager Copy Services User’s Guide



SMrepassist -r
  

3.   In the NT4 Disk Administrator window, assign a drive letter to the new 

VolumeCopy target logical drive. 

4.   When you no longer need the VolumeCopy target logical drive, open the NT4 

Disk Management window and remove the drive letter before you delete the 

VolumeCopy target logical drive.

Accessing the VolumeCopy  target logical drive on a Novell NetWare 

host 

You cannot map the VolumeCopy target logical drive to the same Novell NetWare 

servers that the VolumeCopy source logical drive is mapped to. You must use 

another server, or unmap the VolumeCopy source logical drive from the server. 

To access the target logical drive after you have created the VolumeCopy, you must 

first change the target permissions, and then mount the target logical drive to a 

drive letter or mount point. 

Complete the following steps to change the target permissions to Disable Read 

Only: 

1.   In the Logical view of the SMclient Subsystem Management window, right-click 

the icon for target logical drive and click Copy Manager. The Copy Manager 

Window opens. 

2.   From the top menu, select Change → Target Volume Permissions → Disable 

Read Only.

Complete the following steps to configure your host for the new VolumeCopy target 

logical drive: 

1.   Run the hot_add utility to let the system recognize the newly added 

VolumeCopy target logical drive.

Note:  If the system does not recognize the VolumeCopy target logical drive 

after you run the hot_add utility, restart the server. 

2.   Type the logical drive in the command window, or use the Disk Management 

menu in the ConsoleOne window to verify that the drive is added.

SMrepassist utility for Windows NT, Windows 2000, and Windows 

Server 2003 

SMrepassist (replication assistance) is a host-based utility for Windows NT®, 

Windows 2000, and Windows Server 2003. It should be used before you create a 

VolumeCopy on Windows NT, Windows 2000, and Windows Server 2003. 

Running the SMrepassist utility ensures that all the memory-resident data for file 

systems on the target logical drive are flushed. If you are creating a VolumeCopy 

on Windows NT, you also use this utility after you map the VolumeCopy target 

logical drive to the same Windows NT server that the VolumeCopy source logical 

drive is mapped to. This resolves the duplicate disk signatures and system partition 

table information. 
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Important: You cannot map the VolumeCopy target logical drive to the same 

Windows 2000 or Windows Server 2003 servers that the VolumeCopy source 

logical drive is mapped to. You must use another server, or unmap the VolumeCopy 

source logical drive from the server. 

The command to run this utility is: 

SMrepassist -f [filesystem-identifier] | -r [filesystem-identifier]- list 

where: 

v   -f flushes all the memory-resident data for the file system indicated by 

[filesystem-identifier] 

v    [filesystem-identifier] specifies a unique file system in the following syntax: 

drive-letter: [mount-point-path] 

The file system might include only a drive letter, or a drive letter plus a mount 

point 

v    -r (Windows NT operating system only) resolves any duplicate signatures and 

partition table information. You must write a unique boot block signature to each 

logical drive that has a duplicate signature. Ensure that the driver rereads the 

partition table for the logical drive to avoid a restart of the operating system. 

The -r option by itself causes the utility to find and resolve all FlashCopy logical 

drive and VolumeCopies on the storage array having duplicate signatures. The 

utility will only modify the signature on a FlashCopy logical drive or a 

VolumeCopy, not the base logical drive or standard logical drive, even where 

there are more than two logical drives that share a common signature.

An error message is provided in the command line and the logical drives are listed 

as a logical drive set when the utility cannot distinguish between the following 

logical drives: 

v   Base logical drive and FlashCopy logical drive (for example, if the snapshot 

logical drive has been removed) 

v   Standard logical drive and VolumeCopy (for example, if the VolumeCopy has 

been removed)

Locating associated logical drives 

The Go To option can be used to quickly jump to an associated source logical drive 

or target logical drive displayed in the Logical view of the Subsystem Management 

Window. 

Important: The Go To option is available only if the VolumeCopy feature has been 

enabled, or if VolumeCopy copies currently exist on the storage array. It is not 

accessible using the Mappings view of the Subsystem Management Window. 

To locate an associated source logical drive or target logical drive, complete the 

following steps: 

1.   Select a source logical drive or target logical drive in the Logical view of the 

Subsystem Management window. 

2.   Perform one of the following actions, based on the logical drive type that you 

have selected: 

Source logical drive 

Click View → Go To → Source Logical Drive. 
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The selection jumps to the associated source logical drive in the Logical 

view of the Subsystem Management window. 

Target logical drive 

Click View →Go To →Target Logical Drive. 

 The selection jumps to the associated target logical drive in the Logical 

view of the Subsystem Management window.
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Chapter  4.  Managing  VolumeCopy  

After you create a VolumeCopy with the Create Copy wizard, you can monitor the 

VolumeCopy operation through the Copy Manager. You can perform the following 

tasks from the Copy Manager: 

v   Recopy, stop, or remove a VolumeCopy 

v   Modify the attributes of a logical drive, including the copy priority and the target 

logical drive read-only attribute 

v   View the status of a VolumeCopy operation 

v   Determine what logical drives are involved in a VolumeCopy operation 

You can also use the Storage Subsystem Profile to determine what logical drives 

are involved in a VolumeCopy operation.

Copy Manager displays information for all of the logical drive copies on the storage 

subsystem. This information includes the following items: 

v   The source logical drive 

v   The target logical drive 

v   The status of the VolumeCopy operation 

v   A timestamp for any completed copies 

v   The VolumeCopy priority assigned to the VolumeCopy

If a target logical drive is read-only to hosts, a lock icon displays in the Target 

Logical Drive column. 

Perform the following steps to access and use the Copy Manager: 

1.   Click Select Logical Drive → Copy → Copy Manager. 

The Copy Manager window opens. 

2.   Click the VolumeCopy pair or press Enter to select the VolumeCopy pair in the 

table. 

3.   Select an option from the pull-down menu.

Restrictions 

The following restrictions apply to the source logical drive, target logical drive, and 

the storage subsystem: 

v   The source logical drive is available for read I/O activity only while a VolumeCopy 

operation has a status of In Progress or Pending. Write requests are allowed 

after the VolumeCopy operation is completed. 

Before you start the VolumeCopy operation, create a FlashCopy of the logical 

drive that you want to copy, and then use the FlashCopy as the source logical 

drive of the VolumeCopy pair. 

v   A logical drive can be used as a target logical drive in only one VolumeCopy 

operation at a time. 

v   The maximum number of VolumeCopies that are allowed per storage subsystem 

depends on the number of target logical drives that are available on your storage 

subsystem. 

v   A storage subsystem can have up to eight logical drive copies running at any 

given time. 

v   The target logical drive capacity must be equal to or greater than the source 

logical drive capacity. 
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v   The target logical drive capacity must be equal to or greater than the usable 

capacity of the original source logical drive. 

v   A target logical drive can be a standard logical drive, a base logical drive of a 

disabled or failed FlashCopy logical drive, or a Remote Mirror primary logical 

drive.

Note:  You must disable all FlashCopy logical drives that are associated with the 

base logical drive before you can select it as a target logical drive. 

Otherwise, the base logical drive cannot be used as a target logical drive.

Logical drives that have the following statuses cannot be used as a source logical 

drive or target logical drive: 

v   A logical drive that is reserved by the host 

v   A logical drive that is in a modification operation 

v   A logical drive with a status of Failed or Degraded

Note:  A logical drive can be defined as the source logical drive of multiple 

VolumeCopy logical drive pairs even when the status of the VolumeCopy 

logical drive pair is In Progress or Failed. After a logical drive is defined as 

a target logical drive in a VolumeCopy logical drive pair, it is not available to 

participate in any other VolumeCopy logical drive pairs as a target logical 

drive regardless of the VolumeCopy logical drive pair status. After a 

VolumeCopy operation is completed, the logical drive, which is defined as a 

target logical drive in a VolumeCopy logical drive pair, is available to 

participate in any other VolumeCopy logical drive pairs as the source logical 

drive role only. 

Copy status 

The progress of the VolumeCopy operation displays in the status bar at the 

bottom-right of the Copy Manager. The status bar shows the estimated time 

remaining for the VolumeCopy operation to complete. You can view the progress of 

a VolumeCopy operation in the Copy Manager only when a VolumeCopy operation 

has a status of In Progress. 

There are three possible copy statuses: 

Copy Pending 

The Copy Pending status displays in the Copy Manager when a 

VolumeCopy operation has been created, but system resources do not 

allow it to start. For example, if there are already eight logical drive copies 

with a status of In Progress, any subsequent VolumeCopy that you create 

will have a status of Pending until one of the other eight logical drive copies 

has completed. In addition, a modification operation on another logical drive 

in the array might need to complete before the VolumeCopy operation can 

begin. 

 While in the Copy Pending status, the host has read-only access to the 

source logical drive, and read and write requests to the target logical drive 

do not take place until the VolumeCopy operation has completed. 

Copy In Progress 

The Copy In Progress status displays in the Copy Manager while data on 

the source logical drive is being read, and then written to the target logical 

drive. While in the Copy In Progress status, the host has read-only access 
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to the source logical drive, and read and write requests to the target logical 

drive do not take place until the VolumeCopy operation has completed. 

Copy Failed 

The Copy Failed status displays in the Copy Manager when an error occurs 

while the VolumeCopy is being created. A status of Copy Failed can occur 

because of a read error from the source logical drive, a write error to the 

target logical drive, or a failure on the storage subsystem that affects the 

source logical drive or target logical drive (such as a Remote Mirror role 

reversal). A critical event is logged in the Major Event Log (MEL) and a 

Needs-Attention icon displays. 

 While a VolumeCopy operation has the Copy Failed status, the host has 

read-only access to the source logical drive, and read and write requests to 

the target logical drive will not take place until the failure is fixed. 

 When a VolumeCopy operation fails, you must use the Stop Copy option in 

the Copy Manager to stop the operation and use the Recovery Guru to fix 

the problem. 

 You can use the Re-Copy option to restart the VolumeCopy operation from 

the beginning.

Notes:  

1.   If there are eight logical drive copies with a status of In Progress, any 

subsequent VolumeCopy operation will have a status of Pending until one of the 

eight logical drive copies completes. 

2.   If a modification operation is running on a source logical drive or target logical 

drive, and the VolumeCopy operation has a status of In Progress, Pending, or 

Failed, then the VolumeCopy operation will not take place. 

3.   If a modification operation is running on a source logical drive or target logical 

drive after a VolumeCopy has been created, then the modification operation 

must complete before the VolumeCopy operation can start. If a VolumeCopy 

operation has a status of In Progress, then any modification operation will not 

take place.

Viewing  VolumeCopy  properties 

Use the Logical Drive Properties window, shown in Figure 23 on page 76, to view 

the following information about a selected source logical drive or target logical drive: 

v   The role of the logical drive: either source or target 

v   The copy status: Pending, In Progress, Completed, Stopped, Failed 

v   The copy priority: Lowest, Low, Medium, High, Highest 

v   The start timestamp: in the format MM/DD/YY HH/MM/SS 

v   Completion timestamp: in the format MM/DD/YY HH/MM/SS 

v   The read-only attribute: Enabled or Disabled (only if a target logical drive is 

selected) 

v   Source or target logical drive ID: WWN 

v   Source or target logical drive name

Note:  You can only view the progress of a VolumeCopy operation with a status of 

In Progress.
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Perform the following steps to view the VolumeCopy properties: 

1.   Select the source logical drive or target logical drive in the Logical view. 

2.   Click Logical Drive → Properties. 

The Logical Drive Properties window opens. 

3.   Click the Copying tab. 

The Copy Properties tab displays. 

If a source logical drive has multiple target logical drives, then the details will be 

repeated for each target logical drive. 

4.   Click Close to close the window.

Changing copy priorities 

You can change the copy priority to balance I/O activity with VolumeCopy operation 

activity on a storage subsystem. You can set the copy priority to a rate that will 

have the least impact on I/O activity. There are five copy priority rates available: 

lowest, low, medium, high, and highest. If the copy priority is set at the lowest rate, 

I/O activity is prioritized and the VolumeCopy operation will take longer. If the copy 

priority is set to the highest priority rate, the VolumeCopy operation is prioritized, but 

I/O activity for the storage subsystem might be affected. 
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Figure 23. The Logical Drive Properties window
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You can change the copy priority for a VolumeCopy pair before the VolumeCopy 

operation begins, while the VolumeCopy operation has a status of In Progress, or 

after the VolumeCopy operation has completed (for a recopy). Perform the following 

steps to change the copy priority: 

1.   Click Select Logical Drive → Copy → Copy Manager. 

The Copy Manager window opens as shown in Figure 24.
 

2.   Select one or more VolumeCopy pairs in the table. You can select more than 

one VolumeCopy pair by pressing Ctrl and the left mouse button. 

3.   Click Change → Copy Priority. 

The Change Copy Priority window opens. 

4.   In the Copy Priority field, use the slider bar to select the appropriate copy 

priority, depending on your system performance needs. 

For more information about the copy priority, see “Setting the copy priority” on 

page 64. 

5.   Click OK. 

The Change Copy Priority - Progress window opens. 

6.   Click OK. 

The copy priority for the selected VolumeCopy pair is changed.

Setting the target logical drive read-only attribute option 

The target logical drive read-only attribute determines how read and write requests 

to the target logical drive are handled after a VolumeCopy operation is complete or 

if the VolumeCopy operation fails before it completes. After the VolumeCopy 

operation has completed, the target logical drive automatically becomes read-only 

to hosts, and write requests to the target logical drive do not take place. You might 

want to keep this attribute enabled in order to preserve the data on the target 

logical drive. The following situations are examples of when you might want to keep 

the read-only attribute enabled: 

v   If you are using the target logical drive for backup purposes 

v   If you are copying data from one array to a larger array for greater accessibility 

v   If you are using the data on the target logical drive to copy back to the base 

logical drive of a disabled or failed FlashCopy logical drive
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Figure 24. Copy Manager window
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If you decide not to preserve the data on the target logical drive after the 

VolumeCopy operation is completed, use the Copy Manager to disable the 

read-only attribute for the target logical drive. 

Perform the following steps to enable the read-only attribute: 

1.   Click Select Logical Drive → Copy → Copy Manager. 

The Copy Manager window opens. 

2.   Select one or more VolumeCopy pairs in the table. You can select more than 

one copy pair by pressing Ctrl and the left mouse button. 

3.   Click Change → Target Logical Drive Permissions → Enable Read-Only. 

The read-only attribute is enabled on the target logical drive. Write requests to 

the target logical drive are rejected.

Perform the following steps to disable the read-only attribute: 

1.   Click Select Logical Drive → Copy → Copy Manager. 

The Copy Manager window opens. 

2.   Select one or more VolumeCopy pairs in the table. You can select more than 

one VolumeCopy pair by pressing Ctrl and the left mouse button. 

3.   Click Change → Target Logical Drive Permissions → Disable Read-Only. 

The read-only attribute is disabled on the target logical drive. Write requests to 

the target logical drive are permitted.

When the read-only attribute for a target logical drive is enabled, a lock icon 

displays in the Target Logical Drive column of the Copy Manager. The read-only 

attribute can be changed in the Copy Manager only after the VolumeCopy operation 

completes. 

Recopying the source logical drive in a VolumeCopy  pair 

When you recopy the source logical drive in a VolumeCopy Pair, you create a new 

copy of the source logical drive data on an associated target logical drive. You can 

use Re-Copy to create a new copy from the beginning if the original VolumeCopy 

operation fails, was stopped, or has completed. You can also use Re-Copy for 

backup purposes; for instance, if the data on the source logical drive changes, you 

can use Re-Copy to duplicate any new data to the target logical drive. 

 Attention:  Recopying overwrites existing data on the target logical drive and 

makes the target logical drive read-only to hosts until you disable the read-only 

attribute in the Copy Manager. 

Important: Note the following points before you recopy logical drives: 

v   If hosts have been mapped to the source logical drive, the data that is recopied 

to the target logical drive might have changed since the previous VolumeCopy 

was created. 

v   To use Re-Copy, select only one VolumeCopy in the Copy Manager. 

v   See “Selecting the source logical drive” on page 60 and “Selecting the target 

logical drive” on page 61 for information about what types of logical drives you 

can use as source and target logical drives.

Perform the following steps to create a new VolumeCopy of the data on a selected 

VolumeCopy pair: 

1.   Stop all I/O operations to the source logical drive and target logical drive. 
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2.   Unmount any file systems on the source logical drive and target logical drive. 

3.   Click Select Logical Drive → Copy → Copy Manager. 

The Copy Manager window opens. 

4.   Click the VolumeCopy pair or press Enter to select the VolumeCopy pair in the 

table. 

5.   Click Copy → Re-Copy. 

The Re-Copy window opens. 

6.   Set the copy priority. 

See “Setting the copy priority” on page 64 for more information. 

7.   Type Yes and click OK. 

The VolumeCopy operation begins.

Note:  You can view the progress of a VolumeCopy operation in the Copy 

Manager only when a VolumeCopy operation has a status of In 

Progress.

Stopping a VolumeCopy  operation 

You can stop a VolumeCopy operation with a status of Pending, In Progress, or 

Failed. If you decide not to use a particular logical drive as a source logical drive or 

target logical drive, you can stop the VolumeCopy operation before it completes. 

Then after you delete the VolumeCopy pair definition, the logical drives can be used 

in a new VolumeCopy pair. 

Note:  If you stop a VolumeCopy operation with a status of Failed, the 

Needs-Attention condition on a storage subsystem is cleared. 

Important: Note the following points before you stop a VolumeCopy operation: 

v   If the copying process was stopped prematurely, there is no guarantee that the 

target logical drive will be in a usable state. 

v   Select only one copy pair in the Copy Manager. 

v   When the VolumeCopy operation is stopped, all mapped hosts will have write 

access to the source logical drive. If data is written to the source logical drive, 

the data on the target logical drive will no longer match the data on the source 

logical drive.

Perform the following steps to stop a VolumeCopy operation: 

1.   Click Select Logical Drive → Copy → Copy Manager . 

The Copy Manager window opens. 

2.   Click the VolumeCopy pair or press Enter to select the VolumeCopy pair in the 

table. 

3.   Click Copy → Stop. 

The Stop Copy window opens. 

4.   Click Yes. 

The VolumeCopy operation stops.
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Removing copy pairs 

You can remove one or more VolumeCopies from the Copy Manager. Any 

VolumeCopy copy-related information for the source and target logical drive is 

removed from the Logical Drive Properties and Storage Subsystem Profile windows. 

After you remove the VolumeCopy, you can use the source logical drive and target 

logical drive in a new VolumeCopy. When you remove the VolumeCopy, the 

read-only attribute for the target logical drive is also removed. 

After the VolumeCopy is removed from the Copy Manager, you can select the target 

logical drive as a source logical drive or target logical drive for a new VolumeCopy. 

If you remove a VolumeCopy, the source logical drive and target logical drive are no 

longer displayed in the Copy Manager. 

Important: Note the following points before you remove VolumeCopy pairs: 

v   This action does not delete the data on the source logical drive or target logical 

drive. 

v   If the VolumeCopy operation has a status of In Progress, it must be stopped 

before you can remove the VolumeCopy pair from the Copy Manager.

Perform the following steps to remove VolumeCopy pairs from the Copy Manager: 

1.   Click Select Logical Drive → VolumeCopy → Copy Manager. 

The Copy Manager window opens. 

2.   Select one or more VolumeCopy pairs in the table. You can select more than 

one VolumeCopy pair by pressing Ctrl and using the left mouse button to select 

multiple VolumeCopy pairs. 

3.   Click Copy → Remove Copy Pairs. 

The Remove Copy Pairs window opens. 

4.   Click Yes to confirm that you want to continue with the VolumeCopy pair 

removal. 

The VolumeCopy pair is removed.

VolumeCopy  and other premium features 

This section describes how VolumeCopy can be used with other premium features 

that are available with DS4000 Storage Manager. This section covers Storage 

Partitioning, FlashCopy, and the Remote Mirroring Option premium features. 

Although Storage Partitioning is not covered in this guide, it is a premium feature 

that is offered with DS4000 Storage Manager. For more information about Storage 

Partitioning, see your operating system installation and user’s guide or see the 

DS4000 Storage Manager online help. 

Storage Partitioning and VolumeCopy  

Note:  Storage Partitioning is not a copy services premium feature. This guide does 

not describe how to enable and use the storage partitioning feature. For 

more information about Storage Partitioning, see the IBM System Storage 

DS4000 Storage Manager Version 9 Installation and Support Guide for your 

operating system.
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Storage Partitioning is a feature that enables hosts to share access to logical drives 

in a storage subsystem. A storage partition is created when you define a collection 

of hosts (a host group) or a single host, and then define a logical drive-to-LUN 

mapping. 

This mapping allows you to define what host group or host will have access to a 

particular logical drive in the storage subsystem. 

After a VolumeCopy has been created, the target logical drive automatically 

becomes read-only to hosts to ensure that the data is preserved. Hosts that have 

been mapped to a target logical drive do not have write access to the logical drive, 

and any attempt to write to the read-only target logical drive results in a host I/O 

error. 

If you want hosts to have write access to the data on the target logical drive, use 

the Copy Manager to disable the read-only attribute for the target logical drive. For 

more information about changing the target logical drive read-only attribute, see 

“Setting the target logical drive read-only attribute option” on page 77. 

FlashCopy and VolumeCopy  

A FlashCopy logical drive is a point-in-time image of a standard logical drive and is 

typically created so that an application, such as a backup application, can access 

the FlashCopy logical drive and read the data while the base logical drive remains 

online and accessible to hosts. 

Always use a FlashCopy logical drive as the source logical drive for a VolumeCopy. 

Important: If you choose the base logical drive of a FlashCopy logical drive as your 

target logical drive, you must disable all FlashCopy logical drives that are 

associated with the base logical drive before you can select it as a target logical 

drive. 

When you create a FlashCopy logical drive, a FlashCopy repository logical drive is 

automatically created. The FlashCopy repository logical drive stores information 

about the data that has changed since the FlashCopy logical drive was created. 

FlashCopy repository logical drives cannot be selected as source logical drives or 

target logical drives in a VolumeCopy pair. 

FlashCopy can be used with VolumeCopy to back up data on the same storage 

array, and to restore the data on the FlashCopy logical drive back to its original 

base logical drive. 

The Remote Mirror Option and VolumeCopy  

The Remote Mirror Option is used for online, real-time replication of data between 

storage subsystems over a remote distance. In the event of a disaster or a 

catastrophic failure of one storage subsystem, you can promote a second storage 

subsystem to take over responsibility for computing services. 

When you create a remote mirror, a mirrored logical drive pair is created, consisting 

of a primary logical drive at the primary storage subsystem and a secondary logical 

drive at a secondary, remotely located storage subsystem. The mirroring process 

and I/O completion notification to the host is different, depending on whether the 

write mode selected is synchronous or asynchronous. The description below is for 

mirroring with synchronous write mode selected. See “Synchronous write mode 
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(Metro Mirroring)” on page 97 and “Asynchronous write mode (Global Copy and 

Global Mirroring)” on page 98 for more information on the differences between the 

two modes. 

The primary logical drive is the logical drive that accepts host I/O and stores data. 

When the mirror relationship is initially created, data from the primary logical drive is 

copied in its entirety to the secondary logical drive. This process is known as a full 

take synchronization and is directed by the controller owner of the primary logical 

drive. During a full synchronization, the primary logical drive remains fully 

accessible for all normal I/O activity. 

The controller owner of the primary logical drive initiates remote writes to the 

secondary logical drive to keep the data on the two logical drive synchronized. 

Whenever the data on the primary logical drive and the secondary logical drive 

becomes unsynchronized, the controller owner of the primary logical drive initiates a 

full synchronization. 

The secondary logical drive maintains a mirror of the data on its associated primary 

logical drive. The controller owner of the secondary logical drive receives remote 

writes from the primary logical drive controller owner. It will accept host read 

requests, but all host write requests will be blocked by the controller.

Note:  The Host OS file I/O caching may briefly give the impression that one can 

write to the secondary logical drive. However, these attempted writes will be 

rejected when the Host OS tries to flush them from server cache memory to 

the logical drive. 

The secondary logical drive remains unavailable (except for read requests in 

servers that can mount the secondary logical drive as read-only) to host 

applications while mirroring is in progress. In the event of a disaster or catastrophic 

failure at the primary site, you can perform a role reversal to promote the secondary 

logical drive to a primary role. Hosts are then able to access the newly promoted 

logical drive and business operations can continue. 

A primary logical drive in a remote mirror relationship can be selected as the source 

logical drive for a VolumeCopy. However, a secondary logical drive in a remote 

mirror relationship cannot be selected as a source logical drive or target logical 

drive and is not available in the Create Copy wizard when you create a 

VolumeCopy. If a copy of a secondary logical drive is required, you can perform a 

role reversal to change the secondary logical drive to a primary logical drive. For 

more information about remote mirror role reversals, see “Role reversals” on page 

107. 

Note:  Another method you can use to produce a copy of the secondary logical 

drive is to create a FlashCopy of the secondary logical drive, then create a 

VolumeCopy of the FlashCopy logical drive. This method eliminates the need 

to perform a role reversal on the secondary logical drive. This is the 

recommended method. 

If a primary logical drive in a remote mirror is selected as the source logical drive 

for a VolumeCopy, any VolumeCopies that have a status of In Progress or Pending 

when a role reversal takes place fail, and cannot be started again until the primary 

logical drive is demoted back to its original remote mirror secondary logical drive 

role. 
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For more information about the Remote Mirror Option, see Chapter 6, “Overview of 

the Enhanced Remote Mirroring Option,” on page 91 or the Subsystem 

Management window online help. 
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Chapter  5.  Troubleshooting  VolumeCopy  

This chapter provides information about troubleshooting some of the more common 

problems encountered when you use the VolumeCopy feature. The troubleshooting 

topics that are included are general VolumeCopy problems and premium feature 

troubleshooting topics. Locate the section that is directly related to your problem, or 

consult the section that describes general troubleshooting techniques. If your 

problem is not discussed in any of the sections in this chapter, contact technical 

support. 

General troubleshooting 

Table 4 describes some of the typical problems you might encounter when you use 

the VolumeCopy feature. The information in this section is presented in sequence, 

from the time the feature is enabled to problems that you might encounter when 

you use the VolumeCopy feature. 

Information about the probable cause and recommended resolution for each 

problem are provided. If your problem is not addressed in this chapter, contact 

technical support. 

 Table 4. General troubleshooting for the VolumeCopy feature 

Problem Cause Resolution 

The VolumeCopy menu options in the 

Subsystem Management window are 

not available. 

The VolumeCopy feature is not 

enabled. 

Enable the VolumeCopy feature. You 

must use a Feature Key File to enable 

premium features. If one has not been 

supplied, contact your storage 

supplier. 

For step-by-step instructions about 

enabling the VolumeCopy feature, see 

“Enabling the premium feature” on 

page 10 or the Subsystem 

Management Window online help. 

The VolumeCopy icon in the premium 

status area is marked with a red line 

and is not available. 

The VolumeCopy feature is not 

enabled. 

Enable the VolumeCopy feature. You 

must use a Feature Key File to enable 

premium features. If one has not been 

supplied, contact your storage 

supplier. 

For step-by-step instructions about 

enabling the VolumeCopy feature, see 

“Enabling the premium feature” on 

page 10 or the Subsystem 

Management Window online help. 

The Create Copy option is not 

available after selecting a source 

logical drive in the Logical view. 

The logical drive that you have 

chosen to be the source logical drive 

for the VolumeCopy is not a valid 

source logical drive. 

See “Selecting the source logical 

drive” on page 60 for more 

informations on source logical drives. 

Select a valid source logical drive, 

which can be one of the following: 

v   A standard logical drive 

v   A FlashCopy logical drive 

v   A base logical drive of a FlashCopy 

logical drive 

v   A primary logical drive that is 

participating in a Remote Mirror 
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Table 4. General troubleshooting for the VolumeCopy feature (continued) 

Problem Cause Resolution 

The source logical drive or target 

logical drive displays as being a 

missing logical drive. 

A physical drive on which the 

VolumeCopy depends (such as a 

source logical drive or target logical 

drive) has been removed, and the 

logical drive is now displayed under 

the Missing Logical Drive node in the 

Logical view of the Subsystem 

Management window. 

If logical drives are missing because 

of a power loss to the drive trays or 

because drives have accidentally 

been removed, you can recover these 

logical drive by completing the 

following steps: 

1.   Reinsert the drives into the drive 

tray. 

2.   Ensure that the power supplies for 

the drive tray are properly 

connected to an operating power 

source and have an Optimal 

status.

Important: Deleting a missing volume 

is a permanent action. Any associated 

logical drives or logical drive-to-LUN 

mappings will also be deleted. 

For more information about 

troubleshooting missing volumes, refer 

to the Recovery Guru or contact 

technical support. If the missing 

logical drive is no longer required, it 

can be deleted. 

The controller owner for the source 

logical drive or target logical drive 

changes after the VolumeCopy 

operation has completed. 

When the VolumeCopy operation 

started, the preferred controller did not 

have ownership of both the source 

logical drive and target logical drive. 

During a VolumeCopy operation, the 

same controller must own both the 

source logical drive and the target 

logical drive. If both logical drives do 

not have the same preferred controller 

when the VolumeCopy operation 

starts, the ownership of the target 

logical drive automatically transfers to 

the preferred controller of the source 

logical drive. 

When the VolumeCopy operation 

completes or is stopped, ownership of 

the target logical drive is restored to 

its preferred controller. If ownership of 

the source logical drive changes 

during the VolumeCopy operation, 

ownership of the target logical drive 

also changes. 

A VolumeCopy that includes a source 

logical drive that is participating in a 

remote mirror has a status of In 

Progress, Pending, or Completed, but 

has failed. 

In response to a catastrophic failure at 

the primary storage subsystem, a role 

reversal has occurred. The secondary 

logical drive in the mirrored pair was 

promoted to the primary volume role, 

while the primary volume was 

demoted to the secondary volume 

role. 

After the preferred controller of the 

primary logical drive can be contacted, 

a role reversal will automatically take 

place and you can then restart the 

VolumeCopy operation. 

For more information about role 

reversals, see “Role reversals” on 

page 107. 
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Table 4. General troubleshooting for the VolumeCopy feature (continued) 

Problem Cause Resolution 

The error message indicates that the 

VolumeCopy feature is out of 

compliance. 

The VolumeCopy feature is out of 

compliance. 

This normally occurs if a logical drive 

group with existing VolumeCopies has 

been moved into a storage subsystem 

where the feature is not authorized, or 

if you have disabled the feature on a 

storage subsystem where the feature 

is authorized, and you have existing 

VolumeCopies present. 

v   If the VolumeCopy feature is not 

authorized for this storage 

subsystem and you want to 

authorize it, or the VolumeCopy 

feature is authorized for this 

storage subsystem but you have 

disabled it, complete the following 

steps to clear the error: 

1.   Obtain a new Feature Key File 

for this feature, or retrieve the 

existing Feature Enable 

Identifier by clicking Storage 

Subsystem → Premium 

Features → List in the 

Subsystem Management 

window. 

2.   Enable the VolumeCopy 

feature. For step-by-step 

instructions, see “Enabling the 

premium feature” on page 10 or 

the Subsystem Management 

window online help.

v    If the VolumeCopy feature is not 

authorized for this storage 

subsystem and you do not want to 

authorize it, disable the 

VolumeCopy feature by clicking 

Storage Subsystem → Premium 

Features → Disable in the 

Subsystem Management window.

For more information about disabling 

premium features, see to the 

Subsystem Management window 

online help. 
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Table 4. General troubleshooting for the VolumeCopy feature (continued) 

Problem Cause Resolution 

The error message indicates that the 

selected source logical drive has a 

reservation placed on it. 

Logical drives that are configured with 

a legacy or persistent reservation 

cannot be selected as a source logical 

drive or a target logical drive for a 

VolumeCopy. 

Clear the reservation for the selected 

logical drive, and then recreate the 

VolumeCopy. 

1.   Click Advanced → Persistent 

Reservations to open the 

Persistent Reservations window. 

Ensure that the View Associated 

Registrations check box is 

deselected in the upper left corner 

of the Persistent Reservations 

window. 

2.   Click one or more desired logical 

drives. To select all logical drives, 

click Select All. The selected 

logical drives or all logical drives 

are highlighted, depending on your 

selection. 

3.   Click Clear. 

The Clear Registrations/
Reservations window opens. 

4.   Type Yes in the confirmation field. 

The OK button is enabled. 

5.   Click OK, or click Cancel to return 

to the main Persistent 

Reservations window without 

clearing any reservations.

The reservations and registrations that 

are associated with the logical drives 

that you highlighted in the upper pane 

are cleared.
  

VolumeCopy  critical events 

Critical major event Log (MEL) events are generated when an error occurs that can 

affect data availability or that results in a degraded mode of operation. The storage 

management software responds by alerting the appropriate administrators by 

e-mail, SNMP trap, or other configured mechanisms. 

Because administrative action is required to correct the problem, the storage 

subsystem generally enters a Needs Attention status. Therefore, the appropriate 

indications are presented through the storage management software and an 

associated Recovery Guru procedure displays when requested. 

Table 5 on page 89 provides a description of critical MEL events, with a brief 

explanation of what caused the event, and the recommended resolution. If your 

critical MEL event is not included in this section, contact technical support. 
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Table 5. VolumeCopy critical events 

Problem Cause Resolution 

Event 6600 - VolumeCopy Operation 

Failed 

This event is logged when a 

VolumeCopy with a status of In 

Progress or Pending fails. A Needs 

Attention status is also reported for 

the storage subsystem. 

This failure can be caused by a read 

error on the source logical drive, a 

write error on the target logical drive, 

or because of a failure that occurred 

on the storage subsystem that affects 

the source logical drive or target 

logical drive. 

For specific recovery procedures, see 

the Recovery Guru.
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Chapter  6.  Overview  of  the  Enhanced  Remote  Mirroring  

Option  

This chapter introduces the basic concepts of the Enhanced Remote Mirroring 

Option, describes what a remote mirror is, how information is replicated between 

storage subsystems, the software and hardware required, and the preferred system 

configurations.

Note:  Enhanced Remote Mirroring, Remote Mirror, and Remote Mirroring are used 

interchangeably throughout this document, the online client, and online help 

system to refer to remote mirroring functionality. Although these terms are 

used interchangeably, this usage does not mean that their functionality is 

identical. 

Enhanced Remote Mirroring Implementation Requirement 

v   The Bandwidth Estimator Tool is required for architecting an Enhanced Remote 

Mirroring solution. To acquire the Bandwidth Estimator Tool, please contact your 

IBM Marketing representative or IBM Business Partner. 

v   In addition, it is strongly recommended that you have an IBM SAR (Solutions 

Assurance Review) performed on your Enhanced Remote Mirroring solution, 

before implementation. 

v   In certain conditions and environments, Enhanced Remote Mirroring has been 

shown to support link speeds as low as 2 Mbps.

Note:  Link speeds as low as 2 Mbps are not supported in every environment. 

Basic concepts of the Enhanced Remote Mirroring Option 

The Remote Mirror Option is a premium feature that comes with the IBM DS4000 

Storage Manager software and is enabled by purchasing a premium feature key. 

The Remote Mirror Option is used for online, real-time replication of data between 

storage subsystems over a remote distance. In the event of a disaster or 

unrecoverable error at one storage subsystem, the Remote Mirror Option enables 

you to promote a second storage subsystem to take over responsibility for normal 

I/O operations. 

 Attention:  The FAStT500 supports only Remote Mirroring; it does not support 

Enhanced Remote Mirroring. The information provided in this section that is 

applicable to FAStT500 should be used only when configuring FAStT500 with 

Remote Mirroring. 

Remote Mirroring supports only 10 km maximum distance synchronous (metro 

mirroring) Remote Mirroring pairs. Remote Mirroring is supported with controller 

firmware versions 05.20.xx.xx (FAStT500 and DS4400 only), 05.30.xx.xx and 

05.40.xx.xx (DS4400 and DS4500), and 05.41.xx.xx (DS4500). The supported 

DS4000 storage subsystems are DS4400, DS4500 and the withdrawn DS4000 

storage subsystem FAStT500. The maximum number of mirror pairs is eight for 

FAStT500 and 32 for DS4400 and DS4500. 

Enhanced Remote Mirroring is an enhanced version of Remote Mirroring; therefore 

providing an enhancement of the existing 10 km maximum distance synchronous 

Remote Mirror Option. The Enhanced Remote Mirroring supports the 10 km 

maximum distance synchronous Remote Mirroring pairs. The Enhanced Remote 
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Mirroring also supports asynchronous Remote Mirroring with the write consistency 

(GlobaI Mirroring) option or without the write consistency (Global Copy) option. 

The Enhanced Remote Mirroring is supported with controller firmware 06.xx.xx.xx or 

higher. The supported DS4000 storage subsystems are the DS4100 standard option 

with firmware version 06.12.xx.xx or higher, DS4300 with Turbo option, DS4400, 

DS4500, DS4700, and DS4800. The maximum number of mirror pairs is 32 for the 

DS4100 standard dual controller model, DS4300 Turbo models, and DS4700. The 

maximum number of mirror pairs is 64 for DS4400, DS4500, and DS4800. 

The maximum number of storage subsystems that can participate in a remote 

mirror configuration is two. The two storage subsystems are called primary and 

secondary storage subsystems or local and remote storage subsystems. These 

names are used interchangeably to describe remote mirror setups or concepts. The 

names do not refer to the location of storage subsystems or to the role that storage 

subsystems have in a remote mirror relationship. 

Primary and secondary logical drives on a remote mirror setup 

This section introduces you to primary and secondary logical drives, and describes 

how they interact to replicate data between storage subsystems using the Remote 

Mirror Option. When you create a remote mirror, a mirrored logical drive pair is 

defined and consists of a primary logical drive at the primary storage subsystem, 

and a secondary logical drive at a secondary storage subsystem. A standard logical 

drive might only be defined in one mirrored logical drive pair. The maximum number 

of supported mirrored logical drive pairs is determined by the storage subsystem 

model. 

The primary and secondary role in a remote mirror setup is implemented at the 

logical drive level instead of at the storage subsystem level. All logical drives that 

participate in a remote mirror relationship on a storage subsystem can be in either a 

primary or secondary role only. The storage subsystem can also have a 

combination of logical drives in a primary role and logical drives in a secondary role. 

Whether the logical drive is in a primary or secondary role, it counts towards the 

maximum number of mirror logical drive pairs that can be defined in a storage 

subsystem. 

There are no requirements for having a certain number of logical drives be of a 

certain role in a remote mirror relationship for a given storage subsystem. For 

example, a storage subsystem with a maximum of 16 remote mirror relationship 

pairs might have logical drives in any one of the remote mirror relationship 

combinations shown in Table 6. 

 Table 6. Remote Mirror drives in primary and secondary roles 

Remote mirror 

drives in a 

primary role 

Remote mirror 

drives in a 

secondary role 

Description 

16 0 This local storage subsystem has data in 16 logical 

drives mirrored in 16 logical drives in a separate 

(remote) storage subsystem. 

8 8 This local storage subsystem has data in eight logical 

drives mirrored in eight logical drives in a remote 

storage subsystem. It also has eight logical drives that 

are used to store the mirrored data from eight logical 

drives in a remote storage subsystem. 
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Table 6. Remote Mirror drives in primary and secondary roles (continued) 

Remote mirror 

drives in a 

primary role 

Remote mirror 

drives in a 

secondary role 

Description 

4 12 There are four logical drives that are used to store the 

mirrored data from four logical drives in a remote 

storage subsystem. It also has 12 logical drives that 

are used to store the mirrored data from 12 logical 

drives in a remote storage subsystem. 

0 16 This local storage subsystem has 16 logical drives that 

are used to store the mirrored data from 16 logical 

drives in a remote storage subsystem.
  

Notes:  

1.   With the Enhanced Remote Mirroring premium, feature, there is a maximum of 

32 remote mirror pairs for DS4100 standard dual controller model, DS4300 

Turbo models, and DS4700, and 64 remote mirror pairs for DS4400, DS4500, 

and DS4800. 

2.    For firmware version 05.3x.xx.xx or higher, the maximum number of logical 

drives include the FlashCopy repository logical drives, the VolumeCopy target 

logical drive, and the Remote Mirror logical drives, in addition to the standard 

data logical drives. If the Remote Mirror Option is enabled, two logical drives are 

reserved for use by the system. 

3.   There is no Remote Mirror support for FAStT200, DS4100 single controller 

models, or DS4300 base/standard and single controller unit. 

4.   FAStT500 is not supported with the new Enhanced Remote Mirroring Option. 

None of the new remote mirroring features are applicable for this subsystem. 

Enhanced Mirroring is supported with the previous 10 km maximum distance 

synchronous Remote Mirror Option only. 

5.   There is a maximum of eight remote mirror pairs for the FAStT500, and the 

DS4400 and DS4500, with the Remote Mirroring premium feature option. 

6.   When using firmware version 05.xx.xx or higher, the firmware reserves one 

logical drive for the system to use. 

7.   There is a maximum of four FlashCopy logical drives for each standard logical 

drive. 

8.   The host-agent management method uses a special logical drive, called an 

access logical drive, to communicate with the controllers on the storage 

subsystem. The access logical drive uses one of the available LUNs. Therefore, 

managing storage subsystems with the host-agent software limits you to one 

fewer LUN than the maximum number that is supported by the operating system 

and the host adapter. 

For controller firmware 05.4x.xx.xx or higher the maximum number of logical 

drives per storage mapping partition is 256. However, depending on the 

operating system limitations, the actual number of supported LUNs logical drives 

per storage mapping partition is less than 256.

The primary logical drive is the drive that accepts host computer I/O and stores 

program data. When you first create the mirror relationship, data from the primary 

logical drive is copied (becomes a mirror image) in its entirety to the secondary 

logical drive. This process is known as a full synchronization and is directed by the 

controller owner of the primary logical drive. During a full synchronization, the 

primary logical drive remains fully accessible for all normal I/O operations. 

 

Chapter 6. Overview of the Enhanced Remote Mirroring Option 93



When a write request is made to the primary logical drive, the controller owner of 

the primary logical drive also initiates a remote write request to the secondary 

logical drive. The timing of the write I/O completion indication that is sent back to 

the host depends on the write mode option that is selected. Synchronous write 

mode requires the primary-side controller to wait for the acknowledgment of the 

write operation from the secondary-side controller before returning the write I/O 

request completion to the host. Asynchronous write mode, which is a new Remote 

Mirror feature, allows the primary-side controller to return the write the I/O request 

completion to the host server before data has been successfully written by the 

secondary-side controller. See “Write options” on page 97 for more information. 

The secondary logical drive is used to store data that is copied from its associated 

primary logical drive. The controller owner of the secondary logical drive receives 

remote writes from the controller owner of the primary logical drive and will not 

accept host write requests. The Enhanced Remote Mirror Option allows the host 

server to issue read requests to the secondary logical drive.

Note:  The host server must have the ability to mount the file system as read-only 

in order to properly mount and issue read requests to the data in the 

secondary logical drive. 

The secondary logical drive is normally unavailable to host computer programs 

while mirroring is performed. In the event of a disaster or unrecoverable error of the 

primary storage subsystem, a role reversal is performed to promote the secondary 

logical drive to the primary logical drive. Host computers will then be able to access 

the newly-promoted logical drive and normal operations can continue. 

Figure 25 shows the primary and secondary logical drives displayed in the 

Subsystem Management window for the primary storage subsystem and the 

secondary storage subsystem. 

Primary storage subsystem Secondary storage subsystem

Both the primary and secondary
logical drives are displayed in the
Subsystem Management window
for the storage subsystem.

Logical/Physical View Logical/Physical View

Logical Logical

] ]

Unconfigured Capacity (8.44 GB) Unconfigured Capacity (8.44 GB)

Storage Subsystem Primary Site Storage Subsystem Secondary Site

Logical Drive Group 1 (RAID 5) Logical Drive Group 1 (RAID 5)

CTL A Mirror Repository (0.004 GB) CTL A Mirror Repository (0.004 GB)

CTL B Mirror Repository (0.004 GB) CTL B Mirror Repository (0.004 GB)

Free Capacity (10.873 GB) Free Capacity (10.873 GB)

Primary Logical Drive (5 GB) Secondary Logical Drive

Secondary Logical Drive

Only the secondary logical drive
is displayed in the Subsystem
Management window for the
secondary storage subsystem.

SJ001109

  

 

   

Figure 25. Primary and secondary logical drives displayed in the Subsystem Management 

window
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Mirror repository logical drives 

A mirror repository logical drive is a special logical drive in the storage subsystem. It 

is created as a resource for the controller owner of the primary logical drive in a 

remote logical drive mirror. The controller stores mirrored information on this logical 

drive, including information about remote write requests that are not yet written to 

the secondary logical drive. The controller can use this information to recover from 

controller resets or if the storage subsystems are accidentally turned off. 

When you activate the Remote Mirror Option on the storage subsystem, two mirror 

repository logical drives are created, one for each controller in the storage 

subsystem. An individual mirror repository logical drive is not needed for each mirror 

logical drive pair. 

When you create the mirror repository logical drives, you specify their location. You 

can either use existing free capacity (shown in Figure 26 on page 96) or you can 

create an array for the logical drives from the unconfigured capacity, and then 

specify the RAID level. 

Because of the critical nature of the data that is stored, the RAID level of mirror 

repository logical drives must be nonzero. The required size of each logical drive is 

128 MB for each mirror repository logical drive (256 MB total). If you are upgrading 

from the previous version of Remote Mirror, you must upgrade the size of the 

repository logical drive from 4M to 128M (see “Upgrading mirror repository logical 

drives” on page 137) in order to support a maximum of 64 Remote Mirror pairs. A 

maximum of only 32 Remote Mirror pairs is supported with the 4M repository logical 

drive. 

Recommendation:  For each mirrored pair that you create, leave a minimum of 

0.25 GB free capacity in the same array as the mirror 

repository logical drives. If you someday deactivate the 

mirrored pair, this will ensure that you have enough capacity to 

reestablish the mirrored pair from the deactivated state. 

Otherwise, if there is no free capacity available on the storage 

subsystem, you might not be able to reestablish the mirrored 

pair. 

Figure 26 on page 96 shows mirror repository logical drives displayed in the 

Subsystem Management window for the primary storage subsystem. 
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Mirror relationships 

Before you define a mirror relationship, the Remote Mirror Option must be enabled 

on both the primary and secondary storage subsystems. A secondary standard 

logical drive candidate must be created on the secondary storage subsystem if one 

does not already exist. It must be a standard logical drive and be at least the same 

size or larger than the primary logical drive. 

When secondary logical drive candidates are available, you can define a mirror 

relationship in the storage management software by identifying the storage 

subsystem that contains the primary logical drive and the storage subsystem that 

contains the secondary logical drive. 

When you set up the mirror relationship, a full synchronization occurs as data from 

the primary logical drive is copied in its entirety to the secondary logical drive. For 

more information about establishing mirror relationships, see“Creating mirror 

relationships” on page 139. 

Data replication 

This section describes how data is replicated between storage subsystems that are 

participating in remote logical drive mirroring, and the actions that are taken by the 

controller owner of the primary logical drive if a link interruption occurs between 

storage subsystems. Data replication between the primary logical drive and the 

secondary logical drive is managed by the controllers and is transparent to host 

computers and programs. 

Note:  When a read request is received from a host computer, the controller owner 

of either the primary or secondary logical drive manages the request, 

depending on whether the read is issued to the primary or secondary logical 

drive, respectively. No communication takes place between the primary and 

secondary storage subsystems.
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Figure 26. Mirror repository logical drives displayed in the Subsystem Management window
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Write  options 

When the controller owner of the primary logical drive receives a write request from 

a host computer, the controller first logs information about the write request to its 

mirror repository logical drive, and then writes the data to the primary logical drive. 

The controller then initiates a remote write operation to copy the affected data 

blocks to the secondary logical drive at the secondary storage subsystem. 

There are two write mode options that affect the timing that the I/O completion 

indication is sent back to the host: 

v   “Synchronous write mode (Metro Mirroring)” 

v   “Asynchronous write mode (Global Copy and Global Mirroring)” on page 98

Synchronous write mode (Metro Mirroring) 

When synchronous write mode (also known as Metro Mirroring) is selected, any 

host write requests are written to the primary logical drive, and then copied to the 

secondary logical drive. After the host write request has been written to the primary 

logical drive and the data is successfully copied to the secondary logical drive, the 

controller removes the log record on the mirror repository logical drive and sends an 

I/O completion indication back to the host computer. 

In the event of a communication failure, synchronous write mode offers the best 

chance of full data recovery from the secondary logical drive. In synchronous write 

mode, host I/O performance is slower than it is in asynchronous write mode. 

Synchronous write mode is selected by default and is the recommended write mode 

when the maximum distance between the DS4000 Storage Subsystems in an 

Enhanced Remote Mirroring configuration is 10 km. 

Figure 27 on page 98 shows the data replication process for synchronous write 

mode (Metro Mirroring). 
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Asynchronous write mode (Global Copy and Global Mirroring) 

When asynchronous write mode is selected, host write requests are written to the 

primary logical drive, and the controller then sends an I/O completion indication 

back to the host system regardless of when the data was successfully copied to the 

secondary logical drive. 

There are two types of mirroring that use asynchronous write mode: Global Copy 

and Global Mirroring. See “Write consistency groups” on page 99 for a description 

of each type. 

Note:  Remote mirroring using synchronous write mode is referred to as Metro 

Mirroring. 

Asynchronous write mode offers faster host I/O performance than synchronous 

write mode, but does not guarantee that the copy has been successfully completed 

before processing the next write request. This is the recommended mode when the 

maximum distance between the DS4000 Storage Subsystems in an Enhanced 

Remote Mirroring configuration is more than 10 km. 

Figure 28 on page 99 shows the data replication process for asynchronous write 

mode. 
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Figure 27. Data replication between primary and secondary storage subsystems: 

Synchronous write mode (Metro Mirroring)
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Write  consistency 

Write consistency, a configuration option available for any primary or secondary 

logical drives in a remote mirror relationship using asynchronous write mode, 

preserves write orders. 

In asynchronous write mode, write requests are not guaranteed to be completed in 

the same order on the secondary logical drive as they are on the primary logical 

drive. If the order of write requests is not retained, data on the secondary logical 

drive may become inconsistent with the data on the primary logical drive. This can 

jeopardize any attempt to recover data if a disaster occurs on the primary storage 

subsystem. 

You can avoid this by selecting the write consistency option for multiple mirror 

relationships on the same storage subsystem. When you select write consistency, 

the order in which the data is synchronized is preserved. For example: In a remote 

mirror pair, the write for Mirror 1 is always performed before the write for Mirror 2. 

Note:  Selecting write consistency for a single mirror relationship does not change 

the process in which data is replicated. More than one mirror relationship 

must reside on the primary storage subsystem for the replication process to 

change. 

Write consistency groups 

When multiple mirror relationships on a single storage subsystem have been 

configured to use asynchronous write mode and to preserve write consistency, they 

are considered to be an interdependent group known as a write consistency group. 
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Figure 28. Data replication between primary and secondary storage subsystems: 

Asynchronous write mode (Global Copy/Global Mirroring)
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In a write consistency group, all mirror relationships maintain the same order when 

sending writes from the primary logical drives to their corresponding secondary 

logical drives. 

The data on the secondary, remote storage subsystem cannot be considered fully 

synchronized until all remote mirrors in the write consistency group are 

synchronized. If one mirror relationship in a write consistency group becomes 

unsynchronized, all of the mirror relationships in the write consistency group will 

become unsynchronized. In this case, write activity to the remote, secondary 

storage subsystem is prevented, in order to protect the consistency of the remote 

data set. 

Note:  Care must be taken in selecting the number of logical drives that are in a 

write consistency group to minimize the impact when multiple simultaneous 

remote writes becomes single-thread because of write consistency 

requirement.

Example of a write consistency group:   On a campus site, the Remote Mirror 

Option has been configured between two storage subsystems. At the primary site, 

the primary storage subsystem has three defined mirror relationships (RMO-A, 

RMO-B, and RMO-C), with each mirror relationship configured to copy data to the 

secondary storage subsystem. 

All three mirror relationships have been configured to use the Asynchronous write 

mode and to preserve write order. If the mirrored pair RMO-A becomes 

unsynchronized due to a link interruption, the controller will automatically transition 

RMO-B and RMO-C into an Unsynchronized state until communication can be 

resumed. 

Global Copy and Global Mirroring:   There are two types of asynchronous 

mirroring: 

Global Copy 

Refers to a remote logical drive mirror pair that is set up using 

asynchronous write mode without the write consistency group option. This is 

also referred to as Asynchronous Mirroring without Consistency Group. 

 Global Copy does not ensure that write requests to multiple primary logical 

drives are carried out in the same order on the secondary logical drives as 

they are on the primary logical drives. If it is critical that writes to the 

primary logical drives are carried out in the same order in the appropriate 

secondary logical drives, use Global Mirroring instead of Global Copy. 

Global Mirroring 

Refers to a remote logical drive mirror pair that is set up using 

asynchronous write mode with the write consistency group option. This is 

also referred to as Asynchronous Mirroring with Consistency Group. 

 Global Mirroring ensures that write requests to multiple primary logical 

drives are carried out in the same order on the secondary logical drives as 

they are on the primary logical drives, preventing data on the secondary 

logical drives from becoming inconsistent with the data on the primary 

logical drives.

Resynchronization methods 

Data replication between the primary logical drive and secondary logical drive in a 

mirror relationship is managed by the controllers, and is transparent to host 

machines and applications. When the controller owner of the primary logical drive 
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receives a write request from a host, the controller persistently logs information 

about the write to a mirror repository logical drive, then writes the data to the 

primary logical drive. The controller then initiates a write operation to copy the 

affected data to the secondary logical drive on the secondary storage subsystem. 

If a link interruption or logical drive error prevents communication with the 

secondary storage subsystem, the controller owner of the primary logical drive 

transitions the mirrored pair into an Unsynchronized state and sends an I/O 

completion to the host that sent the write request. The host can continue to issue 

write requests to the primary logical drive, but remote writes to the secondary 

logical drive do not take place. These write requests are persistently logged in the 

primary-side remote mirror repository logical drive. 

When connectivity is restored between the controller owner of the primary logical 

drive and the controller owner of the secondary logical drive, resynchronization 

takes place. To minimize the resynchronization effort, the Enhanced Remote 

Mirroring Option will copy only the blocks of data that were changed on the primary 

logical drive during the link interruption to the secondary logical drive. 

If the remote mirror logical drive pair becomes unsynchronized due to the lost of 

mirror repository logical drives, full synchronization will be required when the mirror 

repository logical drives is restored. 

 Attention:  Multiple communication disruptions and restore cycles that occur 

between the primary and secondary storage subsystems during resynchronization 

can result in a mix of new and old data on the secondary logical drive. If this 

happens, the data is unusable in a disaster recovery situation. Manual 

Resynchronization is the recommended setting. 

This section describes the two resynchronization methods that you can use: 

v   “Manual resynchronization” 

v   “Automatic resynchronization” on page 102

Important: Manual resynchronization is the recommended setting for all mirror 

relationships in a write consistency group. If automatic resynchronization is selected 

for a mirror relationship in a write consistency group, resynchronization will start as 

soon as communication is reestablished, which does not preserve consistency in 

the write consistency group. 

Manual resynchronization 

When you select manual resynchronization and a communication failure occurs 

between the primary and secondary storage subsystems, resynchronization of the 

data on the primary logical drive and secondary logical drive can be started 

manually after communication has been restored to the unsynchronized mirrored 

pair. 

Important: Only the blocks of data that were changed on the primary logical drive 

during the link interruption are copied to the secondary logical drive. 

Selecting the manual resynchronization option allows you to manage the 

resynchronization process in a way that provides the best opportunity for recovering 

data. When this option is selected and a communication failure occurs between the 

primary and secondary logical drives, the mirror relationship transitions to an 

Unsynchronized state. Any write requests to the primary logical drive are logged and 

the storage subsystem is placed in a Needs Attention state. 
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After the controller owner of the primary logical drive detects that communication 

has been restored, the mirror relationship will remain in an Unsynchronized state 

until you select Logical Drive → Remote Mirror Option → Resume in the 

Subsystem Management window. 

Automatic resynchronization 

When the automatic resynchronization option is selected and a communication 

failure occurs between the primary and secondary storage subsystems, the 

controller owner of the primary logical drive will start resynchronizing the primary 

and secondary logical drives immediately after detecting that communication has 

been restored. 

Important: Only the blocks of data that have changed on the primary logical drive 

during the link interruption are copied to the secondary logical drive. 

Link interruptions or secondary logical drive errors 

In the course of processing write requests, a primary controller might be able to 

write only to the primary logical drive while a link interruption prevents 

communication with the remote secondary controller. 

After a link interruption, the remote write operation cannot complete to the 

secondary logical drive and the primary and secondary logical drives are no longer 

correctly mirrored. The primary controller transitions the mirrored pair into an 

Unsynchronized state and sends an I/O completion message to the primary host 

computer, as shown in Figure 29. The primary host computer can continue to write 

to the primary logical drive but remote write operations do not take place. 
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When connectivity is restored between the controller owner of the primary logical 

drive and the controller owner of the secondary logical drive, a resynchronization 

either happens automatically or must be started manually, depending on which 

method you chose when you set up the mirror relationship. During the 

resynchronization, only the blocks of data that were changed on the primary logical 

drive during the link interruption are copied to the secondary logical drive. 

After the resynchronization begins, the mirrored pair transitions from an 

Unsynchronized state to a Synchronization-in-Progress state, as shown in 

Figure 30 on page 103. 

Figure 29. Mirrored logical drive pair showing Unsynchronized status
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The primary controller places the mirrored pair in an Unsynchronized state when a 

logical drive error on the secondary storage subsystem prevents a remote write 

operation from completing. For example, an offline or failed secondary logical drive 

can cause the remote mirror to be placed in an Unsynchronized state. When the 

secondary logical drive is placed online or is recovered to an Optimal state, a 

manual or automatic resynchronization is required, and the mirrored pair transitions 

to a Synchronization-in-Progress state. 

For more information about Remote Mirror Option status, see Chapter 8, “Using the 

Enhanced Remote Mirroring Option,” on page 137. 

Connectivity and I/O 

The Remote Mirror Option requires a dedicated host port for mirroring data between 

storage subsystems. This section describes three configurations that you can use to 

connect storage subsystems for remote logical drive mirroring, controller ownership 

of logical drives within storage subsystems, the maximum storage subsystem 

distance permitted, and some general performance considerations. If these 

configurations do not meet your remote mirror configuration requirement, contact 

your IBM technical-support representative. 

The Remote Mirror Option is supported on DS4000 storage subsystems that have 

at least two Fibre Channel host ports per controller (FAStT500, DS4400, and 

DS4300). When the Remote Mirror Option is activated, one Fibre Channel host-side 

I/O port on each controller is dedicated only to mirroring operations. For example, in 

the primary storage subsystem, controller host ports A2 and B2 are dedicated to 

mirroring operations. In the secondary storage subsystem, controller host ports A2 

and B2 are also dedicated to mirroring operations. See Figure 31 on page 104 for 

the location of the controller host ports for FAStT500 and DS4400. 
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Figure 30. Mirrored logical drive pair showing Synchronization-in-Progress status
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See Figure 32 for the location of controller host ports for DS4300. 

 

 For DS4800, controller host ports A4 and B4 are dedicated for mirroring options 

when the Enhanced Remote Mirroring premium feature is enabled. For DS4700, 

controller host port 2 in DS4700 model 70A/H and port 4 in model 72A/H are 

dedicated for mirroring options when the Enhanced Remote Mirroring premium 

feature is enabled. See Figure 33 on page 105 for the location of controller host 

ports for DS4800 and Figure 34 on page 105 and Figure 35 on page 105 for 

DS4700. 
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Figure 31. Controller A and Controller B host ports, FAStT500 and DS4400
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Figure 32. Controller A and Controller B host ports, DS4300
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For FAStT500 and DS4400, each of the controller host ports is connected to a 

minihub. Each minihub has two small form-factor pluggable (SFP) or gigabit 

interface converter (GBIC) port slots. If the first minihub SFP or GBIC port slot is 

connected to a Fibre Channel switch port as part of remote mirror setup, the 

second minihub port must not be occupied. 

Host-initiated I/O operations are refused by the dedicated port. Requests that are 

received on this dedicated port are only accepted from a controller that is 

participating in the remote mirror relationship. 

Controller ports that are dedicated to the remote logical drive mirror must be 

attached to a Fibre Channel fabric environment with support for the Directory 

Service and Name Service interfaces. 

Host port B4

Host port A4

Controller A

Controller B

  

Figure 33. Controller A and Controller B host ports, DS4800

  

Figure 34. Controller A and Controller B host ports, DS4700 Model 70

  

Figure 35. Controller A and Controller B host ports, DS4700 Model 72
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Logical drive ownership 

The controller owner of the primary logical drive attempts to communicate with only 

its mirrored controller in the secondary storage subsystem. As shown in Figure 36, 

controller A in the primary storage subsystem attempts to communicate with 

controller A in the secondary storage subsystem. 

The controller (A or B) that owns the primary logical drive determines the controller 

owner of the secondary logical drive. Regardless of the secondary logical drive 

controller ownership, if the primary logical drive is owned by controller A on the 

primary storage subsystem, the secondary logical drive is then owned by controller 

A on the secondary storage subsystem. If primary controller A cannot communicate 

with secondary controller A, no controller ownership changes take place and the 

remote mirror link is broken for that mirror logical drive pair. When primary controller 

A can communicate with secondary controller A, the next I/O request to the primary 

logical drive results in a secondary drive ownership change. 
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When an I/O path error causes a logical drive ownership change on the primary 

storage subsystem, or if the storage administrator changes the controller owner of 

the primary logical drive, the next remote write request that is processed 

automatically starts an ownership change on the secondary storage subsystem. 

As shown in Figure 37 on page 107, if a primary logical drive is owned by controller 

A and the controller owner is changed to controller B, the next remote write 

operation changes the controller owner of the secondary logical drive from controller 

A to controller B. 

Figure 36. Controller A shown as the controller owner
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Because controller ownership changes on the secondary storage subsystem are 

controlled by the primary controller, they do not require any special intervention and 

you cannot manually change them. 

Note:  Create the primary and secondary mirrors on the same primary path. 

Primary and secondary storage subsystem connection distance 

The maximum connection distance that is permitted between storage subsystems 

that are participating in a mirror relationship is governed by the distance limits of the 

Fibre Channel interswitch links (ISL). With the previous Remote Mirror Option using 

standard single-mode fiber technology, the maximum link distance was 10 km (6.25 

mi) between storage subsystems. In addition, the ISL link must be a standard Fibre 

Channel connection using single-mode Fibre Channel cables between two 

longwave GBICs or SFPs that are inserted into the Fibre Channel switch port slots. 

With the Enhanced Remote Mirroring Option, link distances between storage 

subsystems of more than 5150 km (3200 mi) can be achieved. 

Role reversals 

A role reversal is the act of promoting the secondary logical drive to be the primary 

logical drive of the mirrored logical drive pair, and demoting the primary logical drive 

to the secondary logical drive role. 

In the event of a disaster at the storage subsystem that contains the primary logical 

drive, you can fail over to the secondary site by performing a role reversal to 

promote the secondary logical drive to the primary logical drive role. This allows 

business operations to continue and hosts to continue accessing data. 

You can use one of the following methods to perform a role reversal: 

v   Click Volume → Remote Mirroring → Change → Role to Primary to change a 

secondary logical drive to a primary logical drive. 

This option promotes the selected secondary logical drive to become the primary 

logical drive of the mirrored pair, and can be used when a catastrophic failure 

has occurred. For step-by-step instructions, see the Subsystem Management 

window online help. 

Figure 37. Controller B shown as controller owner
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v   Click Volume → Remote Mirroring → Change → Role to Secondary to change a 

primary logical drive to a secondary logical drive. 

This option demotes the selected primary logical drive to the secondary logical 

drive role, and can be used during normal operating conditions. For step-by-step 

instructions, see the Subsystem Management Window online help.

If the primary storage array is recovered but is unreachable due to a link failure, a 

forced promotion of the secondary logical drive results in both the primary and 

secondary logical drives viewing themselves in the primary logical drive role 

(dual-primary condition). If this occurs, the logical drive copy in which the primary 

logical drive is participating will be unaffected by the role change. 

General performance considerations 

Note the following general performance considerations when you create remote 

mirrors: 

v   The controller owner of a primary logical drive performs a full synchronization in 

the background while processing local I/O write operations to the primary logical 

drive and associated remote write operations to the secondary logical drive. 

Because a full synchronization diverts controller processing resources from I/O 

activity, this can impact performance to the host computer program. 

To reduce the performance impact, you can set the synchronization priority to 

establish how the controller owner prioritizes a full synchronization relative to 

other I/O activity. The following are some basic guidelines for setting the 

synchronization rate: 

–   A full synchronization at the lowest synchronization priority rate takes 

approximately eight times as long as a full synchronization at the highest 

priority synchronization rate. 

–   A full synchronization at the low synchronization priority rate takes 

approximately six times as long as a full synchronization at the highest priority 

synchronization rate. 

–   A full synchronization at the medium synchronization priority rate takes 

approximately three and a half times as long as a full synchronization at the 

highest priority synchronization rate. 

–   A full synchronization at the high synchronization priority rate takes 

approximately twice as long as a full synchronization at the highest priority 

synchronization rate.

For more information about setting the synchronization priority, see Chapter 8, 

“Using the Enhanced Remote Mirroring Option,” on page 137. 

v   When the mirror logical drive pair is in the Synchronization-in-Progress state, 

all host computer write data is copied to the remote system in processing the I/O. 

Controller I/O bandwidth and I/O latency affect host computer write performance. 

Host read performance is not affected by the mirror relationship. 

v   The overall DS4000 storage subsystem performance is impacted by the number 

of remote mirrors defined in the mirroring configurations and the number of write 

requests that need to be performed at a given time for all of the defined mirrors. 

The greatest impact occurs when the maximum number of Remote Mirroring 

pairs are defined and the I/Os to the primary LUNs are write only at the 

maximum I/O rate. Use the appropriate performance monitor to optimally define 

the maximum Remote Mirroring pairs for your applications.
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Using other premium features with the Remote Mirror Option 

This section describes how you can use the Remote Mirror Option with Storage 

Partitioning and FlashCopy. 

For information about using the Remote Mirror Option with VolumeCopy, see “The 

Remote Mirror Option and VolumeCopy” on page 81. 

Storage Partitioning and the Remote Mirror Option 

Storage Partitioning is a premium feature which enables host computers to share 

access to logical drives in a storage subsystem. A storage partition is created when 

you define a collection of host computers (a host group) or a single host computer, 

and then define a logical drive to LUN map. This map enables you to define what 

host group or host computer has access to a particular logical drive in your storage 

subsystem. 

Note:  Storage partitioning is not a copy services premium feature. This guide does 

not describe how to enable and use the Storage Partitioning feature. For 

more information about storage partitioning, see the IBM System Storage 

DS4000 Storage Manager Version 9 Installation and Support Guide for your 

operating system. 

Figure 38 shows the Mappings view of the Subsystem Management window, where 

primary logical drive Accounting is included in a partition that is accessible by host 

group Campus East, and secondary logical drive Accounting 2 is included in a 

partition that is accessible by host group Campus West. 

 

The storage partition definitions for the primary and secondary storage subsystems 

are independent of each other. If the storage partition definitions are put in place 

while the logical drive is in the secondary role, the storage partition reduces the 

administrative effort that is associated with storage subsystem recovery if it 
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Figure 38. Mappings view of the Subsystem Management window showing storage 

partitioning
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becomes necessary to promote the secondary logical drive to the primary role. 

However, depending on the host operating system and application, the secondary 

logical drive might not be assigned to the same host that the primary logical drive is 

mapped to. For more information about defining storage partitions, see the 

Subsystem Management window online help. 

Storage partition definitions can be performed using the Create command in the 

Storage Manager Script window or the CLI. For more information, see the 

Enterprise Management window online help. 

FlashCopy and the Remote Mirror Option 

FlashCopy is a premium feature that comes with the IBM DS4000 Storage Manager 

software. You can enable this premium feature by purchasing the FlashCopy option. 

A FlashCopy logical drive is a point-in-time (real-time) image of a logical drive and 

is created so that a program, such as a backup program, can access the 

FlashCopy logical drive and read the data while the base logical drive remains 

online and is accessible to host computers. 

When FlashCopy is enabled, you can have FlashCopy logical drives that are based 

on the primary or secondary logical drive of a mirrored logical drive pair. 

The logical drive for which the point-in-time image is created is known as the base 

logical drive and must be a standard logical drive in the storage subsystem. For 

remote logical drive mirroring, only the base logical drive of a FlashCopy logical 

drive is permitted to be a candidate for the primary logical drive in a mirror 

relationship. Figure 39 on page 111 shows the primary logical drive (also the base 

logical drive for the FlashCopy logical drive), the secondary logical drive, and the 

FlashCopy repository logical drive in the Subsystem Management window for the 

primary storage subsystem. 

Important: The base logical drive of a FlashCopy logical drive cannot be a 

candidate for the secondary logical drive role in a mirror relationship. Otherwise, the 

FlashCopy logical drive fails when the remote mirror relationship is created. 
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Dynamic Volume  Expansion 

Dynamic Volume Expansion (DVE) is a modification operation that you can use to 

increase the capacity of a standard logical drive or a FlashCopy repository logical 

drive. To increase the capacity, a DVE operation uses the free capacity that is 

available on the logical drive group of the logical drive. 

The operation is considered to be ″dynamic″ because you can continuously access 

data on logical drive groups, logical drives, and disk drives during the operation. 

You can perform a DVE operation on a primary or secondary logical drive in a 

remote mirror relationship. However, keep in mind that although Storage Manager 

indicates that the logical drive has increased in capacity, its usable capacity 

becomes the smaller of the two logical drives. 

You cannot perform a DVE operation on a mirror repository logical drive. If the 

mirror repository logical drive exists from a previous release of Storage Manager 

and needs to be upgraded, see “Upgrading mirror repository logical drives” on page 

137 

Figure 39. FlashCopy logical drive included in a mirror relationship
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Chapter  7.  Installing  hardware  and  software  for  the  Enhanced  

Remote  Mirroring  Option  

This chapter contains the information that you need to install the hardware and 

software to run the Remote Mirror Option. The first section contains the steps that 

you must complete before you install the hardware and software. In the next 

section, hardware installation procedures are presented, followed by software 

installation procedures. Complete the procedures in this chapter sequentially, from 

beginning to end. 

Pre-installation considerations 

This section provides the following information that you must review and complete 

before you begin the hardware or software installation procedures: 

v   Site preparation 

v   Hardware requirements 

v   Software requirements 

v   Host operating systems 

v   Switch zoning overview

Site preparation 

The Remote Mirror Option uses Fibre Channel switches to create a fabric 

environment for data replication. These Fibre Channel switches require only minimal 

additional site preparation beyond basic storage subsystem operation. 

For basic site preparation considerations including the use of Fibre Channel cables 

and connections, see the IBM System Storage DS4000 Storage Manager Version 9 

Installation and Support Guide for your operating system. 

For additional site preparation considerations concerning the Fibre Channel 

switches, including power requirements and physical dimensions and requirements, 

see the documentation provided with the fabric switch. 

Hardware requirements 

The following list contains the minimum hardware requirements for configuring your 

system to use the Enhanced Remote Mirror Option. The list includes the 

components that are supplementary to the standard requirements of a basic storage 

subsystem environment. For more information, see the IBM System Storage 

DS4000 Storage Manager Version 9 Installation and Support Guide for your 

operating system.

Note:  Enhanced Remote Mirroring is not supported on IBM FAStT500 Fibre 

Channel Storage Subsystems. However, you can use the previous, 

synchronous-mode-only Remote Mirroring on FAStT500 storage servers with 

Storage Manager firmware version 05.20.xx.xx or higher. If you have a 

FAStT500 storage subsystem, see the following previous edition of the Copy 

Services Guide for information about using Remote Mirroring: 

IBM System Storage FAStT Storage Manager Copy Services Guide 

(GC26-7561-00) 

v   IBM System Storage DS4000 Storage Subsystems 
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Enhanced Remote Mirroring is currently supported on DS4100, DS4300, 

DS4400, DS4500, DS4700, and DS4800 Storage Subsystems. For information 

about other storage subsystems that might be supported in the future, contact 

your IBM service representative. 

It is possible to have different storage subsystems in each of the two nodes of 

the Remote Mirror Option. For example, the local storage subsystem can be the 

IBM DS4400 Storage Subsystem and the remote storage subsystem can be the 

IBM DS4500 Storage Subsystem and vice-versa. 

However, because the IBM DS4400 and IBM DS4500 Storage Subsystems are 

different sets of hardware with different performance characteristics, the storage 

subsystem and its associated drives and storage expansion enclosures in each 

of the nodes of the remote mirror setup must be the same for optimal and 

reliable performance. 

v   Fibre Channel switches 

Use these devices to connect multiple host computers with multiple storage 

subsystems in a storage area network (SAN) fabric environment. 

For Metro Mirroring (synchronous write mode), the fibre channels switches must 

be used to connect the DS4000 storage subsystem controller ports that are 

dedicated for remote mirroring operations together (see “Connectivity and I/O” on 

page 103). For Global Copy and Global Mirroring (asynchronous write mode), 

use either the fibre channels switches or the fibre-channel-IP (FC-IP) routers for 

connecting the DS4000 storage subsystem controller ports that are dedicated for 

remote mirroring operations together. If the FC-IP routers are used, ensure that 

minimum speed between the FC-IP router is 10 MB per second. (It is 

recommended that the maximum number of active mirrors be reduced to eight at 

this minimum speed.) 

For a list of certified Fibre Channel switches to use with the Remote Mirror 

Option, see the DS4000 Storage Subsystem Interoperability matrix at the 

following Web site: 

www-1.ibm.com/servers/storage/disk/ds4000/interop-matrix.html 

v   Multimode Fibre Channel cables 

Use these cables to connect the host computers and the storage subsystems to 

the Fibre Channel switches. Multimode Fibre Channel cables are used with 

shortwave SFP to complete Fibre Channel connections between any two nodes. 

v   Single-mode Fibre Channel cables 

Use these cables to connect between Fibre Channel switches to complete 

long-distance Fibre Channel connections between Fibre Channels switches. 

Singlemode Fibre Channel cables must also be used with longwave SFPs. 

v   Fibre Channel host bus adapters (HBAs) 

For a list of certified HBAs to use with the Remote Mirror Option, see the 

DS4000 Storage Manager readme file for your host operating system. 

v   Ethernet switches and network 

Use these devices to connect the DS4000 Storage Subsystems to the DS4000 

Storage Subsystem management station. To create remote mirror logical drive 

pairs, the management station must have either in-band or out-of-band 

management connections to both DS4000 Storage Subsystems where the logical 

drives reside. 

The management station with the Storage Manager client program that is used to 

manage an Enhanced Remote Mirror setup must have management connections 

to both the primary and the secondary DS4000 setups. For example, both the 

primary and the secondary DS4000 Storage Subsystems must have optimal 

entries in the Enterprise Management window of the Storage Manager client 
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program. You must ensure that the management station, and the primary and 

secondary DS4000 Storage Subsystems are in the same Ethernet subnet.

Software requirements 

When configuring your host computer to use the new Enhanced Remote Mirroring 

Option, be sure that the following minimum software requirements are met: 

v   IBM DS4000 Storage Manager version 9.x or higher 

v   Controller firmware version 06.10.xx.xx or higher for DS4300 Turbo Option, 

DS4400, and DS4500 (version 06.12.xx.xx or higher is recommended) 

v   Controller firmware version 06.12.1x.xx or higher for DS4100 

v   Controller firmware version 06.16.4x.xx or higher for DS4700 

v   Controller firmware version 06.14.xx.xx or higher for DS4800 (version 06.15.xx.xx 

or higher is recommended) 

v   IBM Enhanced Remote Mirror Premium Feature Key (one for each storage 

subsystem)

When configuring your host computer to use the previous, synchronous-mode-only 

version of Remote Mirror Option, be sure that the following minimum software 

requirements are met: 

v   IBM DS4000 Storage Manager Version 9.x 

v   Controller firmware version 05.20.xx.xx or higher for FAStT500 and DS4400. 

Controller firmware version 05.30.xx.xx or higher for DS4500. 

v   IBM Remote Mirror Premium Feature Key (one for each storage subsystem)

Host operating systems 

Host computers that access mirrored logical drives must have one of the following 

operating systems installed to use the Remote Mirror Option. (For the most 

up-to-date information, see the most recent DS4000 Storage Manager readme file 

for the appropriate host operating system. See “Who should read this document” on 

page xi for instructions that describe how to find the readme file online.) 

v   Microsoft Windows NT 4.0 Server Edition (earlier Remote Mirror Option only) 

v   Microsoft Windows 2000 

v   Microsoft Windows Server 2003 

v   Solaris Version 2.6, 2.7 (Solaris 7), 2.8 (Solaris 8), Solaris 9 

v   HP-UX Version 11.0 or higher 

v   AIX Version 5.1, 5.2 or higher 

v   Linux (Red Hat Advance Server 3.0 and 4.0, SLES 8, 9 and 10) 

v   Linux on POWER-based operating systems (Red Hat Enterprise Linux 3 and 4, 

SLES 9 and 10) 

v   Novell NetWare Version 6.5

Switch zoning overview 

This section describes how to create zones for Remote Mirroring. For host server 

zoning, see the DS4000 Storage Manager Installation and Support Guide for your 

host operating system, in addition to the installation and user’s guide provided by 

the switch manufacturer. 

To create switch zoning configurations for Remote Mirroring, use the management 

software that comes with the Fibre Channel switch. 
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The Enhanced Remote Mirroring Option requires two dedicated controller host port 

connections for each storage subsystem that will participate in Enhanced Remote 

Mirroring. When the Enhanced Remote Mirroring Option is activated on a storage 

subsystem, one of the host ports in each of the DS4000 controllers is dedicated for 

Remote Mirroring. You cannot use this port for other types of I/O to the DS4000 

storage subsystem. In DS4000 storage subsystems that have a maximum of two 

host ports on each controller, the second host port of each controller is the port that 

is dedicated for Remote Mirroring operations. See the DS4000 Storage Subsystem 

Installation, User’s and Maintenance Guide for your storage subsystem for 

information about Remote Mirroring dedicated ports. 

You must create at least two zones – one zone that consists of the host ports in 

controller A of the Enhanced Remote Mirroring pair primary and secondary storage 

subsystems that are dedicated for mirroring operations, and similarly, one zone that 

consists of the host ports in controller B of the primary and secondary storage 

subsystems that are dedicated for mirroring operations. This configuration is 

required to ensure that one port on the controller is fully dedicated to remote 

mirroring operations. However, for best practices, IBM Corporation recommends 

that you also zone server HBA connections so that a single host bus adapter in a 

server can access only one controller per storage subsystem. 

Important:  

1.   IBM Corporation recommends that you establish one-to-one zones between the 

DS4000 Storage Subsystems in the mirrored pair. The zoning and cabling 

procedures described in this section are for illustrative purposes only, and might 

not show one-to-one zoning. Adjust the procedures for your specific installation. 

2.   Do not zone the ISL port that connects (cascades) switches within a fabric 

environment. 

3.   Although the ports that are dedicated for remote mirroring operations are known 

as host ports, in a remote mirror setup you do not connect them to a host 

server. Instead, you connect them to the other DS4000 Storage Subsystems in 

the mirrored pair. 

When two or more Fibre Channel switches are cascaded together, each switch 

shares a common view of the SAN fabric. For example, if two 16-port Fibre 

Channel switches are physically connected (cascaded) with a Fibre Channel cable, 

the switch management software manages these two switches as if they are a 

single switch with 32 ports (0 - 31), rather than as two separate Fibre Channel 

switches with 16 ports each (0 - 15). Therefore, a zone that is created containing 

any of these ports exists on multiple cascaded Fibre Channel switches.

Note:  This is usually, but not always the case, depending on the switch 

manufacturer. Some switch software might write over, rather than merge the 

switches. 

In the top illustration in Figure 40 on page 117, the Fibre Channel switches are on 

the same network and cascaded. Therefore, there are two zones that span across 

two switches (Zone 1 and Zone 2). Zone 1 is the same zone on Switch 1A as Zone 

1 on Switch 1B. 

In the bottom illustration in Figure 40 on page 117, the Fibre Channel switches are 

on the same network, but are not cascaded. Therefore, in this configuration, there 

are four different zones — two zones on Switch 1 and two zones on Switch 2. The 

zones on Switch 1 are independent of the zones on Switch 2. 
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For more information about Fibre Channel switch zoning or setting up a zone 

configuration, see the documentation that comes with the switch. 

Installing the hardware 

This section describes the procedures that are necessary to properly connect and 

configure one or more storage subsystems for use with the Remote Mirror Option. 

For a checklist to ensure that all the required hardware components are configured 

properly, see “Hardware and software checklists” on page 134. 

The following Remote Mirroring configurations are examples of configurations that 

IBM Corporation supports. Contact your IBM representative or reseller if you have 

questions about the implementation of your Remote Mirroring requirements. 

Host 1

HA1 HA2

Host 1

HA1 HA2

Fabric 1
10 Km Max

Switch 1A

Switch 1

Zone 1
0 2 4 6 8 10 12 14

1 3 5 7 9 11 13 15
Zone 1 Zone 2

0 2 4 6 8 10 12 14

1 3 5 7 9 11 13 15
Zone 1 Zone 2

0 2 4 6 8 10 12 14

1 3 5 7 9 11 13 15
Zone A Zone B

Zone 2

Switch 1B

Switch 2

16 18 20 22 24 26 28 30

17 19 21 23 25 27 29 31

B1 B2

A1 A2

B1 B2

A1 A2

  

Figure 40. Switch zoning in cascaded (top) and noncascaded (bottom) Fibre Channel 

switches
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Highest Availability Campus configuration 

This configuration has two Fibre Channel switches at both the primary and 

secondary sites to provide complete failover and redundancy in the Fibre Channel 

switches and fabrics, in addition to all storage subsystem components and host 

computers. Two Fibre Channel switches at each site also provide redundancy to the 

local site in addition to a fully redundant remote configuration. There is no single 

point of failure in the hardware components. Therefore, data synchronization can 

continue for any single switch failure. This simplifies the disaster recovery process. 

Use Metro Mirroring (synchronous write mode) for distance less than 10 km and 

Global Mirroring for distance of greater than 10 km. Additional hardware and/or 

Fibre Channel switch licensing may be required to support distances greater than 

10 km. 

Important:  

1.   IBM Corporation recommends that you establish one-to-one zones between the 

DS4000 Storage Subsystems in the mirrored pair. The zoning and cabling 

procedures described in this section are for illustrative purposes only, and might 

not show one-to-one zoning. Adjust the procedures for your specific Highest 

Availability Campus installation. 

2.   The Highest Availability Campus configuration is the preferred configuration for 

the Remote Mirror Option. 

Figure 41 on page 119 shows the Highest Availability Campus configuration after 

installation is complete. 
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Switch zoning for the Highest Availability Campus configuration 

This configuration provides a separate zone for each reserved port for the Remote 

Mirroring Option. 

You do not need to zone the Fibre Channel switches exactly as presented in this 

sample configuration. However, the following are requirements when zoning 

switches for the Highest Availability Campus configuration: 

v   The remote mirror host port connections cannot be zoned together. You must 

create two zones: 

–   The first zone consists of the Remote Mirroring-dedicated host ports from 

Controllers A of the primary and secondary host subsystems. 

–   The second zone consists of the Remote Mirroring-dedicated host ports from 

Controllers B of the primary and secondary host subsystems.
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Figure 41. Highest Availability Campus configuration
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v   The uplink port must not be zoned on any Fibre Channel switch. 

v   For best practices, IBM Corporation recommends that you zone server HBA 

connections so that a single host adapter can access only one controller per 

storage subsystem fabric. 

Important: The Fibre Channel switches in Figure 41 on page 119 contain 16 ports 

each, which leaves many unused ports per switch. If you are performing switch 

zoning using the Fibre Channel host port number, instead of the WWNN of the SAN 

fabric logged-in ports, do not include Fibre Channel switch ports with no Fibre 

Channel connections in the zone definition. If you include these unused ports in 

your zones, unauthorized access to the SAN might result. 

Figure 41 on page 119 shows how the four Fibre Channel switches are cabled for 

this Highest Availability Campus configuration. The zones are configured on the 

switch to allow one port per zone for a storage subsystem connection, and one 

HBA port per zone for each host. There are four zones in the following configuration 

example. 

v   Zone 1 and Zone 3 exist on Fabric 1 (switch 1A at the primary site, and switch 

1B at the secondary site) 

v   Zone 2 and Zone 4 exist on Fabric 2 (switch 2A at the primary site, and switch 

2B at the secondary site.

Before proceeding to the next section, ensure that all four Fibre Channel switches 

are properly zoned. For more information about zoning Fibre Channel switches, see 

“Switch zoning overview” on page 115. 
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Cabling examples for the Highest Availability Campus 

configuration 

Table 7 and Table 8 show examples of the Fibre Channel cabling connections in the 

Highest Availability Campus configuration. Refer to the examples before you 

complete the procedure in “Setting up the Highest Availability Campus 

configuration” on page 122. 

Important: IBM Corporation recommends that you establish one-to-one zones 

between the DS4000 Storage Subsystems in the mirrored pair. The examples 

shown in these tables are for illustrative purposes only, and do not show one-to-one 

zoning. 

 Table 7. Highest Availability Campus configuration connections (Primary site) 

Primary site 

Switch 1A Switch 2A 

Zone Port Connection to and from: Zone Port Connection to and from: 

1 0 Host 1, HBA 1 (HA1) 2 0 Host 2, HBA 2 (HB2) 

1 Controller port A1 1 Host 1, HBA 2 (HA2) 

2 Host 2, HBA 1 (HB1) 2 Controller port B1 

3 Additional host, HBA 1 (optional) 3 Additional host, HBA 2 (optional) 

4 Additional host, HBA 1 (optional) 4 Additional host, HBA 2 (optional) 

5 Additional host, HBA 1 (optional) 5 Additional host, HBA 2 (optional) 

6 Additional host, HBA 1 (optional) 6 Additional host, HBA 2 (optional) 

7 Additional host, HBA 1 (optional) 7 Additional host, HBA 2 (optional) 

3 8 Unused 4 8 Controller port B2 (dedicated 

remote mirror port) 

9 Controller port A2 (dedicated 

remote mirror port) 

9 Unused 

10 Unused 10 Unused 

11 Unused 11 Unused 

12 Unused 12 Unused 

13 Unused 13 Unused 

N/A 14 Spare (can be added to either 

zone) 

N/A 14 Spare (can be added to either 

zone) 

N/A 15 Uplink with Switch 1B N/A 15 Uplink with Switch 2B
  

 Table 8. Highest Availability Campus configuration connections (Secondary site) 

Secondary site 

Switch 1B Switch 2B 

Zone Port Connection from and to: Zone Port Connection from and to: 

N/A 16 Uplink with Switch 2A N/A 16 Uplink with Switch 1A 

N/A 17 Spare (can be added to either 

zone) 

N/A 17 Spare (can be added to either 

zone) 
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Table 8. Highest Availability Campus configuration connections (Secondary site) (continued) 

Secondary site 

1 18 Host 3, HBA 1 (HC1) 2 18 Controller port B1 

19 Controller port A1 19 Host 4, HBA 2 (HD2) 

20 Host 4, HBA 1 (HD1) 20 Additional host, HBA 1 (optional) 

21 Additional host, HBA 1 (optional) 21 Host 4, HBA 2 (HD2) 

22 Additional host, HBA 1 (optional) 22 Additional host, HBA 1 (optional) 

23 Additional host, HBA 1 (optional) 23 Additional host, HBA 1 (optional) 

3 24 Unused 4 24 Controller port B2 (dedicated 

remote mirror port) 

25 Controller port A2 (dedicated 

remote mirror port) 

25 Unused 

26 Unused 26 Unused 

27 Unused 27 Unused 

28 Unused 28 Unused 

29 Unused 29 Unused 

30 Unused 30 Unused 

31 Unused 31 Unused
  

Setting up the Highest Availability Campus configuration 

Complete the steps in this procedure to set up the Highest Availability Campus 

configuration for the Remote Mirror Option. Adjust the steps for your specific 

installation. 

Before you begin, note the following information: 

v   It is recommended that you establish one-to-one zones between the DS4000 

Storage Subsystems in the mirrored pair. The zoning and cabling procedures 

described in this section are for illustrative purposes only, and might not show 

one-to-one zoning. Adjust the procedures for your specific Highest Availability 

Campus installation. 

v   Refer to Figure 41 on page 119 as you complete the steps in this procedure. 

v   Begin the installation at the primary site. Repeat these steps for the secondary 

site when instructed to do so. 

v   All connections are completed using Fibre Channel cables of appropriate length. 

v   If you are adding the Remote Mirror Option hardware to an existing storage 

subsystem environment that stops I/O from all host computers, begin with step 1. 

If this is a new storage subsystem installation, begin with step 2.

 1.   Power down all storage subsystems, host computers, Fibre Channel switches, 

and all other hardware in the storage subsystem environment. 

 2.   Ensure that the cabling between all storage subsystems and storage 

expansion enclosures is complete. 

Note:  Depending on which site you are configuring, Switch 1 represents 

Switch 1A for the primary site and Switch 1B for the secondary site. 

Repeat the same configuration for Switch 2. 

 3.   Connect the primary host bus adapter (Hx1) for each local host to an available 

port in Zone 1 of Switch 1. 
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Note:  You can connect the cables to any port in the proper zone of the switch. 

 4.   Connect the secondary host bus adapter (Hx2) for each host at this site to an 

available port in Zone 2 of Switch 2. 

 5.   Connect controller port A1 of the storage subsystem to an available port in 

Zone 1 of Switch 1. 

 6.   Connect controller port B1 of the storage subsystem to an available port in 

Zone 2 of Switch 2. 

 7.   Connect controller port A2 of the storage subsystem to an available port in 

Zone 3 of Switch 1. 

 8.   Connect controller port B2 of the storage subsystem to an available port in 

Zone 4 of Switch 2. 

Note:  Controller ports A2 and B2 are reserved for mirror relationship 

synchronization when the Remote Mirror Option is activated. For more 

information, see “Connectivity and I/O” on page 103. 

 9.   If the primary site cabling and the secondary site cabling is complete, go to 

step 10. Otherwise, repeat step 1 on page 122 through step 8 for the 

secondary site. 

10.   Complete the Fabric 1 environment for Switch 1 by connecting Switch 1A with 

Switch 1B. Connect each end of a long range Fibre Channel cable (that can 

support a distance up to 10 Km (6.25 mi)) to an unzoned port in each switch. 

11.   Repeat step 10 for Switch 2A and 2B to complete the Fabric 2 environment for 

Switch 2. 

12.   Cabling for this Highest Availability Campus configuration is complete. Repeat 

step 3 on page 122 through step 9 for any additional storage subsystems that 

use the Remote Mirror Option. 

13.   Power up all storage subsystems, host computers, Fibre Channel switches, 

and any other hardware at both sites that were powered down in step 1 on 

page 122. 

14.   Hardware installation is complete. The next step is to configure the storage 

management software to support mirror relationships. Go to “Installing the 

software” on page 131.

Campus configuration 

The Campus configuration offers the same functionality as the Highest Availability 

Campus configuration, but contains only one switch at each site, rather than two. 

The configuration is still redundant for host bus adapters, controllers, and remote 

logical drive mirroring ports, but is a single point of failure for Fibre Channel 

switches. If a switch at either site fails, the Remote Mirror Option cannot function. 

For this reason, the Highest Availability Campus configuration is preferred for total 

environment redundancy. Figure 42 on page 124 shows the Campus configuration 

after installation is complete. 

Use Metro Mirroring (synchronous write mode) for distance less than 10 km and 

Global Mirroring for distance of greater than 10 km. Additional hardware and/or 

Fibre Channel switch licensing may be required to support distances greater than 

10 km. 

Important: IBM Corporation recommends that you establish one-to-one zones 

between the DS4000 Storage Subsystems in the mirrored pair. The zoning and 

cabling procedures described in this section are for illustrative purposes only, and 

might not show one-to-one zoning. Adjust the procedures for your specific Campus 

installation. 
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Switch zoning for the Campus configuration 

This configuration provides a separate zone for each reserved port for the Remote 

Mirroring Option. 

For an example of how to zone the Fibre Channel switches, see “Switch zoning for 

the Highest Availability Campus configuration” on page 119. Remember that the 

Campus configuration uses two Fibre Channel switches and one 10Km (6.2 mi) ISL. 

There are a total of four zones in this configuration. 

v   All zones exist on the Fabric 1 environment (Switch 1A at the primary site, and 

Switch 1B at the secondary site). 

v   Zone 3 and Zone 4 are reserved for the dedicated Remote Mirror Option 

connections. 

Important: The Fibre Channel switches in Figure 42 contain 16 ports each, which 

leaves many unused ports per switch. If you are performing switch zoning using the 

Fibre Channel host port number, instead of the WWNN of the SAN fabric logged-in 

ports, do not include Fibre Channel switch ports with no Fibre Channel connections 

in the zone definition. If you include these unused ports in your zones, unauthorized 

access to the SAN might result. 
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Figure 42. Campus configuration
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Before proceeding to the next section, ensure that both Fibre Channel switches are 

properly zoned. For more information about zoning Fibre Channel switches, see 

“Switch zoning overview” on page 115. 

Cabling examples for the Campus configuration 

Table 9 and Table 10 show examples of the Fibre Channel cabling connections in 

the Campus configuration. Refer to the examples before you complete the 

procedure in “Setting up the Campus configuration” on page 126. 

Important: IBM Corporation recommends that you establish one-to-one zones 

between the DS4000 Storage Subsystems in the mirrored pair. The examples 

shown in these tables are for illustrative purposes only, and do not show one-to-one 

zoning. 

 Table 9. Campus configuration connections (Primary site) 

Primary site 

Switch 1A 

Zone Port Connection to and from: 

1 0 Host 1, HBA 1 

1 Controller port A1 

2 Host 2, HBA 1 

3 Additional host, HBA 1 (optional) 

4 Additional host, HBA 1 (optional) 

5 Additional host, HBA 1 (optional) 

2 6 Host 1, HBA 2 

7 Controller port B1 

8 Host 2, HBA 2 

9 Additional host, HBA 2 (optional) 

10 Additional host, HBA 2 (optional) 

11 Additional host, HBA 2 (optional) 

3 12 Controller port A2 (dedicated remote mirror port) 

4 13 Controller port B2 (dedicated remote mirror port) 

N/A 14 Spare 

N/A 15 Uplink with Switch 2
  

 Table 10. Campus configuration connections (Secondary site) 

Secondary site 

Switch 1B 

Zone Port Connection to and from: 
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Table 10. Campus configuration connections (Secondary site) (continued) 

Secondary site 

1 16 Uplink with Switch 1 

17 Spare 

18 Host port, HBA 1 

19 Controller port A1 

20 Host 4, HBA 1 

21 Additional host, HBA 1 (optional) 

22 Additional host, HBA 1 (optional) 

23 Additional host, HBA 1 (optional) 

2 24 Host 3, HBA 2 

25 Controller port B1 

26 Host 4, HBA 2 

27 Additional host, HBA 2 (optional) 

28 Additional host, HBA 2 (optional) 

29 Additional host, HBA 2 (optional) 

3 30 Controller port A2 (dedicated remote mirror port) 

4 31 Controller port B2 (dedicated remote mirror port)
  

Setting up the Campus configuration 

Complete the steps in this procedure to set up the Campus configuration for the 

Remote Mirror Option. 

Before you begin, note the following information: 

v   IBM Corporation recommends that you establish one-to-one zones between the 

DS4000 Storage Subsystems in the mirrored pair. The zoning and cabling 

procedures described in this section are for illustrative purposes only, and might 

not show one-to-one zoning. Adjust the procedures for your specific Campus 

installation. 

v   Refer to Figure 42 on page 124 as you complete the steps in this procedure. 

v   Begin the installation at the primary site. Repeat these steps for the secondary 

site when instructed to do so. 

v   All connections are completed using Fibre Channel cables of appropriate length. 

v   If you are adding Remote Mirror Option hardware to an existing storage 

subsystem environment that stops I/O from all host computers, begin with step 1. 

If this is a new storage subsystem installation, begin with step 2.

 1.   Power down all storage subsystems, host computers, Fibre Channel switches, 

and all other hardware in the storage subsystem environment. 

 2.   Ensure that the basic cabling between all storage subsystems and storage 

expansion enclosures is complete. 

Note:  Depending on which site is configured, Switch 1 represents Switch 1A 

for the primary site, and Switch 1B for the secondary site. 

 3.   Connect the primary host bus adapter (Hx1) for each host at this site to an 

available port in Zone 1 of Switch 1. 

Note:  You can connect the cables to any port in the proper zone of the switch.
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4.   Connect the secondary host bus adapter (Hx2) for each host at this site to an 

available port in Zone 2 of Switch 1. 

 5.   Connect controller port A1 of the storage subsystem to an available port in 

Zone 1 of Switch 1. 

 6.   Connect controller port B1 of the storage subsystem to an available port in 

Zone 2 of Switch 1. 

 7.   Connect controller port A2 of the storage subsystem to an available port in 

Zone 3 of Switch 1. 

 8.   Connect controller port B2 of the storage subsystem to an available port in 

Zone 4 of Switch 1. 

Note:  Controller ports A2 and B2 are reserved for mirror relationship 

synchronization when the Remote Mirror Option is activated. For more 

information, see “Connectivity and I/O” on page 103. 

 9.   The primary site cabling is now complete. If the secondary site cabling is 

complete, go to step 10. Otherwise, repeat step 1 on page 126 through step 8 

for the secondary site. 

10.   Complete the Fabric 1 environment by connecting Switch 1A with Switch 1B. 

Connect each end of a long range Fibre Channel cable (that can support a 

distance of up to 10 Km [6.25 mi]) to an unzoned port in each switch. 

11.   Cabling for this Campus configuration is complete. Repeat step 3 on page 126 

through step 9 for any additional storage subsystems that use the Remote 

Mirror Option. 

12.   Power up all storage subsystems, host computers, Fibre Channel switches, 

and any other hardware at both sites that were powered down in step 1 on 

page 126. 

13.   Hardware installation is complete. The next step is to configure the storage 

management software to support mirror relationships. Go to “Installing the 

software” on page 131.

Intra-site configuration 

This configuration is similar to the Campus configuration in that there are only two 

Fibre Channel switches. However, no multiple-switch fabrics exist in this 

configuration. This configuration is used in environments where a long distance 

fabric is not required due to the close proximity of the host computers and storage 

subsystems. The configuration is still redundant for host bus adapters, controllers, 

remote logical drive mirroring ports, and Fibre Channel switches, but is a single 

point of failure for the site. For this reason, the Highest Availability Campus 

configuration is preferred for total environment redundancy. 

Important: 

v   A switch failure in this configuration does not affect data access; however, an 

unsynchronized mirror state might occur as a result. 

v   IBM Corporation recommends that you establish one-to-one zones between the 

DS4000 Storage Subsystems in the mirrored pair. The zoning and cabling 

procedures described in this section are for illustrative purposes only, and might 

not show one-to-one zoning. Adjust the procedures for your specific Intra-site 

installation.

Figure 43 on page 128 shows the Intra-site configuration after installation is 

complete. 
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Switch zoning for Intra-site configuration 

Intra-site configuration is designed for switch redundancy. However, the Fibre 

Channel switches are not cascaded, and therefore are independent of each other. 

This configuration provides a separate zone for each reserved port for the Remote 

Mirror Option. 

For an example of how to zone the Fibre Channel switches, see “Switch zoning for 

the Highest Availability Campus configuration” on page 119. Remember that the 

Intra-site configuration uses two Fibre Channel switches but does not use any 

10Km (6.2 mi) ISLs. 

Important: The Fibre Channel switches in Figure 43 contain 16 ports each, which 

leaves many unused ports per switch. If you are performing switch zoning using the 

Fibre Channel host port number, instead of the WWNN of the SAN fabric logged-in 

ports, do not include Fibre Channel switch ports with no Fibre Channel connections 

in the zone definition. If you include these unused ports in your zones, unauthorized 

access to the SAN might result. 

Note:  Figure 43 illustrates that there is no relationship between Zone A and Zone B 

in Switch 2 and Zone 1 and Zone 2 in Switch 1. 

There are a total of four zones in this configuration. 

2109 F16 2109 F16

Host 1 Host 2 Host 3 Host 4

Primary Site Secondary Site

Ethernet Network

HBA 1 HBA 2 HBA 1 HBA 2 HBA 1 HBA 2 HBA 1 HBA 2

0 1 2 3 4 5 6 7 8 9 1110 12 13 14 150 1 2 3 4 5 6 7 8 9 1110 12 13 14 15

DS4300
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DS4500
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j0
0

1
1

5
1

  

Figure 43. Intra-site configuration
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v   Zone 1 and Zone 2 exist on Switch 1 

v   Zone A and Zone B exist on Switch 2

Before proceeding to the next section, ensure that both Fibre Channel switches are 

properly zoned. For more information about zoning Fibre Channel switches, see 

“Switch zoning overview” on page 115. 

Cabling examples for the intra-site configuration 

Table 11 shows examples of the Fibre Channel cabling connections in the intra-site 

configuration. Refer to the examples before you complete the procedure in “Setting 

up the Intra-site configuration.” 

Important: IBM Corporation recommends that you establish one-to-one zones 

between the DS4000 Storage Subsystems in the mirrored pair. The examples 

shown in these tables are for illustrative purposes only, and do not show one-to-one 

zoning. 

 Table 11. Intra-site configuration connection 

Switch 1 Switch 2 

Zone Port Connection to and from: Zone Port Connection to and from: 

1 0 Host 1, HBA 1 (HA1) A 0 Host 1, HBA 2 (HA2) 

1 Controller port A1 (primary storage 

subsystem) 

1 Controller port B1 (primary 

storage subsystem) 

2 Host 2, HBA 1 (HB1) 2 Host 2, HBA 2 (HB2) 

3 Controller port A1 (secondary 

storage subsystem) 

3 Controller port B1 (secondary 

storage subsystem) 

4 Host 3, HBA 1 (HC1) 4 Host 3, HBA 2 (HC2) 

5 Additional host, HBA 1 (optional) 5 Additional host, HBA 2 

(optional) 

6 Host 4, HBA 1 (HD1) 6 Host 4, HBA 2 (HD2) 

7 Additional host, HBA 1 (optional) 7 Additional host, HBA 2 

(optional) 

2 8 Unused B 8 Unused 

9 Controller port A2 (primary storage 

subsystem - dedicated remote 

mirror port) 

9 Controller port B2 (primary 

storage subsystem - 

dedicated remote mirror port) 

10 Unused 10 Unused 

11 Controller port A2 (secondary 

storage subsystem - dedicated 

remote mirror port) 

11 Controller port B2 (secondary 

storage subsystem - 

dedicated remote mirror port) 

12 Unused 12 Unused 

13 Unused 13 Unused 

14 Unused 14 Unused 

15 Unused 15 Unused
  

Setting up the Intra-site configuration 

Complete the steps in this procedure to set up the Intra-site configuration for the 

Remote Mirror Option. 

Before you begin, note the following information: 
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v   IBM Corporation recommends that you establish one-to-one zones between the 

DS4000 Storage Subsystems in the mirrored pair. The zoning and cabling 

procedures described in this section are for illustrative purposes only, and might 

not show one-to-one zoning. Adjust the procedures for your specific Intra-site 

installation. 

v   Refer to Figure 43 on page 128 as you complete the steps in this procedure. 

v   Begin the installation at the primary site. Repeat these steps for the secondary 

site when instructed to do so. 

v   All connections are completed using Fibre Channel cables of appropriate length. 

v   If you are adding Remote Mirror Option hardware to an existing storage 

subsystem environment that stops I/O from all host computers, begin with step 1. 

If this is a new storage subsystem installation, begin with step 2.

 1.   Power down all storage subsystems, host computers, Fibre Channel switches, 

and all other hardware in the storage subsystem environment. 

 2.   Ensure that the basic cabling between all storage subsystems and storage 

expansion enclosures is complete on both storage subsystems. 

 3.   Connect the primary host bus adapter for each host (Hx1) to an available port 

in Zone 1 of Switch 1. 

Note:  You can connect the cables to any port in the proper zone of the switch. 

 4.   Connect the secondary host bus adapter (Hx2) for each host to an available 

port in Zone A of Switch 2. 

 5.   Connect controller port A1 of the primary storage subsystem to an available 

port in Zone 1 of Switch 1. 

 6.   Connect controller port B1 of the primary storage subsystem to an available 

port in Zone A of Switch 2. 

 7.   Connect controller port A2 of the primary storage subsystem to an available 

port in Zone 2 of Switch 1. 

 8.   Connect controller port B2 of the primary storage subsystem to an available 

port in Zone B of Switch 2. 

Note:  Controller Ports A2 and B2 are reserved for mirror relationship 

synchronization when the Remote Mirror Option is activated. For more 

information, see “Connectivity and I/O” on page 103. 

 9.   Connect controller port A1 of the secondary storage subsystem to an available 

port in Zone 1 of Switch 1. 

10.   Connect controller port B1 of the secondary storage subsystem to an available 

port in Zone A of Switch 2. 

11.   Connect controller port A2 of the secondary storage subsystem to an available 

port in Zone 2 of Switch 1. 

12.   Connect controller port B2 of the secondary storage subsystem to an available 

port in Zone B of Switch 2. 

13.   Cabling for this Intra-site configuration is complete. Repeat step 3 through step 

12 for any additional storage subsystems that use the Remote Mirror Option. 

14.   Power up all storage subsystems, host computers, Fibre Channel switches and 

any other hardware that was powered down in step 1. 

15.   Hardware installation is complete. The next step is to configure the storage 

management software to support mirror relationships. Go to “Installing the 

software” on page 131.

 

130 IBM System Storage DS4000 Storage Manager Copy Services User’s Guide



Installing the software 

The Remote Mirror Option is a premium feature that is included as part of the IBM 

DS4000 Storage Manager installation. You must purchase an IBM Storage Manager 

Remote Mirror Option for each storage subsystem in your remote mirror 

configuration. This option contains a GenKey file that will enable the Remote Mirror 

Option. If you want to purchase the Remote Mirror Premium Feature option, contact 

your IBM technical-support representative. 

Important: All storage subsystems participating in mirror relationships must have 

firmware level 05.2x.xx.xx or higher installed. For more information about upgrading 

firmware and installing the storage-management software, see the appropriate IBM 

System Storage DS4000 Storage Manager Version 9 Installation and Support Guide 

for your operating system. 

For a checklist to ensure that all the required software components are configured 

properly, see “Hardware and software checklists” on page 134. 

For more information about enabling or activating the Remote Mirror Option, see 

“Enabling and activating the Remote Mirror Option.” 

Enabling and activating the Remote Mirror Option 

The Remote Mirror Option premium feature key must be purchased before you can 

enable the option. The option must be activated by using a GenKey program before 

you can create any mirror relationships. First, determine the status of the Remote 

Mirror Option. Then enable and activate it. 

Determining Remote Mirror Option status 

There are four possible statuses of the Remote Mirror Option: 

v   Disabled/Deactivated 

v   Disabled/Activated 

v   Enabled/Deactivated 

v   Enabled/Activated

Important: The Remote Mirror Option must be in the Enabled/Activated state on 

the secondary storage subsystem as well as the primary storage subsystem to 

create and maintain mirror logical drive pairs. 

You can determine the current status by hovering the mouse pointer over the 

Remote Mirror option icon in the status area of the Subsystem Management 

window, as shown in Figure 44 on page 132. 
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Important: The Remote Mirror Option status for the primary storage subsystem is 

managed independently from the secondary storage subsystem. To determine the 

status for both storage subsystems, select each storage subsystem independently, 

then determine the status. 

The Remote Mirror Option statuses are as follows: 

Disabled and deactivated 

No function of the Remote Mirror Option can be performed. Full Remote 

Mirror Option functionality is not available until the option is enabled and 

activated. The icon for this state displays in the Premium Feature status 

area as a cylinder with a mirrored reflection. The icon has a red slash 

through it to show it is disabled and deactivated. An example of this state is 

shown in Figure 44. 

Disabled and activated 

 The Remote Mirror Option is disabled, preventing new mirror relationships 

from being created. However, any pre-existing mirror relationships are 

maintained with all functions of the Remote Mirror Option. The icon that 

displays for this state is similar to the disabled and deactivated state, 

because the red slash remains to show the option is disabled. However, the 

cylinder and its reflection are green to show that the option is active. 

Enabled and deactivated 

The Remote Mirror Option is enabled, but not activated. The icon that 

displays for this state is similar to the disabled and deactivated state, 

because the cylinder and its reflection remain gray indicating that it is not 

available. However, there is no red slash, indicating that the option is 

enabled. 

Enabled and activated 

The Remote Mirror Option is enabled and active. You can create and 

maintain mirror relationships. The icon for this state displays in the Premium 

Feature status area as a green cylinder with a mirrored reflection.

Enabling the Remote Mirror Option 

If the current status of the Remote Mirror Option is Disabled/Deactivated or 

Disabled/Activated, complete the following steps to enable the Remote Mirror 

Option. 

Remote Logical Drive Mirroring - Disabled/Deactivated

Logical Drive Group 4 (RAID 5)

Logical Drive Group 5 (RAID 5)

5 (84.602 GB)

6 (67.681 GB)

SJ001117

  

Figure 44. Remote Mirror Option status
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To enable the Remote Mirror Option, you must perform the following two 

procedures in the following order: 

1.   Obtain the feature enable identifier. This procedure is described in detail in 

“Obtaining the feature enable identifier” on page 10. 

2.   Generate the feature key file and enable the Remote Mirror Option. This 

procedure is described in detail in “Generating the feature key file” on page 10.

Before you begin, gather the following information: 

v   Your Feature Activation Code, which is printed on the IBM FlashCopy Premium 

entitlement card 

v   Your controller unit IBM serial number, which is printed on the label on the back 

of your DS4000 controller unit 

v   A 32-character alphanumeric IBM DS4000 Storage Subsystem premium feature 

identifier string.

To obtain the storage subsystem premium feature identifier string, ensure that your 

controller unit and storage expansion enclosures are connected, powered on, and 

managed using the SMclient. 

If the Remote Mirror Option has not been activated, go to “Activating the Remote 

Mirror Option.” If the Remote Mirror Option is activated, go to “Creating mirror 

relationships” on page 139. 

For more detailed steps on how to enable the Remote Mirror Option, see “Enabling 

the premium feature” on page 10. For information on how to view a list of those 

premium features that are enabled on your storage subsystem, see “Verifying that 

the premium feature is enabled” on page 11. 

Activating the Remote Mirror Option 

Activating the Remote Mirror Option prepares the storage subsystem to create and 

configure mirror relationships. When the option is activated, ports A2 and B2 of the 

storage controller are reserved and dedicated to Remote Mirror Option usage. In 

addition, a mirror repository logical drive is created for each controller in the storage 

subsystem. 

If the current status of the Remote Mirror Option is Enabled/Deactivated, complete 

the following steps to activate the option: 

1.   In the Subsystem Management window, click Storage subsystem → Remote 

Mirroring → Activate . 

The Activate Remote Logical Drive Mirroring - Introduction window opens. 

Note:  Click Back at any time to change the information in the previous window. 

2.   Decide where the mirror repository logical drives will reside. Select one of the 

following: 

v   Use free capacity on existing arrays - If this option is selected, then a 

corresponding logical drive must also be selected. 

a.   Select a logical drive. 

b.   Select Finish or Next. 

c.   Go to step 6 on page 134.

v   Create a new array using unconfigured capacity - If this option is 

selected, more information must be collected about the new logical drive. Go 

to step 3.

3.   In the Create New Array window, select the RAID level for the new logical drive. 
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4.   Under the drive selection choices, select one of the following: 

v   Automatic - The drives are chosen automatically according to available 

capacity. 

v   Manual - This option gives you the option to specify which drives contain the 

mirror repository logical drive.

a.   Press and hold the Ctrl key and click to select the drives that you want to 

include in your array. 

b.   Click Apply.

Important: If the RAID level for the new array is RAID 1, then the number of 

drives must be an even number. If an odd number of drives are selected, an 

error message displays when you click Apply. 

5.   Click Next. 

6.   Review the information in the Preview window and click Finish if all information 

is satisfactory. 

7.   If the storage subsystem password is protected, type the password and click 

OK. 

If the storage subsystem password is not protected, go to step 8 

8.   Review the information in the Completed window and click OK to finish the 

Remote Mirror Option activation. 

The Remote Mirror Option must be enabled and activated on all storage 

subsystems that are part of a remote mirror setup. When the Remote Mirror 

Option is activated, the icon in the Premium Feature status area changes from 

gray to green. If this is not the case, repeat the steps in “Enabling and activating 

the Remote Mirror Option” on page 131 and step 1 on page 133 through step 8 

of this procedure for each storage subsystem that has the remote mirror option 

disabled and deactivated. 

9.   Continue with “Creating mirror relationships” on page 139.

Hardware and software checklists 

Complete the hardware checklist in Table 12 and the software checklist in Table 13 

on page 135 to ensure that all the required hardware and software components are 

configured properly. 

Hardware checklist 

Complete the tasks in Table 12 before you configure the Remote Mirror Option 

using the storage management software. 

 Table 12. Hardware checklist 

Task description Validation activity 

Ensure that the minimum hardware requirements are met. For a 

complete list of the hardware requirements, see “Hardware 

requirements” on page 113. 

h Completed 

Configure your primary and secondary storage subsystems. See 

the appropriate storage subsystem Installation and User’s Guide 

for configuration information and see “Installing the hardware” on 

page 117. 

h Completed 

Configure your Fibre Channel switches and cables. For more 

information about configuring the Fibre Channel switches to use 

with the Remote Mirror Option, see “Installing the hardware” on 

page 117. 

h Completed
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Software checklist 

Complete the tasks in Table 13 before you define mirror relationships in your 

storage subsystems. 

 Table 13. Software checklist 

Task description Validation activity 

Back up all data on the primary and secondary storage 

subsystems that are participating in remote logical drive mirroring. 

h Completed 

Install the correct version of firmware and storage-management 

software. For more information about upgrading firmware or 

installing the storage management software, see the appropriate 

IBM DS4000 Storage Manager Installation and Support Guide or 

the Subsystem Management window online help. 

h Completed 

Enable the Remote Mirror Option on both the primary and 

secondary storage subsystems. For information about enabling 

the feature, see “Enabling and activating the Remote Mirror 

Option” on page 131. 

h Completed 

Activate the Remote Mirror Option and create a mirror repository 

logical drive for each controller on the primary storage subsystem. 

For more information about activating the Remote Mirror Option, 

see “Enabling and activating the Remote Mirror Option” on page 

131. 

h Completed 

Create the required primary and secondary logical drives on the 

primary and secondary storage subsystems. For more information 

about establishing a mirror relationship, see Chapter 8, “Using the 

Enhanced Remote Mirroring Option,” on page 137. 

h Completed

  

Verifying installation and configuration 

All hardware and software is now set up to support mirror relationships through the 

Remote Mirror Option. However, before creating mirror relationships, ensure that all 

required components are working properly. 

Complete the following procedure for each storage subsystem that is participating in 

any aspect of a mirror relationship to verify correct configuration: 

 1.   Start the storage management software. 

For more information about starting the storage management software, see the 

IBM System Storage DS4000 Storage Manager Version 9 Installation and 

Support Guide for your operating system’s specific procedures. 

If this is the first time that you have started the storage management software, 

go to step 2. If this is not the first time that you have started the storage 

management software, go to step 3. 

 2.   If this is the first time that you have started the storage management software, 

perform the following steps: 

a.   Click OK when prompted for Automatic Discovery of devices. 

b.   Ensure that all the storage subsystems that are designated to participate in 

mirror relationships are displayed in the Device Tree view of the Enterprise 

Management window.

Note:  If the storage subsystems do not display, see Chapter 10, 

“Troubleshooting the Enhanced Remote Mirroring Option,” on page 157. 

 3.   If this is not the first time that you have started the storage management 

software, perform the following steps: 
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a.   In the Enterprise Management Window, click Tools → Automatic 

Discovery. 

b.   Click OK. 

c.   Verify that all the storage subsystems that are designated to participate in 

mirror relationships are displayed in the Device Tree view of the Enterprise 

Management window.

Note:  If the storage subsystems do not display, see Chapter 10, 

“Troubleshooting the Enhanced Remote Mirroring Option,” on page 

157.

 4.   In the Enterprise Management window, select a storage subsystem that will 

participate in mirror relationships. 

 5.   Click Tools → Manage Device to open the Subsystem Management window 

for that storage subsystem. 

 6.   In the Subsystem Management window, click Help → About. 

 7.   Verify that the version of the storage management software is 08.3x.xx.xx or 

higher. If this requirement is not met, see the procedures to upgrade the 

storage management software in the IBM System Storage DS4000 Storage 

Manager Version 9 Installation and Support Guide for your operating system. 

 8.   Click OK. 

 9.   In the Subsystem Management window, click Storage Subsystem → View 

Profile. 

10.   Click the All tab, and verify that the current firmware version is 05.2x.xx.xx or 

higher. If this requirement is not met, see the procedures to upgrade the 

firmware in the IBM System Storage DS4000 Storage Manager Version 9 

Installation and Support Guide for your operating system. 

When your installation is completed, refer to the following online help systems: 

v   Enterprise Management window help - Use this online help system to learn 

more about working with the entire management domain. 

v   Subsystem Management window help - Use this online help system to learn 

more about managing individual storage subsystems and Remote Mirror 

Option.

You can access these help systems from within the SMClient. In either a 

Enterprise Management or Subsystem Management window, click Help or 

press F1. 

11.   Click Close. 

12.   Observe the Remote Mirror Option icon in the status area. The icon 

represents the Disabled and Deactivated status of the Remote Mirror Option. 

13.   To begin working with mirror relationships, go to Chapter 8, “Using the 

Enhanced Remote Mirroring Option,” on page 137.
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Chapter  8.  Using  the  Enhanced  Remote  Mirroring  Option  

This chapter contains the procedures for completing the major tasks that are 

associated with the Remote Mirroring Option: 

v   “Upgrading mirror repository logical drives” 

v   “Creating mirror relationships” on page 139 

v   “Maintaining mirror relationships” on page 141 

v   “Deactivating and disabling the Remote Mirror Option” on page 148

Upgrading mirror repository logical drives 

In previous versions of DS4000 Storage Manager, the maximum number of logical 

drives that could participate in mirror relationships was 32. DS4000 Storage 

Manager 9.1x, in conjunction with DS4000 Storage Subsystem controller firmware 

version 06.10.xx.xx or higher, allows 64 logical drives to participate in mirror 

relationships. Therefore, to support creating more than 32 logical drives in mirror 

relationships, you need to upgrade any existing mirror repository logical drives on 

the storage subsystem to have a minimum capacity of 128 MB (increased from 4 

MB). Because two mirror repository logical drives are required per DS4000 server, a 

maximum of 256M of disk space will be needed. 

Note:  You do not need to complete the steps in this section if DS4000 Storage 

Manager 9.1x is the first time you have activated the Remote Mirror Option. 

Upgrading the mirror repository logical drives is only required if a previous 

version of DS4000 Storage Manager existed on your system, with the 

Remote Mirror Option feature installed, before you installed DS4000 Storage 

Manager 9.1x. 

Use the Upgrade Mirror Repository Logical Drives Wizard to create new, larger 

mirror repository logical drives on your storage subsystem, then to move any data 

from the existing mirror repository logical drives to the new ones, and then to delete 

the old mirror repository logical drives. 

Important: If there is not enough free capacity or unconfigured capacity available 

on your storage subsystem, you will not be able to upgrade your mirror repository 

logical drives. The Free Capacity or Unconfigured Capacity options you select for 

the mirror repository logical drives must have a total of 256 MB capacity available. 

Two mirror repository logical drives are created on this capacity: one for each 

controller. 

Recommendation:  For each mirrored pair that you upgrade, leave a minimum of 

0.25 GB free capacity in the same array as the mirror 

repository logical drives. If you someday deactivate the 

mirrored pair, this will ensure that you have enough capacity to 

reestablish the mirrored pair from the deactivated state. 

Otherwise, if there is no free capacity available on the storage 

subsystem, you might not be able to reestablish the mirrored 

pair. 

Complete the following steps to upgrade the mirror repository logical drives: 

1.   Select Storage Subsystems → Remote Mirroring → Upgrade Mirror 

Repository Logical Drives. 
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The Upgrade Mirror Repository Logical Drives: Introduction dialog window 

opens. 

2.   In the Upgrade Mirror Repository Logical Drives: Introduction dialog window, 

select one of the following options, based on where the upgraded mirror 

repository logical drives will reside: 

v   Free capacity on same array (create individual logical drive) – You must 

also select a corresponding array. 

a.   Select an array. 

b.   Select Next. 

c.   Go to step 5.

v    Free capacity on different array (create individual logical drive) – You 

must also select a corresponding array. 

a.   Select an array. 

b.   Select Next. 

c.   Go to step 5.

v    Unconfigured capacity (create new array) – If you select this option, the 

Create New Array dialog window opens. Go to step 3 to create a new array.

3.   In the Create New Array dialog, select the RAID level for the new array. 

Note:  If you need more detailed information about the options in this dialog 

window, select the Help button to launch the online help that is specific to 

this dialog window. 

4.   Under the drive selection choices, select one of the following options: 

v   Automatic – The drives are chosen automatically according to available 

capacity. Click Next; the Preview dialog window opens. 

v   Manual – The user specifies which drives contain the mirror repository logical 

drive, as follows: 

–   Select the desired drives. You can select multiple drives by pressing and 

holding Ctrl while you select. 

–   Click Add to move the drives to the Selected Drives panel. 

–   Click Next. The Preview dialog window opens. 

Important: If the RAID level for the new array is RAID 1, then you must 

select an even number of drives. If you select an odd number of drives, an 

error message will display when you click Apply. RAID 0 is not an option; 

therefore, the number of drives that you select must always be greater than 

one for all RAID levels. RAID 3 and RAID 5 require a minimum of three 

drives.

5.   Review the information that displays in the Preview dialog window, then click 

Finish if all information is satisfactory. 

Notes:  

a.   If prompted for a password, enter the password and select OK. 

b.   The upgrade process might take a minute or longer to complete, depending 

on the current workload of the storage subsystem. Any I/O activity to the 

storage subsystem might be delayed during the upgrade process.

The Completed dialog window opens. 

6.   Review the information that displays in the Completed dialog window, then click 

OK. The mirror repository logical drives are now upgraded, and the storage 

subsystem can support up to 64 mirror relationships. 
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7.   Repeat step 1 through step 6 on page 138 for the secondary storage 

subsystem, and for any additional storage subsystems that contain mirror 

repository logical drives that have not yet been upgraded.

Creating mirror relationships 

Before you create mirror relationships, be sure that the Remote Mirroring Option is 

enabled and activated. 

Note:  The secondary host ports on the storage subsystems are reserved for data 

synchronization between a primary and secondary logical drive of a mirror 

relationship. 

Creating logical drives for mirror relationships 

Before you create mirror relationships, be sure that logical drives exist at both the 

primary and secondary storage subsystems. The logical drive of the remote mirror 

pair that is presented to the host is the primary logical drive. The storage 

subsystem that the primary drive resides in is called the primary storage subsystem. 

Similarly, the storage subsystem that the secondary logical drive resides in is called 

the secondary storage subsystem. 

If a primary or secondary logical drive does not exist, you must create one on the 

corresponding storage subsystem. 

Consider the following when creating a logical drive: 

v   Create the primary and secondary mirrors on the same primary path. 

v   The secondary logical drive must be of equal or greater size than the primary 

logical drive. 

v   The RAID level of the secondary logical drive does not have to be the same as 

that of the primary logical drive. 

For more information about creating logical drives, see the Subsystem Management 

window online help. 

When logical drives exist at both sites, you can create mirror relationships by using 

the Create Remote Mirror wizard. 

Creating a mirror relationship using the Create Remote Mirror wizard 

Using the Create Remote Mirror wizard, you can create a mirror relationship 

between a primary logical drive and a secondary logical drive. Before beginning the 

wizard, ensure that the following requirements are met: 

v   The Remote Mirroring Option is enabled on both storage subsystems in which 

the primary and secondary logical drives will reside. 

v   The Remote Mirroring Option is activated on both subsystems. 

v   The storage subsystems are connected through a proper Fibre Channel fabric 

configuration. 

v   The size of the secondary logical drive is equal to or greater than the primary 

logical drive. 

v   There are management connections to both the primary and secondary storage 

subsystems. The Enterprise Management window must display both primary and 

secondary storage subsystems in the management domain. 
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v   The remote Fibre Channel switch connections are made between the primary 

and secondary storage subsystems. The Fibre Channel switches are zoned so 

that the controller host ports are by themselves. 

When these requirements are met, complete the following steps to create a mirror 

relationship: 

 1.   In the Logical/Physical view of the Subsystem Management window, select the 

logical drive that will become the primary logical drive in the mirror relationship. 

 2.   Click Logical Drive → Remote Mirroring → Create. 

 3.   Click Next. 

 4.   Follow the instructions in the Select Remote Storage subsystem window. 

The Create Remote Mirror window opens and displays starting requirements 

that are similar to those listed at the beginning of this section. 

a.   Select the proper storage subsystem. The wizard displays all available 

storage subsystems within the management domain that have the Remote 

Mirroring Option enabled and activated. 

b.   Click Next. The Select Secondary Logical Drive window displays.

 5.   Select the logical drive that will become the secondary logical drive in the 

mirror relationship. If there are no logical drives listed, the secondary storage 

subsystem that you selected does not have logical drives with enough capacity 

available to mirror the selected logical drive. 

 6.   Click Next. The Set Write Mode window displays. 

 7.   Select one of the following write modes: 

v   Synchronous 

v   Asynchronous

If you select Asynchronous mode, the ″Add to write consistency group″ check 

box becomes available. Select the ″Add to write consistency group″ check box 

if you want to define a Global Mirroring mirror pair (ensures that write 

operations to the secondary storage subsystem are completed in the same 

order as on the primary storage subsystem) instead of a Global Copy mirror 

pair. For more detailed descriptions of each type of write mode, see “Write 

options” on page 97.

Notes:  

a.   Synchronous remote mirroring is referred to as Metro Mirroring. 

b.   Asynchronous remote mirroring with the consistency group option is 

referred to as Global Mirroring; without the consistency group option, it is 

referred to as Global Copy. 

c.   Adding the mirrored pair to a write consistency group (Global Mirroring) 

might impact host I/O performance. 

d.    For more information about write consistency groups, see “Write 

consistency groups” on page 99 or “Changing the write mode” on page 

146.

 8.   Click Next. The Select Synchronization Settings window displays. 

 9.   Select the synchronization priority level. 

Note:  For more information about the synchronization priority level, see 

“Changing the synchronization settings” on page 143. 

10.   Select the resynchronization method. 
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Note:  For more information about resynchronization methods, see 

“Resynchronization methods” on page 100. 

11.   Click Finish. 

12.   If the remote storage subsystem is password protected, type the password and 

click OK. 

If the remote storage subsystem is not password protected, go to step 13. 

13.   If you do not exceed the maximum number of mirrored logical drive pairs that 

can be created for the storage subsystem, you are prompted to create another 

mirror logical drive pair by the Create Remote Mirror wizard. If you do not want 

to create another mirror logical drive pair, click No and go to step 14. 

Otherwise, perform the following steps: 

a.   Select the logical drive that will become the next primary logical drive. 

b.   Click Next. 

c.   Repeat step 4 through step 13 for each additional mirror relationship.

14.   Review the information in the Completed window, then click OK to complete 

the Create Remote Mirror wizard. 

The primary and secondary logical drives are now displayed with the mirror 

relationship icons, which will change slightly when the data synchronization is 

completed. The amount of time that is required for the data to be synchronized 

between the two logical drives varies proportionally to the size of the logical drive 

being mirrored and storage subsystem I/O loads. After the synchronization is 

complete, the icons change to the optimal state mirror relationship icons. Figure 45 

shows how the icons display during and after data synchronization. 

Note:  To view all the icons that are associated with the Remote Mirror Option and 

a description of their purpose, see the Subsystem Management window 

online help. 

New mirror relationship
with synchronizing data

Optional mirror relationship
with fully synchronized data

Primary Logical Drive (5 GB) Primary Logical Drive (5 GB)

Secondary Logical Drive Secondary Logical Drive

SJ001118

  

 

 

The mirror relationship is now created and optimal. 

Maintaining mirror relationships 

When a mirror relationship is active, you can modify certain attributes of the 

relationship at any time. This section describes how to view information about the 

mirror relationship, how to change the synchronization priority level, how to remove 

a mirror relationship, and how to delete logical drives that are participating in a 

mirror relationship. 

Figure 45. Synchronizing and optimal mirror relationship icons
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Viewing  mirror relationships 

The mirror relationship that exists between the primary logical drive and the 

secondary logical drive can be examined by various methods, such as using the 

storage subsystem profile, the Mirroring Properties window, and the View 

Associated Components window. 

Displaying the storage subsystem profile 

The storage subsystem profile is the most efficient way to view information about 

any or all components of the storage subsystem. Details for all logical drives, such 

as the primary, secondary, and mirror repository logical drives can all be easily 

viewed through the storage subsystem profile. The storage subsystem profile also 

contains specific information about components that are associated with mirror 

relationships. 

To display the storage subsystem profile, complete the following steps: 

1.   In the Subsystem Management window click Storage Subsystem → View 

Profile. 

2.   Click the Logical Drives tab. 

v   To view information about the mirror relationships that exist on this storage 

subsystem, click the Mirrors tab. 

v   To view information about the mirror repository logical drive, click the 

Repositories tab.

Note:  Click Save As to save all of the information that is shown in the storage 

subsystem profile as a text (.txt) file. The Save Profile window that opens 

provides the option of saving the current window, multiple windows, or the 

entire storage subsystem profile. 

The Mirroring Properties window 

The Mirroring Properties window displays all the physical characteristics of a single 

logical drive in the mirror relationship. 

The window displays the same information as the storage subsystem profile for the 

selected logical drive, but is specific only to that logical drive. The synchronization 

progress displays if the selected logical drive is synchronizing data with another 

logical drive in a newly defined mirror relationship or in an existing mirror 

relationship after the broken mirror link is restored. 

Complete the following steps for each logical drive that needs to be examined in the 

mirror relationship: 

1.   Select the primary or secondary logical drive. 

2.   Click Logical Drive → Properties. 

3.   Click the Mirroring tab. 

You can also use this procedure to view the synchronization progress of a 

recently-created mirror relationship. 

The View Associated Components window 

The View Associated Components window provides a graphical representation of 

the logical drives that are participating in the mirror relationship. Details are 

provided for all components, rather than just the logical drive that was initially 

selected. 
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Complete the following steps to view all the associated components in a mirror 

relationship, including primary, secondary, and mirror repository logical drives: 

1.   Select the primary or secondary logical drive in a mirror relationship. 

2.   Right click and select View Associated Components. 

The View Associated Components window opens. 

3.   Click Close to exit the window.

Changing the synchronization settings 

The synchronization priority level of a mirror relationship defines the amount of 

system resources that are used to synchronize the data between the primary and 

secondary logical drives of a mirror relationship. If you select the highest priority 

level for a mirror relationship, the data synchronization uses a high amount of 

system resources to increase mirror performance, but might decrease performance 

for all other functions, including other mirror relationships. If you select the lowest 

synchronization level, there is less impact on complete system performance, but the 

mirror relationship synchronization might be slower. 

The setting for the resynchronization method defines whether the communication 

between the primary and secondary logical drives is restored manually or 

automatically after a communication interrupted. 

To change the synchronization settings for a mirror relationship, complete the 

following steps: 

1.   In the Logical/Physical view of the Subsystem Management window, select a 

primary logical drive of a mirror relationship. 

2.   Click Logical Drive → Remote Mirroring → Change → Synchronization 

Settings. 

The Change Synchronization Settings window opens. The primary logical drive 

that you chose in step 1 is selected by default in the Select Logical Drives 

field. 

3.   Select one or more logical drives. 

4.   Select the synchronization priority level. The five levels are Lowest, Low, 

Medium, High, and Highest. All selected logical drives will change to the same 

synchronization priority level. 

For more information about the performance impact of the five priority settings, 

see “General performance considerations” on page 108. 

5.   Select the resynchronization method. You can select Manual or Automatic. 

For more information about the resynchronization methods, see 

“Resynchronization methods” on page 100. 

6.   Click OK. 

7.   Click Yes when the Confirmation window opens. 

8.   Click OK when the Completed window opens.

Suspending a mirror relationship 

Use the Suspend option to stop data transfer between a primary logical drive and a 

secondary logical drive participating in a mirror relationship, without removing the 

mirror relationship. 

Suspending a mirror relationship enables you to control when the data on the 

primary and secondary logical drives should be synchronized. This helps reduce 
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any performance impact to the host application that might occur while any changed 

data on the primary logical drive is copied to the secondary logical drive. 

When a mirror relationship is in a Suspended state, no attempt is made to contact 

the secondary logical drive. Any writes to the primary logical drive are persistently 

logged in the mirror repository logical drives. After the mirror relationship is 

resumed, only the modified regions of the primary logical drive are written to the 

secondary logical drive. The Suspend option can be used to backup a secondary 

logical drive. 

Attention: If the mirrored pair that you select to suspend is part of a write 

consistency group, the system automatically suspends all mirrored pairs in the write 

consistency group. Use the command line interface to resume single 

write-consistent mirrored pairs. For more information about using the command line 

interface, see the Enterprise Management Window online help. For more 

information about write consistency groups, see “Write consistency groups” on page 

99. 

Notes:  

1.    Suspending a mirror relationship removes any Needs Attention status resulting 

from communication failure between the primary and secondary logical drives. 

2.   Any data that is written to the primary volume will be logged while the mirror 

relationship is suspended and will automatically be written to the secondary 

volume when the mirror relationship is resumed. A full synchronization will not 

be required. 

3.   The state of the remote volume mirror remains suspended until you use the 

Resume option to resume synchronization activity. 

Figure 46 shows a mirror relationship in Suspended state.
 

To suspend a mirror relationship, complete the following procedure: 

1.   In the Logical/Physical view of the Array Management Window, select a primary 

volume of a mirror relationship. 

2.   Select Logical Drive → Remote Mirroring → Suspend. The Suspend Mirrored 

Pair window opens. 

3.    Select one or more mirror relationships to suspend. 

4.   Click Suspend. 

5.   Carefully review the information that is presented in the Confirmation window. 

6.   If the information in the Confirmation window is correct, type Yes and click OK. 

Important: If the mirrored pair that you select to suspend is part of a write 

consistency group, the system automatically suspends all mirrored pairs in the 

write consistency group. Use the command line interface to resume single 

d
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Figure 46. Suspended mirror relationships at primary site and secondary site
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write-consistent mirrored pairs. For more information about using the command 

line interface, see the Enterprise Management Window online help. For more 

information about write consistency groups, see “Write consistency groups” on 

page 99.The Suspend Mirrored Pair - Progress window displays while the 

selected mirrored logical drives are suspended. After all of the selected mirrored 

pairs are suspended, the OK button becomes available. 

7.   Click OK. The Subsystem Management window opens, showing the primary 

and secondary logical drives in an Optimal/Suspended state. 

For information about icons used for mirror relationships, refer to the Subsystem 

Management window online help.

Resuming a mirror relationship 

Use the Resume option to restart data transfer between a primary logical drive and 

secondary logical drive participating in a mirror relationship, after the mirror has 

been suspended or unsynchronized. 

This option enables you to control when the data on the primary logical drive and 

secondary logical drive should be resynchronized. This helps reduce any 

performance impact to the host application that might occur while any changed data 

on the primary logical drive is copied to the secondary logical drive. 

After the mirrored pair is resumed, only the regions of the primary logical drive that 

changed since the mirrored pair was suspended are written to the secondary drive. 

Attention: If the mirrored pair that you select to resume is part of a write 

consistency group, the system automatically resumes all mirrored pairs in the write 

consistency group. Use the command line interface to resume single 

write-consistent mirrored pairs. For more information about using the command line 

interface, see the Enterprise Management Window online help. For more 

information about write consistency groups, see “Write consistency groups” on page 

99. 

Complete the following procedure to resume a suspended mirror relationship: 

1.   In the Logical/Physical view of the Subsystem Management Window, select a 

primary logical drive of a mirror relationship. 

2.   Select Logical Drive → Remote Mirroring → Resume. The Resume Mirrored 

Pair window opens. 

3.   Select one or more mirror relationships to resume. 

4.   Click Resume. 

5.   Carefully review the information that is presented in the Confirmation window. 

6.   If the information in the Confirmation window is correct, click Yes to resume 

data transfer to the mirrored pairs that you selected. The Resume Mirrored Pair 

- Progress window displays while data transfer is resumed to the selected 

mirrored pairs. After data transfer is resumed to the mirrored pairs, the OK 

button becomes available. 

7.   Click OK. The Subsystem Management Window opens, showing the primary 

and secondary logical drive in an Optimal or Synchronizing state.

Removing mirror relationships 

Removing a mirror relationship between a primary and secondary logical drive does 

not affect any of the existing data on either logical drive. The link between the 

logical drives is removed, but the primary logical drive still continues normal I/O 

operation. 

 

Chapter 8. Using the Enhanced Remote Mirroring Option 145



This method is not recommended for backup routines. Instead, suspend the mirror 

relationship, because suspend operation maintains the mirror relationship. See 

“Suspending a mirror relationship” on page 143 for more information about the 

suspend procedure. 

A mirror relationship between the two logical drives can be recreated unless one of 

the logical drives is deleted. 

Complete the following steps to remove a mirror relationship between two logical 

drives: 

1.   In the Subsystem Management window, select a local primary or local 

secondary logical drive of a mirror relationship. 

2.   Click Logical Drive → Remote Mirror → Remove Mirror Relationship. 

The Remove Mirror Relationship window displays all mirror relationships that 

are associated with this storage subsystem. 

3.   Select one or more mirror relationships to be removed, and click Remove. 

4.   Carefully review the information that is presented in the Confirmation window. 

5.   If all the information in the Confirmation window is correct, click Yes.

Changing the write mode 

You can select one of the following two write modes: 

Synchronous 

Synchronous write mode offers the best chance of full data recovery from 

the secondary storage subsystem in the event of a disaster. Although it 

provides slower host I/O performance than asynchronous write mode, 

synchronous write mode is the recommended mode. 

 Remote mirroring using synchronous write mode is referred to as Metro 

Mirroring. 

Asynchronous 

Asynchronous write mode offers faster host I/O performance than 

synchronous write mode, but it does not guarantee that data is successfully 

written to the secondary logical drive before indicating a successful write to 

the host system. 

 Remote mirroring using asynchronous write mode with the consistency 

group option is referred to as Global Mirroring. Remote mirroring using 

asynchronous write mode without the consistency group option is referred 

to as Global Copy.

Complete the following steps to change the write mode of a mirror relationship: 

1.   From the Subsystem Management window, select a local primary logical drive of 

a mirror relationship. 

2.   Select Logical Drive → Remote Mirror → Change → Write Mode. The Change 

Write Mode window opens. 

3.   Select one or more mirrored pairs. 

4.   Select one of the following write modes: 

v   Synchronous 

v   Asynchronous

If you select Asynchronous mode, the ″Add to write consistency group″ check 

box becomes available. Do not select the ″Add to write consistency group″ 

check box if you want to define a Global Copy mirror pair (in which write 
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operations to the secondary storage subsystem are not required to be 

completed in the same order as on the primary storage subsystem) instead of a 

Global Mirroring mirror pair. For more detailed descriptions of each type of write 

mode, see “Write options” on page 97.

Notes:  

a.   Synchronous remote mirroring is referred to as Metro Mirroring. 

b.   Asynchronous remote mirroring with the consistency group option is referred 

to as Global Mirroring; without the consistency group option, it is referred to 

as Global Copy. 

c.   Adding the mirrored pair to a write consistency group (Global Mirroring) 

might impact host I/O performance. 

d.   For more information about write consistency groups, see “Write consistency 

groups” on page 99.

Deleting primary and secondary logical drives 

Deleting a logical drive that is participating in a mirror relationship removes the 

mirror relationship and completely deletes the logical drive from the storage 

subsystem. The mirror relationship cannot be redefined until you create a new 

logical drive or an alternate logical drive replaces the deleted logical drive. 

You cannot delete a secondary logical drive that is actively participating in a mirror 

relationship. When you delete a primary logical drive, the mirror relationship is 

removed, and the secondary logical drive becomes a standard logical drive, which 

you can then delete. 

Complete the following steps to delete a primary or secondary logical drive from a 

mirror relationship: 

Attention: 

v   If you have data or logical drives that you want to keep, do not click Recovery → 

Reset → Configuration. This resets the controller unit and deletes all 

previously-configured logical drives. 

v   You must use Disk Administrator and delete operating system logical drives 

before you delete logical drives or reset the configuration in Storage Manager. 

This avoids damage to your registry information. 

v   The following steps will permanently remove data from the selected logical drive. 

1.   In the Subsystem Management window for the primary site, select a primary 

logical drive. 

2.   Select Logical Drive → Delete. 

3.   The Delete Logical Drives window opens. 

4.   Select one or more logical drives to delete. 

5.   Click OK. The confirmation window opens. 

6.   Carefully review the information in the confirmation window. If all the 

information is correct, type Yes in the text area and click OK. 

7.   In the Subsystem Management window for the secondary site, repeat these 

steps to remove the secondary logical drive, if required.
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Deactivating and disabling the Remote Mirror Option 

If no mirror relationships exist and the Remote Mirror Option is no longer required, 

you can deactivate the option to reestablish normal use of dedicated ports on both 

storage subsystems and delete both mirror repository logical drives. 

The Remote Mirror Option can also be disabled. When the option is in the 

Disabled/Active state, you can still maintain and manage previously existing 

mirrors; however, you cannot create any new mirror relationships. When in the 

Disabled/Deactivated state, no Remote Mirror Option activity occurs. 

Note:  When all capacity on a DS4000 storage subsystem is used (no free capacity 

is available), attempts to re-enable or reactivate a disabled/deactivated 

remote mirror might fail with an error message indicating that there is not 

enough space available for creating the remote mirror repository logical 

drives. Therefore, it is best practice to leave a minimum of 0.25 GB free 

capacity for each mirrored pair. The free capacity should be within the same 

array as the mirrored logical drives. Alternatively, you can add additional 

capacity to the storage array, or delete a logical drive from the array to 

create more space. 

Deactivating the Remote Mirror Option 

Complete the following steps to change the Remote Mirror Option status from 

Enabled/Activated to Enabled/Deactivated or from Disabled/Activated to 

Disabled/Deactivated: 

1.   Verify that all mirror relationships are removed. For more information, see 

“Removing mirror relationships” on page 145. 

2.   Click Storage subsystem → Remote Mirror →Deactivate. 

3.   Carefully review the information that is presented in the Confirmation window. 

4.   If the information in the Confirmation window is correct, click Yes.

Disabling the Remote Mirror Option 

Complete the following steps to change the Remote Mirror Option status from 

Enabled/Deactivated to Disabled/Deactivated or from Enabled/Activated to 

Disabled/Activated: 

 Attention:  After you disable the Remote Mirror Option, you will need the 

Enhanced Remote Mirroring premium key file to re-enable the feature. Make sure 

that you have this key file to re-enable the Remote Mirror Option after you disable 

it. Do not disable the Remote Mirror feature if you do not have this key file. 

1.   In the Subsystem Management window, click Storage subsystem → Features → 

Disable. 

2.   Click Remote Mirror. 

3.   Click OK. 

4.   Carefully review the information that is presented in the Confirmation window. 

5.   If the information in the Confirmation window is correct, click Yes.
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Chapter  9.  Disaster  recovery  

This chapter describes the actions to take to prepare for a disaster, the actions to 

take if a hardware component failure occurs, and the actions to take if a complete 

site failure occurs. 

As businesses increasingly require around-the-clock data access, you are required 

to ensure that critical data is safeguarded against potential disasters. In preparing 

for a potential disaster, you must develop a disaster recovery plan that details the 

procedures to prepare for and prevent disasters, and the actions that you need to 

take to respond to and recover from disasters if they occur. 

Planning for disaster recovery 

This section describes the steps that you must take to prepare for a possible 

disaster or unrecoverable error. Preparation includes backing up critical data before 

and during remote logical drive mirroring, using host clustering software for failover 

protection, and preparing the secondary storage subsystem that will participate in 

the remote logical drive mirror. 

Be sure that you complete the checklists in Table 12 on page 134 and Table 13 on 

page 135 to ensure that your primary and secondary storage subsystems are 

prepared correctly. 

Backing up critical data 

It is vital that you back up critical data regularly to protect against disasters or 

unrecoverable error. Backups must be performed regardless of whether the Remote 

Mirror Option is in use. 

A backup of all critical data on both the primary and secondary storage subsystems 

that participate in remote logical drive mirroring must be performed before you 

create a remote logical drive mirror. You must perform periodic backups of the 

primary storage subsystem when remote logical drive mirrors are in use. 

You can use FlashCopy, which captures a point-in-time image of a logical drive, to 

make backups to tape or disk while I/O continues. For more information about using 

FlashCopy logical drives, see “FlashCopy and the Remote Mirror Option” on page 

110 or the Subsystem Management window online help. 

Preparing the secondary storage subsystem 

When preparing for a potential disaster ensure that the secondary storage 

subsystem, to which the data is mirrored, is structured in the same manner as the 

primary storage subsystem. 

Before you create a remote logical drive mirror, prepare your secondary storage 

subsystem to ensure that storage partitions and FlashCopy logical drives are 

defined and ready to function if the secondary storage subsystem is promoted to 

the primary role. 

Defining storage partitioning 

The Storage Partitioning feature enables you to define which host computers have 

access to which logical drives on the storage subsystem and at what LUN. When 

configuring your secondary storage subsystem, replicate the storage partitions that 

were previously defined on the primary storage subsystem. This ensures that if a 
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role reversal is carried out, host computers are able to access their required data. 

Depending on your operating system and host application software, you might not 

be able to map the secondary logical drive to the host that the primary logical drive 

is mapped to. 

For more information about the Storage Partitioning feature, see the Subsystem 

Management window online help. 

Ensuring failover protection using the host clustering software 

Host failover clustering is a process in which the operating system and program 

software work together to provide continuous availability in the event of a program 

failure, hardware failure, or operating system error. Software products that support 

remote failover might refer to global or geographic cluster management. 

You can use the Remote Mirror Option with remote host failover to provide 

complete redundancy of host computers and storage subsystems. If a disaster 

occurs at the primary storage subsystem, host computers at the secondary storage 

subsystem take over the processing and initiate a role change to the secondary 

storage subsystem. 

Remote failover is not a requirement for a disaster recovery plan. Depending on the 

requirements for how quickly operations must again function at optimal status, 

mirroring the storage subsystems and relying on manual startup of the remote host 

computers might be acceptable. 

For more information about host cluster software and configuration, see the readme 

in your IBM DS4000 Storage Manager Version 9 CD. 

Disaster recovery preparation checklist 

Complete the tasks listed in Table 14 to ensure that access to the mirrored data is 

possible in the event of a disaster or an unrecoverable error. 

 Table 14. Disaster recovery preparation checklist 

Task description Validation activity 

1. Back up all critical data on both the primary and secondary 

storage subsystems. 

h Completed 

2. Establish storage partitioning on the secondary storage 

subsystem. This reduces any lag time when promoting a 

secondary logical drive to the primary logical drive role. 

h Completed 

3. If required, configure the host clustering software to allow host 

failover between the primary storage subsystem and secondary 

storage subsystem that is participating in remote logical drive 

mirroring. 

h Completed

  

Recovering from switch failures 

The Campus configuration and the Intra-Site configuration are the two 

configurations where each switch is a single point of failure. In the Highest 

Availability Campus configuration, if a switch fails, at least one other switch is 

configured to be an alternate path for all I/O. The single switch at each site is not 

only responsible for the communication between the two sites for the Remote Mirror 

Option, but for all host-to-storage subsystem I/O as well. 
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If a switch fails in the Campus configuration or the Intra-Site configuration, you must 

decide whether or not to do a complete site failover. This decision must be based 

on the immediate availability of a backup switch or the time it will take to receive a 

replacement. 

If a replacement switch is not readily available, you will need to use one of the 

following temporary scenarios until the switch is replaced. 

v   Direct connection between host computers and storage subsystems - This 

bypasses the switch and allows normal I/O to continue. All mirror relationships 

are suspended until a normal configuration is resumed. Since the storage 

subsystems have a finite number of host connections, all host computers might 

not be able to access the storage subsystem. For information about how to 

directly connect host computers and storage subsystems, see the IBM System 

Storage DS4000 Storage Manager Version 9 Installation and Support Guide for 

your operating system. 

v   Entire site failover - The switch at the secondary site is still functional, which 

enables all host computers to access the switch and storage subsystems. Mirror 

relationships are suspended until the primary storage subsystem is recovered. If 

a complete site failover is needed to continue normal operations, see “Performing 

an entire site failover.”

Recovering from storage subsystem failures 

This section provides procedures for recovering storage systems when one of the 

following situations has occurred: 

v   The primary storage subsystem is damaged or destroyed 

v   The entire primary site is damaged or destroyed 

Both situations require a complete site failover from the primary site to the 

secondary site so that normal operations can continue. For a secondary site failure, 

no site failover is necessary. If the primary logical drive is not damaged, then a full 

synchronization occurs when the site is recovered. If the primary storage subsystem 

is damaged, follow the procedure in “Rebuilding a damaged site” on page 152. 

 Attention:  You must complete the procedures in this section in the order that they 

are presented to ensure that the affected site or storage subsystem is recovered 

successfully. 

Performing an entire site failover 

Entire site failover is necessary when an event occurs that inhibits normal operation 

to the primary site for an extended period of time. 

Complete the following steps to perform an entire site failover: 

1.   Manually reverse the role of the primary logical drive of the mirror relationship to 

the secondary role. For more information, see “Reversing the roles of primary 

and secondary logical drives” on page 153. 

2.   If storage partitioning is preconfigured so that hosts can access the logical 

drives, go to step 4 on page 152. Otherwise, continue with step 3. 

3.   Configure the storage partitioning so that host to logical drive access is identical 

to the primary site configuration. When configured, continue to step 4 on page 

152. For more information about storage partitioning, see “Using other premium 

features with the Remote Mirror Option” on page 109 and the Subsystem 

Management window online help. 
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4.   If the host computers at the secondary site are properly configured for host 

failover, go to step 6. Otherwise, continue with step 5. 

5.   Reinstall the host software and reconfigure the settings as needed. For more 

information about installing and configuring host software, see the 

documentation that comes with the software. 

6.   Run the Hot_add utility on hosts that have only mapped logical drives from the 

secondary storage subsystem. Restart all hosts that have logical drive mappings 

from the primary and secondary storage subsystems. Then resume normal 

operation with the secondary site acting as a new, fully-functioning primary site. 

7.   The entire site failover is complete. The primary site must now be reconfigured 

and the remote mirror environment must be re-created. The next step depends 

on the resulting status of the storage subsystem. 

8.   If the storage subsystem and all of the contained data is recovered and fully 

operational, go to “Recreating a mirror relationship.” Otherwise, go to 

“Rebuilding a damaged site.”

Rebuilding a damaged site 

If a disaster occurs to the primary or secondary site that renders the storage 

subsystem or all data on the storage subsystem irreparable, then the site needs to 

be rebuilt with new hardware. 

Complete the following steps to rebuild a damaged site: 

1.   Obtain new storage subsystems and any host computers and hardware that are 

needed to properly use the Remote Mirror Option. Be sure that the new 

hardware has the same level of specifications as the damaged hardware. 

2.   Depending on the configuration, complete the switch zoning and hardware 

installation procedures for this site only. See “Installing the hardware” on page 

117. 

3.   Define a logical drive to replace the mirrored logical drive that was damaged on 

the original storage subsystem. Be sure that the new logical drive is identical to 

the specifications of the damaged logical drive. 

4.   Ensure that storage partitioning is properly defined so that it can take over 

normal operation from the secondary site. For more information about storage 

partitioning, see “Using other premium features with the Remote Mirror Option” 

on page 109 and the Subsystem Management window online help. 

5.   Ensure that the host software is properly configured so that the host computers 

can take over I/O from the secondary site host computers. For more information 

about installing and configuring host software, see the documentation that 

comes with the software. 

6.   The site is recovered and is now ready to resume any mirror relationships that 

were active before the failure. Go to “Recreating a mirror relationship.”

Recreating a mirror relationship 

After the damaged site is back online and properly configured, mirror relationships 

can be resumed. 

Complete the following steps to recreate a mirror relationship: 

1.   From the active secondary site, define a mirror relationship using the logical 

drive on the recovered primary site as the secondary logical drive. For more 

information, see “Creating mirror relationships” on page 139. 
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2.   Ensure that storage partitioning is properly defined on the recovered primary 

site so that it can take over normal operation from the secondary site. For more 

information about storage partitioning, see “Using other premium features with 

the Remote Mirror Option” on page 109 and the Subsystem Management 

window online help. 

3.   Ensure that the host software is properly configured so that the host computers 

at the recovered primary site can take over I/O from the secondary site host 

computers. For more information about installing and configuring host software, 

see the documentation provided with the software. 

4.   Perform a manual role reversal so that the recovered primary site now 

possesses the active primary logical drive, and the secondary logical drive now 

exists on the secondary site. For more information, see “Reversing the roles of 

primary and secondary logical drives.” 

5.   The remote mirror configuration is now optimal.

Reversing the roles of primary and secondary logical drives 

A role reversal is the process of promoting the secondary logical drive to be the 

primary logical drive within the mirrored logical drive pair, and demoting the primary 

logical drive to be the secondary logical drive. 

A role reversal is performed using one of the following methods: 

Changing a secondary mirrored logical drive to a primary logical drive 

This method promotes a selected secondary logical drive to become the 

primary logical drive of the mirrored pair, and is used when an 

unrecoverable error has occurred. For step-by-step instructions, see 

“Changing a secondary logical drive to a primary drive.” 

Changing a primary mirrored logical drive to a secondary logical drive 

This method demotes a selected primary logical drive to become the 

secondary logical drive of the mirrored pair, and is used during normal 

operating conditions. For step-by-step instructions, see “Changing a primary 

logical drive to a secondary drive” on page 154.

 Role reversals can also be performed using the Set command in the Storage 

Manager Script window or the CLI. For more information, see the Enterprise 

Management window online help. 

Changing a secondary logical drive to a primary drive 

A secondary logical drive is usually promoted to a primary logical drive role when 

an unrecoverable error has occurred on the storage subsystem that contains the 

primary logical drive. The secondary logical drive needs to be promoted so that host 

computers can access data and normal operations can continue. 

This method is not available unless the Remote Mirror Option is activated. 

Note:  When the secondary logical drive becomes a primary logical drive, any host 

computers that are accessing the logical drive through a logical drive-to-LUN 

mapping are now able to read or write to the logical drive. This condition 

applies if the host did not have the same logical-drive-to-LUN mapping as 

the LUN in the primary logical drive that was demoted to secondary logical 

drive. If it did, you must restart the host for the newly-promoted-to-primary 

(secondary) logical drive to replace the demoted (primary) logical drive.
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If a communication problem between the secondary site and the primary site 

prevents the demotion of the primary logical drive, an error message displays. 

However, you are given the opportunity to proceed with the promotion of the 

secondary logical drive, even though this leads to a Dual Primary Remote Mirror 

status condition. The recovery for this condition occurs when the remote mirror 

pairs are recreated. If you attempt to change the role of one of the primary drives, 

an error occurs. 

Complete the following steps to promote a secondary logical drive to the primary 

logical drive role: 

1.   Select the secondary logical drive in the Logical view of the secondary 

Subsystem Management window. Then, either click Logical Drive → Remote 

Mirroring → Change → Role to Primary, or right-click the drive and click 

Change → Role to Primary. The Change to Primary window opens. 

2.   Click Yes. The secondary logical drive is promoted to the primary logical drive 

role in the remote logical drive mirror. 

When the controller owner of the primary logical drive is contacted, the primary 

logical drive is automatically demoted to the secondary logical drive role in the 

remote logical drive mirror.

Changing a primary logical drive to a secondary drive 

Changing a primary logical drive to the secondary logical drive is used for role 

reversals during normal operating conditions. You can also use this option during a 

recovery procedure when a Dual Primary Remote Mirror status condition occurs. 

Role reversal does not occur unless the Remote Mirror Option is activated. 

Important: After the role reversal, any host computers that are accessing the 

primary logical drive through a logical drive-to-LUN mapping are no longer able to 

read or write to the logical drive. When the primary logical drive becomes a 

secondary logical drive, only remote write requests initiated by the primary controller 

are written to the logical drive. 

If a communication problem between the primary and secondary sites prevents the 

demotion of the primary logical drive, an error message displays. However, you are 

given the opportunity to proceed with the demotion of the primary logical drive even 

though this leads to a Dual Secondary Remote logical drive mirror status condition. 

The recovery this status condition occurs when the remote mirror pairs are 

recreated. If you attempt to change the role of one of the primary drives, an error 

occurs. 

 Attention:  If the selected primary logical drive has associated FlashCopy logical 

drives, demoting this logical drive to a secondary role causes the associated 

FlashCopy logical drives to fail. 

Complete the following steps to demote a primary logical drive to the secondary 

logical drive role: 

1.   Select the primary logical drive in the Logical view of the primary Subsystem 

Management window. Then, either click Logical Drive → Remote Mirror → 

Change → Role to Secondary, or right-click the drive and click Change → Role 

to Secondary. The Change to Secondary window opens. 

2.   Click Yes. The primary logical drive is demoted to be the secondary logical drive 

in the remote logical drive mirror. 
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When the controller owner of the primary logical drive is contacted, the 

secondary logical drive is automatically promoted to the primary logical drive 

role in the remote logical drive mirror.
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Chapter  10.  Troubleshooting  the  Enhanced  Remote  Mirroring  

Option  

This chapter provides information about some problems that are commonly 

encountered when using the Remote Mirror Option and how to resolve them. 

The following troubleshooting topics are included in this chapter : 

v   Testing communication between primary and secondary logical drives 

v   General remote logical drive mirroring problems 

v   Inappropriate Fibre Channel fabric configurations 

v   Problems with storage subsystem components that are involved in remote logical 

drive mirroring 

v   Basic switch troubleshooting

Also provided is a list of the critical events that might be generated, and instructions 

for upgrading future versions of controller firmware. 

Locate the section that directly relates to your problem or consult the section 

describing general troubleshooting techniques. If your problem is not discussed in 

any of the sections in this chapter, contact your IBM technical-support 

representative. 

Testing  communication between primary and secondary logical drives 

Use the Test Communication dialog to diagnose possible communication problems 

between a primary logical drive and secondary logical drive participating in a mirror 

relationship. After the communication test has been completed, the dialog will 

display either a Passed, Warning, or Failed status together with values for the 

following: 

v   Test data round trip time 

v   Maximum allowed round trip time 

v   Average round trip time

Important: If the communication test returns a Failed status, the test will continue 

to run after you close the Test Communication dialog until communication between 

the mirrored pair is restored. If you have enabled automatic resynchronization, the 

mirrored pair will automatically synchronize. Otherwise, select Logical Drive → 

Remote Mirroring Option → Resume to manually start resynchronization. 

To run the Test Communication function, follow the steps below: 

1.   Select a primary logical drive or secondary logical drive in the Logical View. 

2.   Select Logical Drive → Remote Mirroring Option → Test Communication. 

3.   The Communication Test dialog displays.
If the communication test returns a Passed with Caution status, the primary 

logical drive and secondary logical drive are communicating correctly; however, 

the test data round trip time is approaching the maximum allowed. This 

indicates that you will need to take some kind of action to fix this problem. 

If the communication test returns a Failed status, the reason for the failure is 

indicated, and you are directed to reference the Recovery Guru to correct the 

problem. 

4.   Review the information displayed in the dialog, and click OK to return to the 

Storage Subsystem Management window.

 

© Copyright IBM Corp. 2004, 2007 157



General troubleshooting 

Table 15 describes some of the usual problems that you might encounter when 

using the Remote Mirror Option. The information is presented in order from the time 

the option is enabled and activated, to problems that might be encountered as you 

use the Remote Mirror Option. 

Information about the probable cause and how you can resolve each problem is 

provided. If your problem is not addressed in this section, see the remaining 

sections in this chapter before you contact your IBM technical-support 

representative. 

 Table 15. General Remote Mirror Option problems 

Problem Cause Resolution 

The Remote Mirror menu 

options in the Subsystem 

Management window are not 

available. 

The Remote Mirror Option is not 

enabled or activated. 

1.   Enable the Remote Mirror Option. A premium 

feature key is required to enable premium 

features. 

2.   Activate the Remote Mirror Option.

The Remote Mirror Option is a premium feature 

option. Contact your IBM technical-support 

representative for purchase information. For 

step-by-step instructions to enable and activate 

the Remote Mirror Option, see “Enabling and 

activating the Remote Mirror Option” on page 

131 or the Subsystem Management window 

online help. 

The Remote Mirror icon in the 

premium feature status area is 

marked with a red line and is 

not available. 

The Remote Mirror Option is not 

enabled or activated. 

1.   Enable the Remote Mirror Option. A premium 

feature key file is required to enable the 

feature. 

2.   Activate the Remote Mirror Option.

The Remote Mirror Option is a premium feature 

option. Contact your IBM technical-support 

representative for purchase information. For 

step-by-step instructions to enable and activate 

the Remote Mirror Option, see “Enabling and 

activating the Remote Mirror Option” on page 

131 or the Subsystem Management window 

online help. 
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Table 15. General Remote Mirror Option problems (continued) 

Problem Cause Resolution 

When creating a remote logical 

drive mirror, the following error 

message is received: 

Error 158 - The operation 

cannot complete because the 

selected logical drive is not 

a a valid candidate for 

Remote Mirroring 

The secondary logical drive 

candidate was participating in a 

mirror relationship with a different 

logical drive on this storage 

subsystem. The mirror 

relationship was successfully 

removed from the other storage 

subsystem. However, a 

communication error prevented 

the successful removal of the 

mirror relationship on this storage 

subsystem. 

A logical drive on this storage subsystem still 

has a mirror relationship defined with the 

secondary logical drive. 

1.   Click View → Storage subsystem profile. 

Click the Logical Drives tab, and then click 

the Mirrors tab. 

2.   Locate the logical drive that is still 

participating in the mirror relationship with 

the secondary logical drive candidate and 

remove the mirror relationship. For 

step-by-step instructions, see “Removing 

mirror relationships” on page 145 or the 

Subsystem Management window online help. 

3.   Re-create the intended remote logical drive 

mirror using the original candidate logical 

drives. For step-by-step instructions, see 

“Creating mirror relationships” on page 139 

or the Subsystem Management window 

online help. 

The primary logical drive is 

showing a Synchronization-in-
Progress status. 

A full synchronization, between 

the primary and secondary logical 

drives participating in a mirror 

relationship, is in progress. Data 

available on the primary logical 

drive is copied in its entirety to its 

associated secondary logical 

drive. 

Wait for the full synchronization to complete. 

When full synchronization has finished copying 

data from the primary logical drive to the 

secondary logical drive, the mirrored logical drive 

pair transitions to a Synchronized status. 

For more information about monitoring the status 

of a remote logical drive mirror, see the 

Subsystem Management window online help. 
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Table 15. General Remote Mirror Option problems (continued) 

Problem Cause Resolution 

Both the primary and secondary 

logical drive are displayed as 

being the primary logical drive. 

A disaster or unrecoverable error 

has occurred on the storage 

subsystem that contains the 

primary logical drive, and the 

secondary logical drive is 

promoted to the primary logical 

drive role. 

The primary storage subsystem is 

now operational, but unreachable 

because of a link failure. A forced 

promotion of the secondary 

logical drive has resulted in both 

the primary and secondary logical 

drives being displayed in the 

primary logical drive role. 

If the mirror logical drive pair status is 

Synchronized, perform step 1 and step 2. 

Otherwise, perform step 3 and step 4. 

1.   Determine which of the logical drives in the 

mirrored logical drive pair must be the 

primary logical drive. 

2.   Choose the logical drive that must be in the 

secondary logical drive role, then click 

Storage subsystem → Change → Role to 

Secondary. A resynchronization 

automatically occurs. 

3.   Delete the mirror relationship from either 

storage subsystem. Select either primary 

logical drive in its respective Subsystem 

Management window and click Logical 

Drive → Remote Mirroring → Remove Mirror 

Relationship. 

Note: The mirror relationship for the remote 

logical drive is not removed if there is a 

connection problem between the two storage 

subsystems. If the mirror relationship 

remains on the remote logical drive after the 

previous action, select that logical drive from 

its respective Subsystem Management 

window and click Logical Drive → Remote 

Mirroring → Remove Mirror Relationship. 

4.   In its respective Subsystem Management 

window, select the logical drive that you want 

to be the primary logical drive. Click Logical 

Drive → Remote Mirroring → Create. Follow 

the instructions in the Create Remote Mirror 

wizard to re-create the mirror relationship

For step-by-step instructions, see “Changing a 

primary logical drive to a secondary drive” on 

page 154 or the Subsystem Management 

window online help. 
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Table 15. General Remote Mirror Option problems (continued) 

Problem Cause Resolution 

Both the primary and secondary 

logical drives are displayed as 

being the secondary logical 

drive. 

In response to a dual primary 

logical drive condition, a role 

reversal was carried out and the 

primary logical drive was 

demoted to the secondary logical 

drive role. The secondary storage 

subsystem is operational, but 

unreachable because of a link 

failure. The forced demotion of 

the primary logical drive has 

resulted in both the primary and 

secondary logical drives being 

displayed in the secondary logical 

drive role. 

If the mirror logical drive pair status is 

Synchronized, perform step 1 and step 2. 

Otherwise, perform step 3 and step 4. 

1.   Determine which of the logical drives in the 

mirrored logical drive pair must be the 

primary logical drive. 

2.   Choose the logical drive that must be in the 

primary logical drive role, then click Storage 

Subsystem → Change → Role to Primary. A 

resynchronization automatically occurs. 

3.   Delete the mirror relationship from either 

storage subsystem. Select either secondary 

logical drive in its respective Subsystem 

Management window and click Logical 

Drive → Remote Mirroring → Remove Mirror 

Relationship. 

Note: The mirror relationship for the remote 

logical drive is not removed if there is a 

connection problem between the two storage 

subsystems. If the mirror relationship 

remains on the remote logical drive after the 

previous action, select that logical drive from 

its respective Subsystem Management 

window and click Logical Drive → Remote 

Mirroring → Remove Mirror Relationship. 

4.   In its respective Subsystem Management 

window, select the logical drive that you want 

to be the secondary logical drive. Click 

Logical Drive→ Remote Mirroring → Create. 

Follow the instructions in the Create Remote 

Mirror wizard to recreate the mirror 

relationship.

For step-by-step instructions, see “Changing a 

secondary logical drive to a primary drive” on 

page 153 or the Subsystem Management 

window online help. 
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Table 15. General Remote Mirror Option problems (continued) 

Problem Cause Resolution 

The primary logical drive or 

secondary logical drive displays 

as missing. 

A physical logical drive that a 

remote logical drive mirror 

depends on (primary logical drive, 

secondary logical drive) is 

removed, and the logical drive is 

now displayed under the missing 

logical drives node in the Logical 

view of the Subsystem 

Management window. 

If missing logical drives are detected because 

drives have accidentally been removed, or are 

detected as missing because of a loss of power 

to the storage expansion enclosures. You can 

recover these logical drives by completing the 

following steps: 

1.   Reinsert the drives back into the storage 

expansion enclosure. 

2.   Ensure that the storage expansion enclosure 

power supplies are properly connected to an 

operating power source and have an Optimal 

status.

For more information, see the Recovery Guru or 

contact your IBM technical-support 

representative. 

If the missing logical drive is no longer required, 

it can be deleted. 

Attention:  Deleting a missing logical drive is a 

permanent action. Any associated logical drives 

or logical drive-to-LUN mappings are also 

deleted. For more information, see the Recovery 

Guru or the Subsystem Management window 

online help. 

The mirror relationship was 

removed successfully from the 

primary side, but not from the 

secondary side. 

When removing a mirror 

relationship, a link failure 

occurred between the primary 

and secondary storage 

subsystems and an error 

message displays. 

The Subsystem Management 

window for the primary storage 

subsystem indicates that the 

mirror relationship was removed 

successfully; however, the 

Subsystem Management window 

for the secondary storage 

subsystem indicates that the 

mirror relationship still exists. 

Open the Subsystem Management window for 

the secondary storage subsystem and remove 

the mirror relationship. 

For step-by-step instructions, see “Removing 

mirror relationships” on page 145 or the 

Subsystem Management window online help. 
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Table 15. General Remote Mirror Option problems (continued) 

Problem Cause Resolution 

The mirror relationship was 

removed successfully from the 

secondary side, but not from the 

primary side. 

When removing a mirror 

relationship, a link failure 

occurred between the primary 

and secondary storage 

subsystems. 

The Subsystem Management 

window for the secondary storage 

subsystem indicates that the 

mirror relationship is removed 

successfully; however, the 

Subsystem Management window 

for the primary storage 

subsystem indicates that the 

mirror relationship still exists, with 

the primary logical drive showing 

an Unresponsive status. 

Open the Subsystem Management window for 

the primary storage subsystem and remove the 

mirror relationship. 

For step-by-step instructions, see “Removing 

mirror relationships” on page 145 or the 

Subsystem Management window online help. 

The primary logical drive is 

showing an Unsynchronized 

status. 

The remote logical drive mirror is 

in an Unsynchronized status 

because the data that is mirrored 

between the primary logical drive 

and the secondary logical drive is 

no longer identical. Usual causes 

for this status include link errors, 

a failed primary logical drive or 

secondary logical drive, or a dual 

primary or dual secondary error 

condition. 

While the remote logical drive 

mirror is in an Unsynchronized 

status, no mirroring activity takes 

place.

Notes:  

1.   The remote mirror link and 

the mirror logical drive pair 

status depends on I/O 

requests, especially I/O write 

requests to the primary logical 

drive. If there are no I/O 

requests, the displayed status 

of the mirror link and the 

mirror logical drive pair in the 

Storage Manager client might 

be incorrect. 

2.   Generate I/O write requests 

to the primary logical drive to 

force the storage subsystems 

updating the remote mirror 

status. 

When the controller owner of the primary logical 

drive can communicate with the controller owner 

of the secondary logical drive and the logical 

drive is online and optimal, a full synchronization 

automatically takes place. When a full 

synchronization begins, the remote logical drive 

mirror transitions to a mirror 

Synchronization-in-Progress status. 

For information about monitoring the status of a 

remote logical drive mirror, see the Subsystem 

Management window online help. 
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Table 15. General Remote Mirror Option problems (continued) 

Problem Cause Resolution 

An error message indicates that 

the Remote Mirror Option is out 

of compliance. 

The Remote Mirror Option is out 

of compliance. This normally 

occurs if a storage subsystem 

with logical drives that are 

participating in remote logical 

drive mirroring is moved into the 

primary storage subsystem and 

one of the following conditions 

now exists: 

v   The Remote Mirror Option is 

not enabled on the selected 

storage subsystem. 

v   The Remote Mirror Option is 

enabled, but the current 

number of remote logical drive 

mirrors that are defined on the 

primary storage subsystem 

exceeds the number of mirror 

relationships that are allowed 

for this storage subsystem. 

If the Remote Mirror Option is not enabled for 

the primary storage subsystem: 

1.   Obtain a premium feature key for this feature 

from your IBM technical-support 

representative. 

2.   Enable the Remote Mirror Option. For 

step-by-step instructions, see “Enabling the 

Remote Mirror Option” on page 132, or the 

Subsystem Management window online help.

If the Remote Mirror Option is enabled, but the 

current number of mirror relationships on the 

storage subsystem exceeds the number of 

mirror relationships that are allowed for the 

storage subsystem, reduce the number of mirror 

relationships to equal or less than the number of 

mirror relationships allowed. The maximum 

number of mirror relationships that are allowed is 

64. 

For step-by step instructions, see “Removing 

mirror relationships” on page 145 or the 

Subsystem Management window online help. 

The remote logical drive 

candidate is unresponsive and 

cannot be updated. 

The primary storage subsystem is 

unable to notify the secondary 

storage subsystem that its 

worldwide name (WWN) has 

changed. 

This might be the result of a 

controller in the primary storage 

subsystem being swapped or 

removed. Storage subsystem 

recovery procedures that result in 

configurations being reset and 

can also cause a change to the 

WWN. 

The first write operation to the 

primary logical drive causes the 

mirrored logical drive pair to 

transition into an Unsynchronized 

status. 

1.   Remove all the existing mirror relationships 

from the primary storage subsystem. For 

step-by-step instructions, see “Removing 

mirror relationships” on page 145 or the 

Subsystem Management window online help. 

2.   Re-establish the required mirror 

relationships. For step-by step instructions, 

see “Creating mirror relationships” on page 

139 or the Subsystem Management window 

online help. 

There is a long boot time for 

Windows 2000 hosts with 

secondary volumes mapped. 

A Windows 2000 host can take 

up to two hours to boot if all of 

the following statements are true: 

v   The storage management 

software is installed on the 

host. 

v   The Remote Volume Mirroring 

premium feature is enabled. 

v   One or more secondary 

volumes are mapped to the 

host. 

Do not map the secondary volumes to the host 

until they are needed for data access. If the host 

needs to be restarted, and the secondary 

volumes are mapped to that host, unmap the 

secondary volumes until the host has completed 

the restart. Remap the secondary volumes only 

when they are needed for data access. 

Because Windows does not allow mounting the 

file system as read-only, it is not recommended 

to mount the secondary logical drive to the 

Windows hosts.
 

 

164 IBM System Storage DS4000 Storage Manager Copy Services User’s Guide



General switch troubleshooting 

Table 16 describes some of the common switch-related problems that you might 

encounter when using the Remote Mirror Option. The troubleshooting information 

provided relates to switches that are supported for use with DS4000 Storage 

Manager. For a list of supported switches, see the IBM System Storage DS4000 

Storage Manager Version 9 Installation and Support Guide for your operating 

system. 

Information about the probable cause and how you can resolve for each problem is 

provided. If your problem is not addressed in this section, see the remaining 

sections in this chapter before contacting your IBM technical-support representative. 

 Table 16. General switch problems 

Problem Cause Resolution 

The host is unable to detect primary 

and secondary storage subsystems 

that are participating in remote logical 

drive mirroring. 

When two or more switches are 

cascaded together and have the 

same domain ID, host computers are 

unable to locate the target device. 

Each switch must have a unique 

domain ID when attempting to 

cascade two switches together. 

Change the domain ID of one or 

more of your switches, ensuring that 

each one is unique. A domain ID 

must be a unique number between 1 

and 239, which is used to identify the 

switch to a Fibre Channel fabric. For 

more information about setting 

domain IDs, see your switch 

documentation.
  

Inappropriate Fibre Channel fabric configurations 

Table 17 describes Fibre Channel fabric configuration problems that you might 

encounter after you have configured your storage subsystems and have activated 

and enabled the Remote Mirror Option. 

Information about the probable cause and how you can resolve each problem is 

provided. If your problem is not addressed in this section, see the remaining 

sections in this chapter before you contact your IBM technical-support 

representative. 

 Table 17. Fibre Channel fabric configuration problems 

Problem Cause Resolution 

The primary logical drive is 

unable to contact the Fibre 

Channel fabric. 

Usually, this error occurs because of a 

failed Fibre Channel fabric or because 

of cabling problems between the 

primary and secondary storage 

subsystems that are participating in a 

remote logical drive mirror. 

v   If the Fibre Channel fabric has failed, repair 

or replace the failed fabric. 

v   If the Fibre Channel fabric is operational, 

check the configuration cabling. The cable 

must not go through a hub or be connected 

directly between storage subsystems. 

Ensure that the cable is attached through a 

switch.

For step-by-step instructions to configure 

storage subsystems for remote logical drive 

mirroring, see Chapter 7, “Installing hardware 

and software for the Enhanced Remote 

Mirroring Option,” on page 113. 
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Table 17. Fibre Channel fabric configuration problems (continued) 

Problem Cause Resolution 

The primary logical drive is 

unable to communicate with 

the secondary storage 

subsystem. The primary 

storage subsystem can still 

communicate with the fabric. 

Usually, this error occurs when the 

secondary storage subsystem has lost 

power or when network problems exist 

between the secondary storage 

subsystem and the fabric. 

v   The secondary storage subsystem has no 

power. If the secondary storage subsystem 

has no power and is not operational, 

restore power to the storage subsystem. 

For information about powering on storage 

subsystems, see your hardware 

documentation. 

v   The secondary storage subsystem has 

power and is operational. Check the 

network status. Ensure that the secondary 

storage subsystem is visible on the 

network. Ensure that the cables are 

correctly connected.

For step-by-step instructions to configure 

storage subsystems for remote logical drive 

mirroring, see Chapter 7, “Installing hardware 

and software for the Enhanced Remote 

Mirroring Option,” on page 113.
  

Storage subsystem component failures 

Table 18 describes how physical or logical storage subsystem component failures 

can impact remote logical drive mirroring functionality. Information about the 

probable cause and how you can resolve each problem is provided. If your problem 

is not addressed in this section, see the remaining sections in this chapter before 

you contact your IBM technical-support representative. 

 Table 18. Storage subsystem component failures 

Problem Cause Resolution 

A FlashCopy logical drive that was 

created for a primary logical drive 

indicates that it has failed, after its 

role in the remote mirroring 

relationship has been changed to 

secondary. 

The base logical drive for the FlashCopy 

logical drive is a primary logical drive that is 

involved in a mirror relationship. A role reversal 

was performed, which demoted the primary 

logical drive to secondary logical drive status, 

resulting in a FlashCopy logical drive on the 

secondary logical drive. 

The base logical drive for a FlashCopy logical 

drive cannot be a candidate for the secondary 

logical drive role in a remote logical drive 

mirror. Therefore, the FlashCopy logical drive 

has failed. 

Perform a role reversal to 

promote the secondary logical 

drive to the primary logical drive 

role. After the role reversal is 

complete, the FlashCopy logical 

drive returns to Optimal status. 

For step-by-step instruction, see 

“Changing a secondary logical 

drive to a primary drive” on 

page 153 or the Subsystem 

Management window online 

help. 
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Table 18. Storage subsystem component failures (continued) 

Problem Cause Resolution 

The primary storage subsystem 

controller indicates that it has failed. 

Failure of the owning controller on the primary 

storage subsystem usually causes the 

associated multipath driver on the attached 

host computer to transfer ownership of the 

alternate controller on the primary storage 

subsystem. 

When this occurs, the alternate controller on 

the primary storage subsystem begins 

forwarding newly-written data to its peer on the 

secondary storage subsystem. The secondary 

controller takes ownership of the logical drive 

from its (secondary) peer controller. This is a 

reactive event; it occurs because of the arrival 

of a write request from the primary storage 

subsystem to the non-owning controller on the 

secondary storage subsystem. 

Allow the ownership transfer to 

complete. Operations continue 

in a normal fashion, with the 

alternate (usually the 

non-preferred) controller on the 

primary storage subsystem 

interacting with the alternate 

controller on the secondary 

storage subsystem. 

Failure of the non-owning 

controller on the primary storage 

subsystem has no direct impact 

on the status of the remote 

logical drive mirrors. 

The secondary storage subsystem 

controller indicates that it has failed. 

One of the following scenarios has occurred: 

v   Controller A on the secondary storage 

subsystem has failed while Controller A is 

the owner of the primary logical drive. 

v   Controller B on the secondary storage 

subsystem has failed while Controller B is 

the owner of the primary logical drive.

In both scenarios, the mirrored logical drive 

pair transitions to the Unsynchronized status. 

Restore the failed controller. For 

detailed recovery procedures, 

see the Recovery Guru. After 

the failed controller is restored, 

the primary storage subsystem 

automatically transitions to a 

Synchronizing status.

  

Remote Mirror critical events 

Critical major event log (MEL) events are generated when an error occurs that can 

affect data availability or that results in a degraded mode of operation. The storage 

management software responds by alerting the appropriate administrators by 

e-mail, SNMP trap, or other configured devices. Because administrative action is 

required to correct the problem, the storage subsystem generally enters a Needs 

Attention status. This causes the appropriate indications to be presented through 

the storage management software and an associated Recovery Guru procedure to 

be displayed when requested by the end user. 

Critical events table 

Table 19 provides a description of critical MEL events, with a brief explanation of 

what caused the event to be triggered, and how you can resolve the problem. If 

your problem is not addressed in this section, see the remaining sections in this 

chapter before you contact your IBM technical-support representative. 

 Table 19. Remote Mirror critical events 

Problem Cause Resolution 

Mirrored pair becomes 

unsynchronized. 

This event is logged when a remote 

logical drive mirror transitions to an 

Unsynchronized status, from either a 

Synchronizing or Optimal status. 

See the associated Recovery Guru 

message for specific recovery 

procedures. 
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Table 19. Remote Mirror critical events (continued) 

Problem Cause Resolution 

Dual-role conflict detected. This event is logged when a dual-role 

conflict is detected, and is usually the 

result of a role reversal. Because both 

sides of the mirrored logical drive pair 

are in the same primary or secondary 

logical drive role, both the primary and 

secondary storage subsystems will 

report this MEL event. 

See the associated Recovery Guru 

message for specific recovery 

procedures. 

Communication error with the 

secondary logical drive on the 

secondary remote storage subsystem. 

This event is logged when an 

interruption in the link that cannot be 

recovered by the firmware fibre 

channel device driver is detected. 

Error codes and recovery procedures 

assist you in finding the exact cause 

of the communication problem 

between storage subsystems that are 

participating in a mirror relationship. 

See the associated Recovery Guru 

message for specific recovery 

procedures. 

Worldwide name (WWN) change 

notification failed. 

This event is logged when a storage 

subsystem detects during startup 

processing that its WWN has 

changed. The WWN can only change 

if both controllers of the array are 

exchanged while the array is powered 

off. 

When the firmware detects this name 

change, it attempts to notify any 

remote storage subsystem that had 

previously been participating in a 

mirroring relationship with any logical 

drive on the array. 

See the associated Recovery Guru 

message for specific recovery 

procedures.

  

Problem resolution scenarios 

The following scenarios present resolutions or workarounds to potential problems 

when using Remote Mirroring: 

Problem: 

When you create a remote mirror of a FlashCopy base logical drive, the 

following scenario is possible. 

v   First, you have created a FlashCopy of a base logical drive and the base 

logical drive is receiving I/O. 

v   Second, you decide to create a remote mirror relationship, using the 

base logical drive as the primary logical drive in the remote mirror pair. 

v   As you create the remote mirror relationship, the FlashCopy logical drive 

fails.

Workaround: 

Quiesce I/O to the base logical drive while you are creating the remote 

mirror relationship. Alternatively, if the remote mirror relationship is created 

before you create the FlashCopy logical drive, this event will not occur. 

Problem: 

When alternately switching the roles of the logical drives in a remote 

mirrored relationship back and forth, Windows NT 4.0 and Windows 2000 
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might cache the file or files on the logical drive (disk) in memory and use 

the cached data instead of going out to the disk to get the data. This 

Windows operating system behavior might make the data look like it was 

not synchronized between logical drives in a remote mirror relationship. 

Resolution: 

Unmount the primary logical drive in the server before demoting it to the 

secondary role. In a Microsoft Windows environment, shut down the server 

that the primary logical drive is mapped to. Then, promote the secondary 

logical drive to the primary role and hot_add it to the appropriate server. 

 If the logical drive is of the Dynamic Disk type, you might be able to resolve 

the situation without shutting down the server. Perform the following steps: 

1.   In the server that has the primary logical drive, run the SMrepassist 

program in the DS4000 Storage Manager utility directory with the  -f 

option to flush the cached data to disk. 

2.   Promote the secondary logical drive and hot_add it to the appropriate 

server. 

3.   Before you promote the logical drive to the primary role in the original 

server, force a failure to the disk by running chkdsk on the disk. 

4.   Promote the logical drive to primary role in the original server and 

hot_add it. 

5.   You might have to reactivate the disk after it is hot_added to the server. 

If the server environment prevents the server from being restarted and the 

logical drive is of the Basic Disk type, perform the following steps: 

1.    In the server that has the primary logical drive, run the SMrepassist 

program in the DS4000 Storage Manager util directory with the -f 

option to flush the cached data to disk. 

2.   Use the DS4000 Storage Manager to remove the LUN mapping of the 

logical drive that had the primary role from its server (host computer). 

3.   Promote the secondary role LUN to the primary role and hot_add it in 

the appropriate server assuming that the LUN mapping is already 

defined for this server in the DS4000 Storage Subsystem. 

4.   Before you promote the logical drive to the primary role in the original 

server, run the Hot_add program or initiate a Scan for Hardware 

Changes task in the original server. This removes the logical drive from 

the available disks. In Windows 2000, you might see Unsafe Removal of 

Devices messages. 

5.   Use the DS4000 Storage Manager to add the LUN mapping of the 

logical drive that will be promoted to primary role to the original server 

(host computer). 

6.   Promote the logical drive to primary role and hot_add it in the original 

server. If you are unable to hot_add the logical drive or the data still 

seems to be mismatched, you must restart the server.
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Appendix  A.  Upgrading  controller  firmware  

The Remote Mirror Option is designed so that it is not necessary for the primary 

storage subsystem and the secondary storage subsystem to run exactly the same 

controller firmware level. All inter-controller operations (including those needed for 

propagation of newly-written data from the primary logical drive to the secondary 

logical drive) are implemented so as to support mixed firmware levels to the 

greatest extent possible. This allows firmware upgrades to be performed on both 

the primary and secondary storage subsystems without any loss of data. This is 

also true in the case that the controller firmware of the DS4000 Storage Subsystem 

at the primary site is version 06.10.xx.xx and the controller firmware of the one at 

the secondary site is version 05.xx.xx.xx and vice versa. The capabilities of the 

remote mirror depend on the version of the controller firmware installed at the 

DS4000 Storage Subsystem where the primary logical drive of remote mirror 

located. 

The key data availability operations, including promotion from the secondary logical 

drive to the primary logical drive, are allowed in mixed firmware levels. However, 

IBM Corporation strongly recommends upgrading firmware to the same levels. This 

will avoid restrictions in Remote Mirroring configuration operations due to a mixed 

primary and secondary DS4000 Storage Subsystem controller firmware 

environment. In a mixed firmware level environment, the following configuration 

requests are the only ones that can be completed: mirror deletion, changing the 

logical drive user label, and changing the synchronization priority. All other mirror 

configuration functions are not allowed. 

Important: Make sure that the DS4000 Storage Subsystem are in Optimal state 

before attempting controller firmware and NVSRAM download. Use the Recovery 

Guru in the Storage Manager subsystem window to correct any problems before the 

downloading the firmware. 

Upgrades to controller firmware should be completed in different ways depending 

on whether the primary controller currently has the Enhanced Remote Mirroring 

Option, or the earlier Remote Mirror Option installed. Follow the steps below, based 

on the remote mirroring version installed. 

Upgrading controller firmware with Enhanced Remote Mirroring 

installed 

This section describes the procedure that you must follow to upgrade controller 

firmware (version 05.2xx.xx or higher) if you are currently running the Enhanced 

Remote Mirroring Option on the primary controller. Performing firmware upgrades 

on storage subsystems that are participating in mirror relationships in sequence 

detailed in the steps below. 

1.   Download the firmware to the primary storage subsystem. 

2.   Download firmware to the secondary storage subsystem. 

The Enhanced Remote Mirroring controller firmware will cache the write I/Os during 

the unsynchronized period and will perform these cached writes only after the 

secondary DS4000 storage subsystem has completed the firmware download.

Note:  For more information about upgrading controller firmware, including detailed 

procedures, see the IBM DS4000 Storage Manager 9 Installation and 

Support Guide for your operating system.
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Upgrading controller firmware with the previous Remote Mirror Option 

installed 

This section describes the procedure that you must follow to upgrade controller 

firmware (version 05.2xx.xx or higher) if the storage subsystems are using the 

earlier version of the Remote Mirror Option. The sequence for firmware upgrades 

on storage subsystems that are participating in mirror relationships is detailed in the 

steps below. 

Important: By following this sequence, it is possible to avoid transitions of the 

mirrored logical drive pair to an Unsynchronized status, avoiding the need for a full 

resynchronization afterwards. The secondary array is offline for some interval while 

the firmware updates are performed (using the previous Remote Mirror 

functionality), which will cause the remote mirror status to change to 

Unsynchronized. This will require full resynchronization when the firmware 

download operation is complete. To minimize the resynchronization process, one 

has to stop I/Os to the primary DS4000 storage subsystem while upgrading the 

secondary storage subsystem. 

1.   Stop I/O to programs that operate on all the affected primary logical drives that 

are temporarily inactive. 

2.   Download firmware to the secondary storage subsystem. 

Resume program access to the primary logical drives. You can operate the 

primary storage subsystem with a different firmware level than the secondary 

storage subsystem for a time, but the inter-controller protocols for data 

replication do not support such interactions. 

3.   Download the firmware to the primary storage subsystem. 

Resynchronization of the primary and secondary storage subsystems will then be 

initiated. 
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Appendix  B.  Additional  DS4000  documentation  

The following tables present an overview of the IBM System Storage DS4000 

Storage Manager, Storage Subsystem, and Storage Expansion Enclosure product 

libraries, as well as other related documents. Each table lists documents that are 

included in the libraries and what common tasks they address. 

You can access the documents listed in these tables at both of the following Web 

sites: 

www.ibm.com/servers/storage/support/disk/ 

www.ibm.com/shop/publications/order/ 

DS4000 Storage Manager Version 9 library 

Table 20 associates each document in the DS4000 Storage Manager Version 9 

library with its related common user tasks.

 Table 20. DS4000 Storage Manager Version 9 titles by user tasks 

Title User tasks 

Planning Hardware 

installation 

Software 

installation 

Configuration Operation and 

administration 

Diagnosis and 

maintenance 

IBM System 

Storage DS4000 

Storage Manager 

Version 9 

Installation and 

Support Guide for 

Windows 

2000/Server 2003, 

NetWare, ESX 

Server, and Linux 

U U U 

IBM System 

Storage DS4000 

Storage Manager 

Version 9 

Installation and 

Support Guide for 

AIX, UNIX, Solaris 

and Linux on 

POWER  

U U U 

IBM System 

Storage DS4000 

Storage Manager 

Version 9 Copy 

Services User’s 

Guide 

U U U U 

IBM TotalStorage 

DS4000 Storage 

Manager Version 9 

Concepts Guide 

U U U U U U 
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Table 20. DS4000 Storage Manager Version 9 titles by user tasks (continued) 

Title User tasks 

Planning Hardware 

installation 

Software 

installation 

Configuration Operation and 

administration 

Diagnosis and 

maintenance 

IBM  System 

Storage DS4000 

Fibre Channel and 

Serial ATA Intermix 

Premium Feature 

Installation 

Overview 

U U U U 

  

DS4800 Storage Subsystem library 

Table 21 associates each document in the DS4800 Storage Subsystem library with 

its related common user tasks.

 Table 21. DS4800 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM System Storage 

DS4800 Storage 

Subsystem 

Installation, User’s 

and Maintenance 

Guide 

U U U U U 

IBM System Storage 

DS4800 Storage 

Subsystem 

Installation and 

Cabling Overview 

U 

IBM TotalStorage 

DS4800 Controller 

Cache Upgrade Kit 

Instructions 

U U U  
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DS4700 Storage Subsystem library 

Table 22 associates each document in the DS4700 Storage Subsystem library with 

its related common user tasks.

 Table 22. DS4700 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM System Storage 

DS4700 Storage 

Subsystem 

Installation, User’s 

and Maintenance 

Guide 

U U U U U 

IBM System Storage 

DS4700 Storage 

Subsystem Fibre 

Channel Cabling 

Guide 

U  
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DS4500 Storage Subsystem library 

Table 23 associates each document in the DS4500 (previously FAStT900) Storage 

Subsystem library with its related common user tasks.

 Table 23. DS4500 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM TotalStorage 

DS4500 Storage 

Subsystem 

Installation, User's, 

and Maintenance 

Guide 

U U U U U 

IBM TotalStorage 

DS4500 Storage 

Subsystem Cabling 

Instructions 

U U 

IBM TotalStorage 

DS4500 Rack 

Mounting 

Instructions 

U U  
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DS4400 Storage Subsystem library 

Table 24 associates each document in the DS4400 (previously FAStT700) Storage 

Subsystem library with its related common user tasks. 

 Table 24. DS4400 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM TotalStorage 

DS4400 Fibre 

Channel Storage 

Server User’s Guide 

U U U U U 

IBM TotalStorage 

DS4400 Fibre 

Channel Storage 

Server Installation 

and Support Guide 

U U U U 

IBM TotalStorage 

DS4400 Fibre 

Channel Cabling 

Instructions 

U U  
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DS4300 Storage Subsystem library 

Table 25 associates each document in the DS4300 (previously FAStT600) Storage 

Subsystem library with its related common user tasks.

 Table 25. DS4300 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM TotalStorage 

DS4300 Storage 

Subsystem 

Installation, User’s, 

and Maintenance 

Guide 

U U U U U 

IBM TotalStorage 

DS4300 Rack 

Mounting 

Instructions 

U U 

IBM TotalStorage 

DS4300 Storage 

Subsystem Cabling 

Instructions 

U U 

IBM TotalStorage 

DS4300 SCU  Base 

Upgrade Kit 

U U 

IBM TotalStorage 

DS4300 SCU  Turbo 

Upgrade Kit 

U U 

IBM TotalStorage 

DS4300 Turbo 

Models 6LU/6LX 

Upgrade Kit 

U U  
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DS4200 Express Storage Subsystem library 

Table 26 associates each document in the DS4200 Express Storage Subsystem 

library with its related common user tasks.

 Table 26. DS4200 Express Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM System Storage 

DS4200 Express 

Storage Subsystem 

Installation, User’s 

and Maintenance 

Guide 

U U U U U 

IBM System Storage 

DS4200 Express 

Storage Subsystem 

Cabling Guide 

U  
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DS4100 Storage Subsystem library 

Table 27 associates each document in the DS4100 (previously FAStT100) Storage 

Subsystem library with its related common user tasks.

 Table 27. DS4100 Storage Subsystem document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM TotalStorage 

DS4100 Storage 

Server Installation, 

User’s and 

Maintenance Guide 

U U U U U 

IBM TotalStorage 

DS4100 Storage 

Server Cabling 

Guide 

U  
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DS4000 Storage Expansion Enclosure documents 

Table 28 associates each of the following documents with its related common user 

tasks. 

 Table 28. DS4000 Storage Expansion Enclosure document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM System Storage 

DS4000 EXP810 

Storage Expansion 

Enclosure 

Installation, User’s, 

and Maintenance 

Guide 

U U U U U 

IBM TotalStorage 

DS4000 EXP700 

and EXP710 

Storage Expansion 

Enclosures 

Installation, User’s, 

and Maintenance 

Guide 

U U U U U 

IBM DS4000 

EXP500 Installation 

and User’s Guide 

U U U U U 

IBM System Storage 

DS4000 EXP420 

Storage Expansion 

Enclosure 

Installation, User’s, 

and Maintenance 

Guide 

U U U U U 

IBM System Storage 

DS4000 Hard Drive 

and Storage 

Expansion 

Enclosures 

Installation and 

Migration Guide 

U U  
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Other DS4000 and DS4000-related documents 

Table 29 associates each of the following documents with its related common user 

tasks. 

 Table 29. DS4000 and DS4000–related document titles by user tasks 

Title User Tasks 

Planning Hardware 

Installation 

Software 

Installation 

Configuration Operation and 

Administration 

Diagnosis and 

Maintenance 

IBM Safety 

Information 

U 

IBM TotalStorage 

DS4000 Hardware 

Maintenance Manual 

¹ 

U 

IBM System Storage 

DS4000 Problem 

Determination Guide 

U 

IBM Fibre Channel 

Planning and 

Integration: User’s 

Guide and Service 

Information 

U U U U 

IBM TotalStorage 

DS4000 FC2-133 

Host Bus Adapter 

Installation and 

User’s Guide 

U U 

IBM TotalStorage 

DS4000 FC2-133 

Dual Port Host Bus 

Adapter Installation 

and User’s Guide 

U U 

IBM Netfinity® Fibre 

Channel Cabling 

Instructions 

U 

IBM Fibre Channel 

SAN  Configuration 

Setup Guide 

U U U U 

Notes:  

1.   The IBM TotalStorage DS4000 Hardware Maintenance Manual does not contain maintenance information for the 

IBM System Storage DS4100, DS4200, DS4300, DS4500, DS4700, or DS4800 storage subsystems. You can find 

maintenance information for these products in the IBM System Storage DSx000 Storage Subsystem Installation, 

User's, and Maintenance Guide for the particular subsystem.
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Appendix  C.  Accessibility  

This section provides information about alternate keyboard navigation, which is a 

DS4000 Storage Manager accessibility feature. Accessibility features help a user 

who has a physical disability, such as restricted mobility or limited vision, to use 

software products successfully. 

By using the alternate keyboard operations that are described in this section, you 

can use keys or key combinations to perform Storage Manager tasks and initiate 

many menu actions that can also be done with a mouse. 

Note: In addition to the keyboard operations that are described in this section, the 

DS4000 Storage Manager 9.14, 9.15, and 9.16 software installation packages for 

Windows include a screen reader software interface. To enable the screen reader, 

select Custom Installation when using the installation wizard to install Storage 

Manager 9.14, 9.15, or 9.16 on a Windows host/management station. Then, in the 

Select Product Features window, select Java™ Access Bridge in addition to the 

other required host software components. 

Table 30 defines the keyboard operations that enable you to navigate, select, or 

activate user interface components. The following terms are used in the table: 

v   Navigate means to move the input focus from one user interface component to 

another. 

v   Select means to choose one or more components, typically for a subsequent 

action. 

v   Activate means to carry out the action of a particular component.

Note:  In general, navigation between components requires the following keys: 

v   Tab - Moves keyboard focus to the next component or to the first member 

of the next group of components 

v   Shift-Tab - Moves keyboard focus to the previous component or to the 

first component in the previous group of components 

v   Arrow keys - Move keyboard focus within the individual components of a 

group of components

 Table 30. DS4000 Storage Manager alternate keyboard operations 

Short cut Action 

F1 Open the Help. 

F10 Move keyboard focus to main menu bar and post first 

menu; use the arrow keys to navigate through the 

available options. 

Alt+F4 Close the management window. 

Alt+F6 Move keyboard focus between dialogs (non-modal) and 

between management windows. 
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Table 30. DS4000 Storage Manager alternate keyboard operations (continued) 

Short cut Action 

Alt+ underlined letter Access menu items, buttons, and other interface 

components by using the keys associated with the 

underlined letters. 

For the menu options, select the Alt + underlined letter 

combination to access a main menu, and then select the 

underlined letter to access the individual menu item. 

For other interface components, use the Alt + underlined 

letter combination. 

Ctrl+F1 Display or conceal a tool tip when keyboard focus is on 

the toolbar. 

Spacebar Select an item or activate a hyperlink. 

Ctrl+Spacebar 

(Contiguous/Non-contiguous) 

AMW Logical/Physical View 

Select multiple drives in the Physical View. 

To select multiple drives, select one drive by pressing 

Spacebar, and then press Tab to switch focus to the next 

drive you want to select; press Ctrl+Spacebar to select 

the drive. 

If you press Spacebar alone when multiple drives are 

selected then all selections are removed. 

Use the Ctrl+Spacebar combination to deselect a drive 

when multiple drives are selected. 

This behavior is the same for contiguous and 

non-contiguous selection of drives. 

End, Page Down Move keyboard focus to the last item in the list. 

Esc Close the current dialog (does not require keyboard 

focus). 

Home, Page Up Move keyboard focus to the first item in the list. 

Shift+Tab Move keyboard focus through components in the reverse 

direction. 

Ctrl+Tab Move keyboard focus from a table to the next user 

interface component. 

Tab Navigate keyboard focus between components or select 

a hyperlink. 

Down arrow Move keyboard focus down one item in the list. 

Left arrow Move keyboard focus to the left. 

Right arrow Move keyboard focus to the right. 

Up arrow Move keyboard focus up one item in the list.
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Notices  

This publication was developed for products and services offered in the U.S.A. 

IBM Corporation may not offer the products, services, or features discussed in this 

document in other countries. Consult your local IBM representative for information 

on the products and services currently available in your area. Any reference to an 

IBM product, program, or service is not intended to state or imply that only that IBM 

product, program, or service may be used. Any functionally equivalent product, 

program, or service that does not infringe any IBM intellectual property right may be 

used instead. However, it is the user’s responsibility to evaluate and verify the 

operation of any non-IBM product, program, or service. 

IBM Corporation may have patents or pending patent applications covering subject 

matter described in this document. The furnishing of this document does not give 

you any license to these patents. You can send license inquiries, in writing, to: 

   IBM Director of Licensing 

   IBM Corporation 

   North Castle Drive 

   Armonk, NY 10504-1785 

   U.S.A.

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS 

PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS 

OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 

OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A 

PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or 

implied warranties in certain transactions, therefore, this statement may not apply to 

you. 

This information could include technical inaccuracies or typographical errors. 

Changes are periodically made to the information herein; these changes will be 

incorporated in new editions of the publication. IBM Corporation may make 

improvements and/or changes in the product(s) and/or the program(s) described in 

this publication at any time without notice. 

Any references in this publication to non-IBM Web sites are provided for 

convenience only and do not in any manner serve as an endorsement of those 

Web sites. The materials at those Web sites are not part of the materials for this 

IBM product, and use of those Web sites is at your own risk. 

IBM Corporation may use or distribute any of the information you supply in any way 

it believes appropriate without incurring any obligation to you. 

Trademarks  

The following terms are trademarks of International Business Machines Corporation 

in the United States, other countries, or both: 

 IBM PC/XT™ 

AIX PS/2® 

AT® System p 

DB2 ServerProven® 

e-server logo System Storage 
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FlashCopy TotalStorage 

Intellistation System x 

Netfinity XT™

  

Intel is a trademark of Intel Corporation in the United States, other countries, or 

both. 

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in 

the United States, other countries, or both. 

Java and all Java-based trademarks and logos are trademarks or registered 

trademarks of Sun Microsystems, Inc. in the United States, other countries, or both. 

QLogic® and SANSurfer® are registered trademarks of QLogic Corporation. 

UNIX is a registered trademark of The Open Group in the United States and other 

countries. 

Linux is a trademark of Linus Torvalds in the United States, other countries, or both. 

Other company, product, or service names may be the trademarks or service marks 

of others. 

Important notes 

Processor speeds indicate the internal clock speed of the microprocessor; other 

factors also affect application performance. 

CD-ROM drive speeds list the variable read rate. Actual speeds vary and are often 

less than the maximum possible. 

When referring to processor storage, real and virtual storage, or channel volume, 

KB stands for approximately 1000 bytes, MB stands for approximately 1 000 000 

bytes, and GB stands for approximately 1 000 000 000 bytes. 

When referring to hard disk drive capacity or communications volume, MB stands 

for 1 000 000 bytes, and GB stands for 1 000 000 000 bytes. Total user-accessible 

capacity may vary depending on operating environments. 

Maximum internal hard disk drive capacities assume the replacement of any 

standard hard disk drives and population of all hard disk drive bays with the largest 

currently supported drives available from IBM Corporation. 

Maximum memory may require replacement of the standard memory with an 

optional memory module. 

IBM Corporation makes no representation or warranties regarding non-IBM products 

and services that are ServerProven, including but not limited to the implied 

warranties of merchantability and fitness for a particular purpose. These products 

are offered and warranted solely by third parties. 

IBM Corporation makes no representations or warranties with respect to non-IBM 

products. Support (if any) for the non-IBM products is provided by the third party, 

not IBM Corporation. 
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Some software may differ from its retail version (if available), and may not include 

user manuals or all program functionality. 
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Glossary  

This glossary provides definitions for the 

terminology and abbreviations used in IBM 

System Storage DS4000 publications. 

If you do not find the term you are looking for, see 

the IBM Glossary of Computing Terms located at 

the following Web site: 

www.ibm.com/ibm/terminology 

This glossary also includes terms and definitions 

from: 

v   Information Technology Vocabulary by 

Subcommittee 1, Joint Technical Committee 1, 

of the International Organization for 

Standardization and the International 

Electrotechnical Commission (ISO/IEC 

JTC1/SC1). Definitions are identified by the 

symbol (I) after the definition; definitions taken 

from draft international standards, committee 

drafts, and working papers by ISO/IEC 

JTC1/SC1 are identified by the symbol (T) after 

the definition, indicating that final agreement 

has not yet been reached among the 

participating National Bodies of SC1. 

v   IBM Glossary of Computing Terms. New York: 

McGraw-Hill, 1994.

The following cross-reference conventions are 

used in this glossary: 

See Refers you to (a) a term that is the 

expanded form of an abbreviation or 

acronym, or (b) a synonym or more 

preferred term. 

See also 

Refers you to a related term.

Abstract Windowing Toolkit (AWT).  A Java graphical 

user interface (GUI). 

accelerated graphics port (AGP).  A bus specification 

that gives low-cost 3D graphics cards faster access to 

main memory on personal computers than the usual 

peripheral component interconnect (PCI) bus. AGP 

reduces the overall cost of creating high-end graphics 

subsystems by using existing system memory. 

access volume.  A special logical drive that allows the 

host-agent to communicate with the controllers in the 

storage subsystem. 

adapter.  A printed circuit assembly that transmits user 

data input/output (I/O) between the internal bus of the 

host system and the external fibre channel (FC) link and 

vice versa. Also called an I/O adapter, host adapter, or 

FC adapter. 

advanced technology (AT) bus architecture.  A bus 

standard for IBM compatibles. It extends the XT bus 

architecture to 16 bits and also allows for bus 

mastering, although only the first 16 MB of main 

memory are available for direct access. 

agent.  A server program that receives virtual 

connections from the network manager (the client 

program) in a Simple Network Management 

Protocol-Transmission Control Protocol/Internet Protocol 

(SNMP-TCP/IP) network-managing environment. 

AGP.   See accelerated graphics port. 

AL_PA.   See arbitrated loop physical address. 

arbitrated loop.  One of three existing fibre channel 

topologies, in which 2 - 126 ports are interconnected 

serially in a single loop circuit. Access to the Fibre 

Channel-Arbitrated Loop (FC-AL) is controlled by an 

arbitration scheme. The FC-AL topology supports all 

classes of service and guarantees in-order delivery of 

FC frames when the originator and responder are on 

the same FC-AL. The default topology for the disk array 

is arbitrated loop. An arbitrated loop is sometimes 

referred to as a Stealth Mode. 

arbitrated loop physical address (AL_PA).  An 8-bit 

value that is used to uniquely identify an individual port 

within a loop. A loop can have one or more AL_PAs. 

array.  A collection of fibre channel or SATA hard drives 

that are logically grouped together. All the drives in the 

array are assigned the same RAID level. An array is 

sometimes referred to as a ″RAID set.″ See also 

redundant array of independent disks (RAID), RAID 

level. 

asynchronous write mode.  In remote mirroring, an 

option that allows the primary controller to return a write 

I/O request completion to the host server before data 

has been successfully written by the secondary 

controller. See also synchronous write mode, remote 

mirroring, Global Copy,Global Mirroring. 

AT.  See advanced technology (AT) bus architecture. 

ATA.  See AT-attached. 

AT-attached.  Peripheral devices that are compatible 

with the original IBM AT computer standard in which 

signals on a 40-pin AT-attached (ATA) ribbon cable 

followed the timings and constraints of the Industry 

Standard Architecture (ISA) system bus on the IBM PC 

AT computer. Equivalent to integrated drive electronics 

(IDE). 
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auto-volume transfer/auto-disk transfer (AVT/ADT).  

A function that provides automatic failover in case of 

controller failure on a storage subsystem. 

AVT/ADT.   See auto-volume transfer/auto-disk transfer. 

AWT.  See Abstract Windowing Toolkit. 

basic input/output system (BIOS).  The personal 

computer code that controls basic hardware operations, 

such as interactions with diskette drives, hard disk 

drives, and the keyboard. 

BIOS.   See basic input/output system. 

BOOTP.   See bootstrap protocol. 

bootstrap protocol (BOOTP).  In Transmission Control 

Protocol/Internet Protocol (TCP/IP) networking, an 

alternative protocol by which a diskless machine can 

obtain its Internet Protocol (IP) address and such 

configuration information as IP addresses of various 

servers from a BOOTP server. 

bridge.  A storage area network (SAN) device that 

provides physical and transport conversion, such as 

fibre channel to small computer system interface (SCSI) 

bridge. 

bridge group.  A bridge and the collection of devices 

connected to it. 

broadcast.  The simultaneous transmission of data to 

more than one destination. 

cathode ray tube (CRT).  A display device in which 

controlled electron beams are used to display 

alphanumeric or graphical data on an 

electroluminescent screen. 

client.  A computer system or process that requests a 

service of another computer system or process that is 

typically referred to as a server. Multiple clients can 

share access to a common server. 

command.  A statement used to initiate an action or 

start a service. A command consists of the command 

name abbreviation, and its parameters and flags if 

applicable. A command can be issued by typing it on a 

command line or selecting it from a menu. 

community string.  The name of a community 

contained in each Simple Network Management 

Protocol (SNMP) message. 

concurrent download.  A method of downloading and 

installing firmware that does not require the user to stop 

I/O to the controllers during the process. 

CRC.   See cyclic redundancy check. 

CRT.  See cathode ray tube. 

CRU.   See customer replaceable unit. 

customer replaceable unit (CRU).  An assembly or 

part that a customer can replace in its entirety when any 

of its components fail. Contrast with field replaceable 

unit (FRU). 

cyclic redundancy check (CRC).   (1) A redundancy 

check in which the check key is generated by a cyclic 

algorithm. (2) An error detection technique performed at 

both the sending and receiving stations. 

dac.  See disk array controller. 

dar.  See disk array router. 

DASD.   See direct access storage device. 

data striping.  See striping. 

default host group.  A logical collection of discovered 

host ports, defined host computers, and defined host 

groups in the storage-partition topology that fulfill the 

following requirements: 

v   Are not involved in specific logical drive-to-LUN 

mappings 

v   Share access to logical drives with default logical 

drive-to-LUN mappings

device type.  Identifier used to place devices in the 

physical map, such as the switch, hub, or storage. 

DHCP.   See Dynamic Host Configuration Protocol. 

direct access storage device (DASD).   A device in 

which access time is effectively independent of the 

location of the data. Information is entered and retrieved 

without reference to previously accessed data. (For 

example, a disk drive is a DASD, in contrast with a tape 

drive, which stores data as a linear sequence.) DASDs 

include both fixed and removable storage devices. 

direct memory access (DMA).   The transfer of data 

between memory and an input/output (I/O) device 

without processor intervention. 

disk array controller (dac).  A disk array controller 

device that represents the two controllers of an array. 

See also disk array router. 

disk array router (dar).  A disk array router that 

represents an entire array, including current and 

deferred paths to all logical unit numbers (LUNs) (hdisks 

on AIX operating system). See also disk array controller. 

DMA.   See direct memory access. 

domain.  The most significant byte in the node port 

(N_port) identifier for the fibre channel (FC) device. It is 

not used in the fibre channel-small computer system 

interface (FC-SCSI) hardware path ID. It is required to 

be the same for all SCSI targets logically connected to 

an FC adapter. 

DRAM.   See dynamic random access memory. 

 

190 IBM System Storage DS4000 Storage Manager Copy Services User’s Guide



Dynamic Host Configuration Protocol (DHCP).  A 

protocol defined by the Internet Engineering Task Force 

that is used for dynamically assigning Internet Protocol 

(IP) addresses to computers in a network. 

dynamic random access memory (DRAM).   A 

storage in which the cells require repetitive application 

of control signals to retain stored data. 

ECC.   See error correction coding. 

EEPROM.   See electrically erasable programmable 

read-only memory. 

EISA.  See Extended Industry Standard Architecture. 

electrically erasable programmable read-only 

memory (EEPROM).  A type of memory chip which can 

retain its contents without consistent electrical power. 

Unlike the PROM which can be programmed only once, 

the EEPROM can be erased electrically. Because it can 

only be reprogrammed a limited number of times before 

it wears out, it is appropriate for storing small amounts 

of data that are changed infrequently. 

electrostatic discharge (ESD).  The flow of current 

that results when objects that have a static charge 

come into close enough proximity to discharge. 

environmental service module (ESM) canister.  A 

component in a storage expansion enclosure that 

monitors the environmental condition of the components 

in that enclosure. Not all storage subsystems have ESM 

canisters. 

E_port.  See expansion port. 

error correction coding (ECC).  A method for 

encoding data so that transmission errors can be 

detected and corrected by examining the data on the 

receiving end. Most ECCs are characterized by the 

maximum number of errors they can detect and correct. 

ESD.  See electrostatic discharge. 

ESM canister.  See environmental service module 

canister. 

EXP.  See storage expansion enclosure. 

expansion port (E_port).  A port that connects the 

switches for two fabrics. 

Extended Industry Standard Architecture (EISA).  A 

bus standard for IBM compatibles that extends the 

Industry Standard Architecture (ISA) bus architecture to 

32 bits and allows more than one central processing 

unit (CPU) to share the bus. See also Industry Standard 

Architecture. 

fabric.  A Fibre Channel entity which interconnects and 

facilitates logins of N_ports attached to it. The fabric is 

responsible for routing frames between source and 

destination N_ports using address information in the 

frame header. A fabric can be as simple as a 

point-to-point channel between two N-ports, or as 

complex as a frame-routing switch that provides multiple 

and redundant internal pathways within the fabric 

between F_ports. 

fabric port (F_port).  In a fabric, an access point for 

connecting a user’s N_port. An F_port facilitates N_port 

logins to the fabric from nodes connected to the fabric. 

An F_port is addressable by the N_port connected to it. 

See also fabric. 

FAStT MSJ.  See FAStT Management Suite Java. 

FAStT Management Suite Java (FAStT MSJ).  A 

diagnostic and configuration utility that can be used on 

Linux, Microsoft Windows, and Novell NetWare host 

systems. In Linux, it is also used with the QLRemote 

agent to define preferred and non-preferred paths for 

logical drives. 

FC.  See fibre channel. 

FC-AL.  See arbitrated loop. 

feature enable identifier.  A unique identifier for the 

storage subsystem, which is used in the process of 

generating a premium feature key. See also premium 

feature key. 

fibre channel (FC).  A set of standards for a serial 

input/output (I/O) bus capable of transferring data 

between two ports at up to 100 Mbps, with standards 

proposals to go to higher speeds. FC supports 

point-to-point, arbitrated loop, and switched topologies. 

Fibre Channel-Arbitrated Loop (FC-AL).  See 

arbitrated loop. 

Fibre Channel Protocol (FCP) for small computer 

system interface (SCSI).  A high-level fibre channel 

mapping layer (FC-4) that uses lower-level fibre channel 

(FC-PH) services to transmit SCSI commands, data, 

and status information between a SCSI initiator and a 

SCSI target across the FC link by using FC frame and 

sequence formats. 

field replaceable unit (FRU).  An assembly that is 

replaced in its entirety when any one of its components 

fails. In some cases, a field replaceable unit might 

contain other field replaceable units. Contrast with 

customer replaceable unit (CRU). 

FlashCopy.  A premium feature for DS4000 that can 

make an instantaneous copy of the data in a volume. 

F_port.  See fabric port. 

FRU.  See field replaceable unit. 

GBIC.   See gigabit interface converter 

gigabit interface converter (GBIC).   A transceiver that 

performs serial, optical-to-electrical, and 
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electrical-to-optical signal conversions for high-speed 

networking. A GBIC can be hot swapped. See also 

small form-factor pluggable. 

Global Copy.  Refers to a remote logical drive mirror 

pair that is set up using asynchronous write mode 

without the write consistency group option. This is also 

referred to as ″Asynchronous Mirroring without 

Consistency Group.″ Global Copy does not ensure that 

write requests to multiple primary logical drives are 

carried out in the same order on the secondary logical 

drives as they are on the primary logical drives. If it is 

critical that writes to the primary logical drives are 

carried out in the same order in the appropriate 

secondary logical drives, Global Mirroring should be 

used instead of Global Copy. See also asynchronous 

write mode, Global Mirroring, remote mirroring, Metro 

Mirroring. 

Global Mirroring.  Refers to a remote logical drive 

mirror pair that is set up using asynchronous write mode 

with the write consistency group option. This is also 

referred to as ″Asynchronous Mirroring with Consistency 

Group.″ Global Mirroring ensures that write requests to 

multiple primary logical drives are carried out in the 

same order on the secondary logical drives as they are 

on the primary logical drives, preventing data on the 

secondary logical drives from becoming inconsistent 

with the data on the primary logical drives. See also 

asynchronous write mode, Global Copy, remote 

mirroring, Metro Mirroring. 

graphical user interface (GUI).  A type of computer 

interface that presents a visual metaphor of a real-world 

scene, often of a desktop, by combining high-resolution 

graphics, pointing devices, menu bars and other menus, 

overlapping windows, icons, and the object-action 

relationship. 

GUI.   See graphical user interface. 

HBA.   See host bus adapter. 

hdisk.  An AIX term representing a logical unit number 

(LUN) on an array. 

host.  A system that is directly attached to the storage 

subsystem through a fibre channel input/output (I/O) 

path. This system is used to serve data (typically in the 

form of files) from the storage subsystem. A system can 

be both a storage management station and a host 

simultaneously. 

host bus adapter (HBA).   An interface between the 

fibre channel network and a workstation or server. 

host computer.  See host. 

host group.  An entity in the storage partition topology 

that defines a logical collection of host computers that 

require shared access to one or more logical drives. 

host port.  Ports that physically reside on the host 

adapters and are automatically discovered by the 

DS4000 Storage Manager software. To give a host 

computer access to a partition, its associated host ports 

must be defined. 

hot swap.  To replace a hardware component without 

turning off the system. 

hub.  In a network, a point at which circuits are either 

connected or switched. For example, in a star network, 

the hub is the central node; in a star/ring network, it is 

the location of wiring concentrators. 

IBMSAN  driver.  The device driver that is used in a 

Novell NetWare environment to provide multipath 

input/output (I/O) support to the storage controller. 

IC.   See integrated circuit. 

IDE.  See integrated drive electronics. 

in-band.  Transmission of management protocol over 

the fibre channel transport. 

Industry Standard Architecture (ISA).  Unofficial 

name for the bus architecture of the IBM PC/XT 

personal computer. This bus design included expansion 

slots for plugging in various adapter boards. Early 

versions had an 8-bit data path, later expanded to 16 

bits. The ″Extended Industry Standard Architecture″ 

(EISA) further expanded the data path to 32 bits. See 

also Extended Industry Standard Architecture. 

initial program load (IPL).  The initialization procedure 

that causes an operating system to commence 

operation. Also referred to as a system restart, system 

startup, and boot. 

integrated circuit (IC).  A microelectronic 

semiconductor device that consists of many 

interconnected transistors and other components. ICs 

are constructed on a small rectangle cut from a silicon 

crystal or other semiconductor material. The small size 

of these circuits allows high speed, low power 

dissipation, and reduced manufacturing cost compared 

with board-level integration. Also known as a chip. 

integrated drive electronics (IDE).  A disk drive 

interface based on the 16-bit IBM personal computer 

Industry Standard Architecture (ISA) in which the 

controller electronics reside on the drive itself, 

eliminating the need for a separate adapter card. Also 

known as an Advanced Technology Attachment 

Interface (ATA). 

Internet Protocol (IP).  A protocol that routes data 

through a network or interconnected networks. IP acts 

as an intermediary between the higher protocol layers 

and the physical network. 

 

192 IBM System Storage DS4000 Storage Manager Copy Services User’s Guide



Internet Protocol (IP) address.  The unique 32-bit 

address that specifies the location of each device or 

workstation on the Internet. For example, 9.67.97.103 is 

an IP address. 

interrupt request (IRQ).  A type of input found on 

many processors that causes the processor to suspend 

normal processing temporarily and start running an 

interrupt handler routine. Some processors have several 

interrupt request inputs that allow different priority 

interrupts. 

IP.  See Internet Protocol. 

IPL.  See initial program load. 

IRQ.   See interrupt request. 

ISA.  See Industry Standard Architecture. 

Java Runtime Environment (JRE).  A subset of the 

Java Development Kit (JDK) for end users and 

developers who want to redistribute the Java Runtime 

Environment (JRE). The JRE consists of the Java virtual 

machine, the Java Core Classes, and supporting files. 

JRE.  See Java Runtime Environment. 

label.  A discovered or user entered property value that 

is displayed underneath each device in the Physical and 

Data Path maps. 

LAN.   See local area network. 

LBA.   See logical block address. 

local area network (LAN).  A computer network 

located on a user’s premises within a limited geographic 

area. 

logical block address (LBA).  The address of a logical 

block. Logical block addresses are typically used in 

hosts’ I/O commands. The SCSI disk command 

protocol, for example, uses logical block addresses. 

logical partition (LPAR).  (1) A subset of a single 

system that contains resources (processors, memory, 

and input/output devices). A logical partition operates as 

an independent system. If hardware requirements are 

met, multiple logical partitions can exist within a system. 

(2) A fixed-size portion of a logical volume. A logical 

partition is the same size as the physical partitions in its 

volume group. Unless the logical volume of which it is a 

part is mirrored, each logical partition corresponds to, 

and its contents are stored on, a single physical 

partition. (3) One to three physical partitions (copies). 

The number of logical partitions within a logical volume 

is variable. 

logical unit number (LUN).  An identifier used on a 

small computer system interface (SCSI) bus to 

distinguish among up to eight devices (logical units) with 

the same SCSI ID. 

loop address.  The unique ID of a node in fibre 

channel loop topology sometimes referred to as a loop 

ID. 

loop group.  A collection of storage area network 

(SAN) devices that are interconnected serially in a 

single loop circuit. 

loop port.  A node port (N_port) or fabric port (F_port) 

that supports arbitrated loop functions associated with 

an arbitrated loop topology. 

LPAR.  See logical partition. 

LUN.  See logical unit number. 

MAC.   See medium access control. 

management information base (MIB).  The 

information that is on an agent. It is an abstraction of 

configuration and status information. 

man  pages.  In UNIX-based operating systems, online 

documentation for operating system commands, 

subroutines, system calls, file formats, special files, 

stand-alone utilities, and miscellaneous facilities. 

Invoked by the man  command. 

MCA.   See micro channel architecture. 

media scan.  A media scan is a background process 

that runs on all logical drives in the storage subsystem 

for which it has been enabled, providing error detection 

on the drive media. The media scan process scans all 

logical drive data to verify that it can be accessed, and 

optionally scans the logical drive redundancy 

information. 

medium access control (MAC).  In local area 

networks (LANs), the sublayer of the data link control 

layer that supports medium-dependent functions and 

uses the services of the physical layer to provide 

services to the logical link control sublayer. The MAC 

sublayer includes the method of determining when a 

device has access to the transmission medium. 

Metro Mirroring.  This term is used to refer to a 

remote logical drive mirror pair which is set up with 

synchronous write mode. See also remote mirroring, 

Global Mirroring. 

MIB.  See management information base. 

micro channel architecture (MCA).   Hardware that is 

used for PS/2 Model 50 computers and above to 

provide better growth potential and performance 

characteristics when compared with the original 

personal computer design. 

Microsoft Cluster Server (MSCS).  MSCS, a feature 

of Windows NT Server (Enterprise Edition), supports the 

connection of two servers into a cluster for higher 

availability and easier manageability. MSCS can 

automatically detect and recover from server or 
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application failures. It can also be used to balance 

server workload and provide for planned maintenance. 

mini hub.  An interface card or port device that 

receives shortwave fiber channel GBICs or SFPs. 

These devices enable redundant fibre channel 

connections from the host computers, either directly or 

through a fibre channel switch or managed hub, over 

optical fiber cables to the DS4000 Storage Server 

controllers. Each DS4000 controller is responsible for 

two mini hubs. Each mini hub has two ports. Four host 

ports (two on each controller) provide a cluster solution 

without use of a switch. Two host-side mini hubs are 

shipped as standard. See also host port, gigabit 

interface converter (GBIC), small form-factor pluggable 

(SFP). 

mirroring.  A fault-tolerance technique in which 

information on a hard disk is duplicated on additional 

hard disks. See also remote mirroring. 

model.  The model identification that is assigned to a 

device by its manufacturer. 

MSCS.   See Microsoft Cluster Server. 

network management station (NMS).  In the Simple 

Network Management Protocol (SNMP), a station that 

runs management application programs that monitor 

and control network elements. 

NMI.   See non-maskable interrupt. 

NMS.   See network management station. 

non-maskable interrupt (NMI).  A hardware interrupt 

that another service request cannot overrule (mask). An 

NMI bypasses and takes priority over interrupt requests 

generated by software, the keyboard, and other such 

devices and is issued to the microprocessor only in 

disastrous circumstances, such as severe memory 

errors or impending power failures. 

node.  A physical device that allows for the 

transmission of data within a network. 

node port (N_port).  A fibre channel defined hardware 

entity that performs data communications over the fibre 

channel link. It is identifiable by a unique worldwide 

name. It can act as an originator or a responder. 

nonvolatile storage (NVS).  A storage device whose 

contents are not lost when power is cut off. 

N_port.  See node port. 

NVS.  See nonvolatile storage. 

NVSRAM.   Nonvolatile storage random access 

memory. See nonvolatile storage. 

Object Data Manager (ODM).   An AIX proprietary 

storage mechanism for ASCII stanza files that are 

edited as part of configuring a drive into the kernel. 

ODM.   See Object Data Manager. 

out-of-band.  Transmission of management protocols 

outside of the fibre channel network, typically over 

Ethernet. 

partitioning.  See storage partition. 

parity check.  (1) A test to determine whether the 

number of ones (or zeros) in an array of binary digits is 

odd or even. (2) A mathematical operation on the 

numerical representation of the information 

communicated between two pieces. For example, if 

parity is odd, any character represented by an even 

number has a bit added to it, making it odd, and an 

information receiver checks that each unit of information 

has an odd value. 

PCI local bus.  See peripheral component interconnect 

local bus. 

PDF.  See portable document format. 

performance events.  Events related to thresholds set 

on storage area network (SAN) performance. 

peripheral component interconnect local bus (PCI  

local bus).  A local bus for PCs, from Intel Corporation, 

that provides a high-speed data path between the CPU 

and up to 10 peripherals (video, disk, network, and so 

on). The PCI bus coexists in the PC with the Industry 

Standard Architecture (ISA) or Extended Industry 

Standard Architecture (EISA) bus. ISA and EISA boards 

plug into an IA or EISA slot, while high-speed PCI 

controllers plug into a PCI slot. See also Industry 

Standard Architecture, Extended Industry Standard 

Architecture. 

polling delay.  The time in seconds between 

successive discovery processes during which discovery 

is inactive. 

port.  A part of the system unit or remote controller to 

which cables for external devices (such as display 

stations, terminals, printers, switches, or external 

storage units) are attached. The port is an access point 

for data entry or exit. A device can contain one or more 

ports. 

portable document format (PDF).  A standard 

specified by Adobe Systems, Incorporated, for the 

electronic distribution of documents. PDF files are 

compact; can be distributed globally by e-mail, the Web, 

intranets, or CD-ROM; and can be viewed with the 

Acrobat Reader, which is software from Adobe Systems 

that can be downloaded at no cost from the Adobe 

Systems home page. 

premium feature key.  A file that the storage 

subsystem controller uses to enable an authorized 

premium feature. The file contains the feature enable 

identifier of the storage subsystem for which the 
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premium feature is authorized, and data about the 

premium feature. See also feature enable identifier. 

private loop.  A freestanding arbitrated loop with no 

fabric attachment. See also arbitrated loop. 

program temporary fix (PTF).  A temporary solution or 

bypass of a problem diagnosed by IBM Corporation in a 

current unaltered release of the program. 

PTF.  See program temporary fix. 

RAID.   See redundant array of independent disks 

(RAID). 

RAID  level.  An array’s RAID level is a number that 

refers to the method used to achieve redundancy and 

fault tolerance in the array. See also array, redundant 

array of independent disks (RAID). 

RAID  set.  See array. 

RAM.   See random-access memory. 

random-access memory (RAM).   A temporary storage 

location in which the central processing unit (CPU) 

stores and executes its processes. Contrast with DASD. 

RDAC.   See redundant disk array controller. 

read-only memory (ROM).   Memory in which stored 

data cannot be changed by the user except under 

special conditions. 

recoverable virtual shared disk (RVSD).  A virtual 

shared disk on a server node configured to provide 

continuous access to data and file systems in a cluster. 

redundant array of independent disks (RAID).   A 

collection of disk drives (array) that appears as a single 

volume to the server, which is fault tolerant through an 

assigned method of data striping, mirroring, or parity 

checking. Each array is assigned a RAID level, which is 

a specific number that refers to the method used to 

achieve redundancy and fault tolerance. See also array, 

parity check, mirroring, RAID level, striping. 

redundant disk array controller (RDAC).   (1) In 

hardware, a redundant set of controllers (either 

active/passive or active/active). (2) In software, a layer 

that manages the input/output (I/O) through the active 

controller during normal operation and transparently 

reroutes I/Os to the other controller in the redundant set 

if a controller or I/O path fails. 

remote mirroring.  Online, real-time replication of data 

between storage subsystems that are maintained on 

separate media. The Enhanced Remote Mirror Option is 

a DS4000 premium feature that provides support for 

remote mirroring. See also Global Mirroring, Metro 

Mirroring. 

ROM.   See read-only memory. 

router.  A computer that determines the path of 

network traffic flow. The path selection is made from 

several paths based on information obtained from 

specific protocols, algorithms that attempt to identify the 

shortest or best path, and other criteria such as metrics 

or protocol-specific destination addresses. 

RVSD.  See recoverable virtual shared disk. 

SAI.  See Storage Array Identifier. 

SA Identifier.  See Storage Array Identifier. 

SAN.   See storage area network. 

SATA.  See serial ATA. 

scope.  Defines a group of controllers by their Internet 

Protocol (IP) addresses. A scope must be created and 

defined so that dynamic IP addresses can be assigned 

to controllers on the network. 

SCSI.  See small computer system interface. 

segmented loop port (SL_port).  A port that allows 

division of a fibre channel private loop into multiple 

segments. Each segment can pass frames around as 

an independent loop and can connect through the fabric 

to other segments of the same loop. 

sense data.  (1) Data sent with a negative response, 

indicating the reason for the response. (2) Data 

describing an I/O error. Sense data is presented to a 

host system in response to a sense request command. 

serial ATA.  The standard for a high-speed alternative 

to small computer system interface (SCSI) hard drives. 

The SATA-1 standard is equivalent in performance to a 

10 000 RPM SCSI drive. 

serial storage architecture (SSA).  An interface 

specification from IBM Corporation in which devices are 

arranged in a ring topology. SSA, which is compatible 

with small computer system interface (SCSI) devices, 

allows full-duplex packet multiplexed serial data 

transfers at rates of 20 Mbps in each direction. 

server.  A functional hardware and software unit that 

delivers shared resources to workstation client units on 

a computer network. 

server/device events.  Events that occur on the server 

or a designated device that meet criteria that the user 

sets. 

SFP.  See small form-factor pluggable. 

Simple Network Management Protocol (SNMP).   In 

the Internet suite of protocols, a network management 

protocol that is used to monitor routers and attached 

networks. SNMP is an application layer protocol. 

Information on devices managed is defined and stored 

in the application’s Management Information Base 

(MIB). 
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SL_port.  See segmented loop port. 

SMagent.  The DS4000 Storage Manager optional 

Java-based host-agent software, which can be used on 

Microsoft Windows, Novell NetWare, HP-UX, and 

Solaris host systems to manage storage subsystems 

through the host fibre channel connection. 

SMclient.  The DS4000 Storage Manager client 

software, which is a Java-based graphical user interface 

(GUI) that is used to configure, manage, and 

troubleshoot storage servers and storage expansion 

enclosures in a DS4000 storage subsystem. SMclient 

can be used on a host system or on a storage 

management station. 

SMruntime.  A Java compiler for the SMclient. 

SMutil.  The DS4000 Storage Manager utility software 

that is used on Microsoft Windows, HP-UX, and Solaris 

host systems to register and map new logical drives to 

the operating system. In Microsoft Windows, it also 

contains a utility to flush the cached data of the 

operating system for a particular drive before creating a 

FlashCopy. 

small computer system interface (SCSI).  A standard 

hardware interface that enables a variety of peripheral 

devices to communicate with one another. 

small form-factor pluggable (SFP).  An optical 

transceiver that is used to convert signals between 

optical fiber cables and switches. An SFP is smaller 

than a gigabit interface converter (GBIC). See also 

gigabit interface converter. 

SNMP.   See Simple Network Management Protocol and 

SNMPv1. 

SNMP  trap event.  (1) (2) An event notification sent by 

the SNMP agent that identifies conditions, such as 

thresholds, that exceed a predetermined value. See 

also Simple Network Management Protocol. 

SNMPv1.  The original standard for SNMP is now 

referred to as SNMPv1, as opposed to SNMPv2, a 

revision of SNMP. See also Simple Network 

Management Protocol. 

SRAM.   See static random access memory. 

SSA.  See serial storage architecture. 

static random access memory (SRAM).   Random 

access memory based on the logic circuit know as 

flip-flop. It is called static because it retains a value as 

long as power is supplied, unlike dynamic random 

access memory (DRAM), which must be regularly 

refreshed. It is however, still volatile, meaning that it can 

lose its contents when the power is turned off. 

storage area network (SAN).  A dedicated storage 

network tailored to a specific environment, combining 

servers, storage products, networking products, 

software, and services. See also fabric. 

Storage Array Identifier (SAI or SA Identifier).  The 

Storage Array Identifier is the identification value used 

by the DS4000 Storage Manager host software 

(SMClient) to uniquely identify each managed storage 

server. The DS4000 Storage Manager SMClient 

program maintains Storage Array Identifier records of 

previously-discovered storage servers in the host 

resident file, which allows it to retain discovery 

information in a persistent fashion. 

storage expansion enclosure (EXP).  A feature that 

can be connected to a system unit to provide additional 

storage and processing capacity. 

storage management station.  A system that is used 

to manage the storage subsystem. A storage 

management station does not need to be attached to 

the storage subsystem through the fibre channel 

input/output (I/O) path. 

storage partition.  Storage subsystem logical drives 

that are visible to a host computer or are shared among 

host computers that are part of a host group. 

storage partition topology.  In the DS4000 Storage 

Manager client, the Topology view of the Mappings 

window displays the default host group, the defined host 

group, the host computer, and host-port nodes. The 

host port, host computer, and host group topological 

elements must be defined to grant access to host 

computers and host groups using logical drive-to-LUN 

mappings. 

striping.  Splitting data to be written into equal blocks 

and writing blocks simultaneously to separate disk 

drives. Striping maximizes performance to the disks. 

Reading the data back is also scheduled in parallel, with 

a block being read concurrently from each disk then 

reassembled at the host. 

subnet.  An interconnected but independent segment 

of a network that is identified by its Internet Protocol (IP) 

address. 

sweep method.  A method of sending Simple Network 

Management Protocol (SNMP) requests for information 

to all the devices on a subnet by sending the request to 

every device in the network. 

switch.  A fibre channel device that provides full 

bandwidth per port and high-speed routing of data by 

using link-level addressing. 

switch group.  A switch and the collection of devices 

connected to it that are not in other groups. 

switch zoning.  See zoning. 

synchronous write mode.  In remote mirroring, an 

option that requires the primary controller to wait for the 
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acknowledgment of a write operation from the 

secondary controller before returning a write I/O request 

completion to the host. See also asynchronous write 

mode, remote mirroring, Metro Mirroring. 

system name.  Device name assigned by the vendor’s 

third-party software. 

TCP.   See Transmission Control Protocol. 

TCP/IP.  See Transmission Control Protocol/Internet 

Protocol. 

terminate and stay resident program (TSR 

program).  A program that installs part of itself as an 

extension of DOS when it is executed. 

topology.  The physical or logical arrangement of 

devices on a network. The three fibre channel 

topologies are fabric, arbitrated loop, and point-to-point. 

The default topology for the disk array is arbitrated loop. 

TL_port.  See translated loop port. 

transceiver.  A device that is used to transmit and 

receive data. Transceiver is an abbreviation of 

transmitter-receiver. 

translated loop port (TL_port).  A port that connects 

to a private loop and allows connectivity between the 

private loop devices and off loop devices (devices not 

connected to that particular TL_port). 

Transmission Control Protocol (TCP).  A 

communication protocol used in the Internet and in any 

network that follows the Internet Engineering Task Force 

(IETF) standards for internetwork protocol. TCP 

provides a reliable host-to-host protocol between hosts 

in packed-switched communication networks and in 

interconnected systems of such networks. It uses the 

Internet Protocol (IP) as the underlying protocol. 

Transmission Control Protocol/Internet Protocol 

(TCP/IP).  A set of communication protocols that 

provide peer-to-peer connectivity functions for both local 

and wide-area networks. 

trap.  In the Simple Network Management Protocol 

(SNMP), a message sent by a managed node (agent 

function) to a management station to report an 

exception condition. 

trap recipient.  Receiver of a forwarded Simple 

Network Management Protocol (SNMP) trap. 

Specifically, a trap receiver is defined by an Internet 

Protocol (IP) address and port to which traps are sent. 

Presumably, the actual recipient is a software 

application running at the IP address and listening to 

the port. 

TSR program.  See terminate and stay resident 

program. 

uninterruptible power supply.  A source of power 

from a battery that is installed between a computer 

system and its power source. The uninterruptible power 

supply keeps the system running if a commercial power 

failure occurs, until an orderly shutdown of the system 

can be performed. 

user action events.  Actions that the user takes, such 

as changes in the storage area network (SAN), changed 

settings, and so on. 

worldwide port name (WWPN).   A unique identifier for 

a switch on local and global networks. 

worldwide name (WWN).  A globally unique 64-bit 

identifier assigned to each Fibre Channel port. 

WORM.   See write-once read-many. 

write-once read many (WORM).   Any type of storage 

medium to which data can be written only a single time, 

but can be read from any number of times. After the 

data is recorded, it cannot be altered. 

WWN.   See worldwide name. 

zoning.  (1) In Fibre Channel environments, the 

grouping of multiple ports to form a virtual, private, 

storage network. Ports that are members of a zone can 

communicate with each other, but are isolated from 

ports in other zones. (2) A function that allows 

segmentation of nodes by address, name, or physical 

port and is provided by fabric switches or hubs.
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 We appreciate your comments about this publication. Please comment on specific errors or omissions, accuracy, 

organization, subject matter, or completeness of this book. The comments you send should pertain to only the 

information in this manual or product and the way in which the information is presented. 

For technical questions and information about products and prices, please contact your IBM branch office, your IBM 

business partner, or your authorized remarketer. 

When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your comments in any 

way it believes appropriate without incurring any obligation to you. IBM or any other organizations will only use the 

personal information that you supply to contact you about the issues that you state on this form. 

Comments: 

 Thank you for your support. 

Submit your comments using one of these channels: 

v   Send your comments to the address on the reverse side of this form. 

If you would like a response from IBM, please fill in the following information: 
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